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Chapter 1

Introduction
This manual describes installation and operation of the Teledyne LeCroy Sierra M124™  
Protocol Analyzer and includes examples of typical applications.

Figure 1.1: Teledyne LeCroy Sierra M124 Protocol Analyzer

1.1 Analyzer Overview

The Sierra M124 SAS/SATA Protocol Analyzer is a serial bus analyzer. The SAS/SATA 
Protocol Suite software performs serial bus analysis for Serial Attached SCSI (SAS) data 
transfers, as well as Serial ATA (SATA) data transfers through STP data transfers and 
Serial ATA (SATA) data transfers.

The Sierra M124 Analyzer helps Hardware, Firmware, Design, and Application Engineers 
troubleshoot and diagnose SAS and SATA problems within their product. The analyzer 
supports the following:

 Capture, triggering, and filtering of Serial Attached SCSI packets or Serial ATA 
packets

 CATC API

The analyzer provides for bi‐directional trigger and capture of commands, primitives, 
patterns and all bus conditions. You can capture all frames and/or exclude traffic. 

The Sierra M124 Analyzer has a USB port and an Ethernet port to connect to a computer. 
You can cascade analyzer units for higher port counts. The analyzer allows you to select 
frames to include and exclude for capture. Capturing can be triggered based on a specific 
event or manually.

The Sierra M124 Analyzer provides a full range of views and statistical reports.
Sierra M124 SAS/SATA Protocol Analyzer User Manual 9



Teledyne LeCroy Features
1.2 Features
 Up to 12 Gb/s SAS and 6 Gb/s SATA protocol analysis or error injection
 Capture, triggering, and filtering of Serial Attached SCSI or Serial ATA packets
 Easy mode triggering
 Cascade up to 8 analyzers
 Sync with Teledyne LeCroy Sierra family products
 CrossSync
 Hardware filtering by Analyzer at Wire speed
 Automatic error detection
 Comprehensive decoding of SAS and SATA data traffic
 Logical and chronological traffic displays
 Statistical reporting
 Trace memory of up to 32 GB (Sierra M122) or 64 GB (Sierra M124)
 GbE & USB 3.0 host interfaces to connect to a host machine
 CATC API
 Automation API
 Error Injection Functionality (InFusion Jammer)
 Traffic Generation Functionality (Trainer)

1.3 Receiving Your Analyzer

The analyzer package includes the following components:

 1 Sierra M124 Analyzer identified in the packing list
 2 miniSAS HD cables, 1 meter
 1 USB A‐B 2.0 cable, 1.8 meter
 1 USB A‐B 3.0 cable, 1 meter
 1 Ethernet cable, 10 feet
 1 Three‐Prong AC power cord
 1 Installation CD ROM with software and documentation
 1 Sierra M124 Getting Started manual

1.4 Unpacking Your Analyzer

Inspect the received shipping container for any damage. Unpack the container and 
account for each of the system components listed on the accompanying packing list. 
Visually inspect each component for absence of damage. In the event of damage notify 
the shipper and Teledyne LeCroy Corporation. Retain all shipping materials for shipper’s 
inspection.

1.5 Analyzer Features

The Analyzer has the following features:

 Power Switch
 Frame, Speed, Link, Error, and Trigger LEDs
 External Trigger Input and Output
 Initiator and Target mini‐SAS connectors (4)
 Expansion In/Out data ports and Clock In/Out connectors
 Status and Configuration LCD Display
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 USB port for host connectivity
 Gigabit Ethernet port for network connectivity
 Power In (on back)

Figure 1.2: Front Panel

1.6 LEDs

Each link is supported by LEDs with the following functionality:

GreenThis LED is illuminated during the OOB (Out of Bound) sequence before the link is 
established and after link is established it indicates traffic on the bus.

Orange This LED is illuminated as follows:

Speed Initiator Target

1.5G On On (Green)

3.0G On On (Green)

6.0G On On (Yellow)

12.0G On On (Blue)

Yellow This LED is illuminated when a link is established.

Red This LED illuminates when an error occurs.

Blue This LED is illuminated when a trigger occurs.

Figure 1.3: LEDs

1.6.1 Status and Configuration Display

The Analyzer front LCD display indicates the configuration and status of operations. For 
example, during initialization, the LCD panel displays boot status messages.
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Teledyne LeCroy Installing Your Analyzer
1.6.2 Temperature and Humidity

The hardware should operate flawlessly in the following temperature ranges:

 Operating 0 °C to 55 °C (32 °F to 131 °F)
 Non‐Operating ‐20 °C to 80 °C (‐4 °F to 176 °F)

The hardware should operate in the following humidity range:

 10% to 90% RH (non‐condensing)

1.7 Installing Your Analyzer

1.8 Software Installation

The SAS and SATA software works on systems using the Windows® XP, Windows 7 (x86, 
x64) Windows 8 (x86, x64), Windows Server 2003, Windows Server 2008 and Windows 
Server 2012 R2 operating systems. 64‐bit Windows OS is recommended because it allows 
using more RAM memory. Other Operating Systems limit the RAM to 3GB.

1. Insert the Installation CD ROM into the CD/DVD drive on the host machine.

2. The installation automatically starts setup, unless Auto Run is off. In that case, select 
the CD ROM from “My Computer” and click Setup.

3. After the warning to close all other programs and before starting the installation, 
the Install component selection opens.

4. Select components for installation.

5. Click Next to complete the installation.

1.8.1 System restart

You must restart your computer before you can use your Protocol Suite software.

1.8.2 Error Message

If you get an error message during installation of the drivers for Window, consult your 
system administrator. Your system may allow only administrator‐level users to copy such 
driver files.

1.9 Hardware Setup

1.9.1 Separate Systems

When using the analyzer, it is recommended to use a system to generate bus traffic and a 
second system to run the software, to avoid characterization of traffic generated by the 
analyzer.
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1.9.2 Connecting in General

Note:You must install the software before connecting the analyzer to the host machine for the first 
time.

To set up the analyzer:

1. Plug the power adapter into the unit, and then plug the power adapter into a 100V–
240V, 50Hz–60Hz, power outlet. Turn on the Power switch.
At power on, the analyzer will go through initialization as shown on the LCD display.

2. Connect the USB cable between the Sierra M124 USB port and a USB port on the 
host machine. The host machine’s operating system detects the analyzer and driver 
files.

3. Connect the analyzer as shown in Figure 1.4.

Figure 1.4: Analyzer Single Lane Connections

Figure 1.5: Analyzer MiniSAS HD Connections

1.9.3 Cables to Use

When connecting between a HBA and a disk drive, use a crossover MiniSAS HD from the 
initiator port on the Sierra to MiniSAS HD, and a MiniSAS HD from the target port to 
SATAx4, connecting the SATA connector to the disk drive.
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1.10 Expandability

The Analyzer provides cascading, external power and other functions through optional 
expansion cards on the back panel. You can expand by:

 Cascading with CATC SYNC Expansion Cards
 Using the Power Expansion Card

You can remove expansion cards with two simple tools.

Cascading and Memory Size
For example, you have two units. The first one has 2 GB memory. The second one has 
4 GB memory. The system shows the entire memory as 6 GB. If you set buffer size to 
6 GB, the system programs the first board for 2 GB and the second board for 4 GB. You 
can consider this ratio when you set buffer size to any value. For example, if you set 
buffer size to 2 GB, the system programs the first board for (2*2)/6 GB and the second 
board for (2*4)/6 GB. Any unit that has more memory will have larger buffer size.

1.10.1 Cascading with CATC SYNC Expansion 

You can use cascading of analyzer units for higher port count, by connecting the units 
through the optional CATC SYNC Expansion Card on the analyzer back. Using the CATC 
SYNC Expansion Cards will not sequentially trigger the State Machine in Advanced mode.

Connecting a Sierra M124 and a Summit T3-16 via the CATC Sync Expansion Card (ACC-
EXP-002-X)

A Sierra M124 and a PCIe Summit T3‐16 are connected using their CATC Sync ports which 
require an optional expansion card (ACC‐EXP‐002‐X) (see Figure 1.6 on page 15).

Note:Refer to the relevant protocol analyzer user manual for instructions on how to install the 
expansion board.

To do so perform the following steps:

1. Make sure to stop any recordings in progress.

Note:You may plug/unplug the sync cable while the analyzer unit is powered on.

2. Connect the female end of the sync cable to the SYNC OUT port of the Sierra 
M124.

3. Connect the male end of the sync cable to the SYNC IN port of the PCIe Summit 
T3‐16.
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Figure 1.6: An Example of Connecting a Sierra M124 and a Summit T3-16

You can cascade up to eight Sierra Analyzers, if they all have a CATC SYNC expansion card.

Note: If the Sierra M 124 has a CATC SYNC Expansion Card, you can cascade with SierraM6‐4, M6‐2 
and M6‐1.

1.10.2 Select Device 

After starting the software, click on Setup and select All Connected Devices (see 
Figure 1.7 on page 16). 
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Figure 1.7: Connecting to All SAS/SATA Device(s) 

The Select Device dialog allows connecting and disconnecting analyzers on the fly, 
without restarting the application. 

The new Device List (introduced in version 4.10) mandates using updated firmware in 
order to detect the analyzer over Ethernet. Thus, the analyzer must be updated over USB 
before it can be used remotely over Ethernet. This is applicable for any update from 
version 4.00 or earlier to any version from 4.10 or later.

The following Select Device dialog displays (see Figure 1.8 on page 17). The colors in the 
‘Location’ column mean the following: 

 Red: Firmware and/or BusEngine components need to be updated to the latest 
version 

 Light Blue: The device is ready to be connected.
 Yellow: The device is locked.
 Green: The software is connected and ready to run.
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Figure 1.8: Select Device Dialog 

Note:Click Refresh Device List to display all the devices on the network.

The Select Device dialog displays the following buttons:

Set Alias Name 

Click Set Alias Name to display the Set device alias name dialog as shown below.

Figure 1.9: Set Device Alias Name Dialog

Disconnect 

Click Disconnect to disconnect a device.
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Add Device... 

Click Add Device to add a device with a static IP address.

Note:You must close and re‐open the application when changing to static IP mode through the front 
panel instead of the application.

Figure 1.10: Add Device with Static IP Dialog.

Force Add/Connect Attempt

Use this option if the application's Ping function fails (the button in the upper right 
corner), but you are sure that the address is correct, and you still want to attempt the 
connection. This setting is stored in the device.

Remove Device 

Click Remove Device to remove a previously added device.

IP Settings... 

Click IP Setting to reset IP settings of a device. The following IP Setting dialog displays.

Figure 1.11: IP Setting Dialog

Networks... 

Click Networks to select a network adapter. The following dialog displays.
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Figure 1.12: Select Adapter Dialog
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Refresh Device List 

Click Refresh Device List to refresh the device list.

To connect to a device, select a device which is Ready to Connect and click the Connect 
button on the right. The Connection Properties dialog is displayed (see the following 
screen capture).

Figure 1.13: Connection Properties Dialog 

Specify one of the actions from the following: 

 Automatically connect to the device 
 Ask if I want to connect to the device 
 Take no action

If ‘Automatically connect to the device’ is selected, the next time the application opens 
the device will be automatically connected. 

In the Select Device dialog chained or cascaded units are displayed in the Device column 

with a [ (square bracket) icon. The sequence of the units is displayed in the Order 
column. See the following screen capture. 
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Figure 1.14: Select Device Dialog Displaying Unit 1 and Unit 2 Chained 

1.10.3 Using the Power Expansion Cards

Two types of Power Expansion Cards are available and the type must be specified when 
ordering the unit. 

 Power Expansion Card (part number: ACC‐EXP‐004‐X)
 Power Expansion Card 2 (part number: ACC‐EXP‐005‐X)

Power Expansion Card (part number: ACC‐EXP‐004‐X)

You can use the Power Expansion Card to power the drives to test for Emulation, 
SATA Compliance, and SAS Verification. The Power Expansion Card can supply 5 V or 12 V.

Power Expansion Card 2 (part number: ACC‐EXP‐005‐X)

This card has several capabilities:

 Supplies power to devices at 12v, 5v, 3.3v, 1.5v and/or 1.2v.
 Allows monitoring in the trace of the DevSlp signal as generated by the Trainer or 

Host Emulator, as well as when generated directly from a Host (using a dedicated 
DevSlp cable). See “DevSlp” on page 336 and “Exit_DevSlp” on page 336). Also 
see “Device Sleep (DevSlp)” on page 119.

 Allows CATC Sync functionality to enable cascading, so there is no need to toggle 
between the Power Expansion Card and the Sync Expansion Card.

 Allows power measurement to monitor and record the power, current and volt‐
age being used by the device it powers (will be supported in a future software 
release).

Note:When it runs, the Host Emulator turns on the voltage on all channels, whether they are turned 
on or off previously. The emulator does not execute any command until its link is established. So 
if the power is off on any channel, the emulator will not proceed even if the first command is a 
Power On command.

Holes in the 
Expansion Card
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Figure 1.15: Power Expansion Card 2

It is shipped with the following three cables:

 Standard 4‐pin power connector (ground, 5v, 12v only): This is a direct replace‐
ment for the existing Power Expansion Card cable.

 SATA 15‐pin power segment connector: This plugs in to the power segment of 
the standard SATA connector, allowing to control and monitor its power and 
DevSlp.

 DevSlp cable: This cable is used to monitor DevSlp levels when the Device is con‐
nected directly to the Host. It is up to the user to supply a copy of the DevSlp sig‐
nal coming from the Host to connect to the DevSlp wire of this cable, as well as 
to connect the adequate ground wire of this cable.

Activating the Power Expansion Cards

Select Setup > Power Source Control to display the Power Source Control dialog (see 
Figure 1.16 on page 23). Depending on the Power Expansion Card/s ordered the 
applicable device controls are enabled. Make the appropriate selections and click Close.
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Figure 1.16: Power Source Control Dialog

1.10.4 Removing Expansion Cards

You can remove expansion cards using two tools:

 Standard (flat blade) 3/16” screwdriver
 Teledyne LeCroy Extraction Tool (part number 230‐0160‐00)

To remove an expansion card, follow these steps:

1. Unplug the system from AC power and turn the system so the expansion port is 
facing you. Note the two retaining screws and the holes for the extraction tool that 
are located on the panel of the expansion card.
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2. Insert the extraction‐tool prongs into the holes in the expansion card panel.

Note: If the prongs do not slip easily into the holes, use a small nail file or similar device to remove 
paint from the prongs.

3. Rotate the extraction tool to a horizontal position to lock the prongs into place and 
make a handle.

Holes in the 
Expansion Card
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4. Using the screwdriver, loosen both retaining screws by rotating them counter‐
clockwise approximately two full turns, until feeling slight resistance. Do not force 
the retaining screws after two turns.

5. Using the extraction tool as a handle, gently wriggle the expansion card forward 
about 1/8”.

6. Repeat steps 4 and 5 approximately three times, until the card is free from the 
retaining screws and you can remove the card from the system.
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1.11 Connecting via Ethernet

The Ethernet connection can have any of these configurations:

1. Analyzer connected to a network using a hub or switch, Gigabit Ethernet interface, 
or similar device.

2. Analyzer connected to the host machine (machine running the application 
software), using a hub or switch, Gigabit Ethernet interface, or similar device.

3. Analyzer connected directly to the host machine using a crossover cable. 

1.12 Connecting to a Network

When connected to a network, the analyzer can communicate with the DHCP server to 
obtain IP address configuration information in order to establish a connection. Refer to 
“Select Device” on page 15.

1.13 Connecting over Different Subnets

If the host machine (with the Sierra software) and Sierra M124 are on the same subnet, 
they will see each other’s broadcasts, and the Sierra M124 application will automatically 
appear in the Select Device dialog, from which you can select a device (as described in 
the previous section).

If the host machine and Sierra M124 do not reside on the same subnet, they will not see 
each other automatically. You must add the Sierra M124 IP address manually. To add the 
IP address, use the Add Device button (see Figure 1.10 on page 18)

1.14 TCP and UDP Ports Must be Open to Connect over Ethernet

WARNING: Check your firewall settings before making Ethernet connections. Incorrect 
firewall settings can prevent Teledyne LeCroy applications from detecting 
analyzers on the network, though Ping works correctly. Consult your Firewall 
documentation to allow Teledyne LeCroy applications access to the network.

The following TCP and UDP ports must be open to connect over the Ethernet:

 TCP Port: 4000 to 4003
 UDP Ports: 4015 to 4017

1.15 Launching Your Analyzer

To launch the software, double‐click the SAS Icon in the Program Manager Window.

1.16 Operating in Simulation Mode

The SAS/SATA application operates in the Simulation Mode by default if the hardware is 
not detected.
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The Protocol Suite software launches and displays the appropriate tool bar, but with the 
limitation that the Analyzer operates only on static, previously captured, bus data. 

Limitations The Simulation mode lets you try all of the available functions, but 
keep in mind that the system is not capturing any real data and is 
displaying only pre‐captured results.

1.17 Using the Software

The Sierra M124 application uses the Teledyne LeCroy SAS/SATA Protocol Suite. 

The Teledyne LeCroy SAS/SATA Protocol Suite can is a:

 Protocol Analyzer: Captures data, triggers on events, and saves. Easy Mode 
allows standard Trigger and Data capture. Advanced Mode allows you to pro‐
gram custom triggering in and out, capturing, state jumps, and timers (see “Pro‐
tocol Analysis” on page 37).

The SAS/SATA application now provides functionality for both protocols. Either protocol  
can now be accessed via the File menu and choosing the protocol to work with. Click File> 
New and select the desired protocol and application.

Figure 1.17: File Menu

To switch between protocols click Window and the select the trace or application to use.

Depending on the protocol in use, the relevant functions and menu options are available 
and the others are greyed out (see Figure 1.18 on page 28).
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Figure 1.18: Window Dialog

1.18 Getting Started with the Protocol Analyzer

To use the software for protocol analysis, first select File > New > SAS Protocol Analyzer

or File > New > SATA Protocol Analyzer for a new project or File > Open an existing 
protocol analysis file: .sac for a SAS file or .stc for a SATA file (see “Protocol Analysis” on 
page 37). You can also open a .scs SAS Sample file or .sts SATA Sample file. Example files 
are in the Examples folder.

Note:Project files created on the Sierra M6‐X family of analyzer products are not compatible with the 
Sierra M124 Analyzer. Open the files and perform a Save As to use them with the Sierra M124 
Analyzer.

On the Capture tab, select to capture Everything or Pattern. For Pattern, select a Pattern. 
You can exclude patterns and frames. You can use different patterns for pre‐trigger and 
post‐trigger.

On the Trigger tab, select the trigger type. For Pattern, select the pattern.

On the Settings tab, select trigger position and memory use. 

Change the Analyzer settings if necessary. Change the port Speed if necessary.

Use Advanced Mode only after you become familiar with the hardware and software and 
have special needs.

1.19 Teledyne LeCroy SAS/SATA Protocol Suite Menu Options and 
Toolbars

This section lists all the SAS/SATA Protocol Suite application menu options and the 
toolbars.
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1.19.1 File

The File menu options allows you to perform common tasks such as open, close, save, 
export, print, send files and exit the application.

Figure 1.19: File Menu Option

1.19.2 Setup

For special work, you can use the Setup menu (see Figure 1.20 on page 30) to perform the 
following actions:

 TxRxVout & Pre‐emphasis (see “TxRxVout & Preemphasis” on page 204)
 User Defined Decoding (see “User‐Defined Decoding” on page 222)
 External Trig Setting (see “Floating Licence Dialog” on page 219)
 Update Device (see “Update Device” on page 221)
 All Connected Devices (see “Select Device” on page 15)
 Find DUT finds the Device Under Test (see “Find DUT” on page 225)
 Power Source Control turns the Device Under Test on and off
 Manage Setup Licences (see “Floating License” on page 219)
 Preferences (see “Preferences” on page 210)
 Self Test (see “Self Test” on page 324)
 Data Block (see “Data Blocks” on page 139)
 Set Port Alias (see “Set Port Alias” on page 202)
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 Set SAS Address Alias (see “SAS Address Alias (SAS only)” on page 203)

Figure 1.20: Setup Menu Option

1.19.3 Session

The Session menu has the following options:

 Start Capture/Record ‐ Start capture or record a trace
 Pause Capture/Record ‐ Aborts the capture without saving
 Stop Capture/Record ‐ Stops the hardware

1.19.4 Analysis

The Analysis menu allows you to view captured data (see Figure 1.21 on page 31).

Menu items and toolbar options are enabled or disabled and displayed or hidden based 
on the type of window open. The following types of windows can be displayed:

 No active window
 Project file open
 Trace file open
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Figure 1.21: SAS/SATA Analysis Menu

1.19.5 Viewing Captured Data 

Captured data can be displayed in several views. Select Analysis from the drop‐down 
menu to access the different views (see “Analysis” on page 114). You can display the same 
data in:

 Packet View: Displays packets
 Spreadsheet View: Displays Packet View fields by time
 Column View: Displays packets in columns
 Text View: Shows transaction frames, grouped in columns by port
 Frame Inspector View: Has lots of information that is available in Packet View, 

but not Spreadsheet View, so it is most useful in conjunction with the Spread‐
sheet View

 Waveform Display: Shows waveform display for all active ports, on which you 
can perform timing measurements

 Statistical Report: generate statistics for all transports, commands, primitives, 
bus conditions, addresses, lanes, and errors 

 Histogram View: Shows frame‐type transfers
 Bus Utilization: Displays the utilization of the bus
 Data Reports: Displays data payloads
 Compare 2 Data Payloads: Compare two data payloads
 VSE: Perform custom post‐process analysis of the open trace by running a verifi‐

cation script over the trace
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1.19.6 Navigation

The Navigation menu has the following options to navigate through the application (see 
Figure 1.22 on page 32).

Figure 1.22: Navigation Menu Option

 Goto
 Trigger Position
 X Position
 Y Position
 Packet No
 Time Stamp
 Bookmark
 Begin 
 End 

 Search
 Search Next
 Search Previous

1.19.7 View

The View menu options allows the user to zoom in and out, enable/disable filtering and 
toolbars among other actions. It has the following options (see Figure 1.23 on page 33).
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Figure 1.23: View Menu Option

 Zoom In (refer to “Navigation + View Toolbar” on page 161)
 Zoom Out (refer to “Navigation + View Toolbar” on page 161)
 Actual Size (refer to “Navigation + View Toolbar” on page 161)
 Tile Views (refer to “Navigation + View Toolbar” on page 161))
 Enable Filtering (refer to “Filter Setup” on page 167)
 Filtering (refer to “Filter Setup” on page 167)
 Filter Idles (refer to “Filter Setup” on page 167)
 Link Layer‐SAS only (refer to “Packet View Toolbar” on page 186)
 Transport Layer‐SAS only (refer to “Packet View Toolbar” on page 186)
 Application Layer‐SAS only (refer to “Packet View Toolbar” on page 186)
 Pack/Unpack Repeated Primitives‐SAS only (refer to “Packet View Toolbar” on 

page 186)
 Physical Layer‐SATA only (refer to “Packet View Toolbar” on page 186)
 FIS Layer‐SATA only (refer to “Packet View Toolbar” on page 186)
 Command Layer‐SATA only (refer to “Packet View Toolbar” on page 186)
 Wrap Packets (refer to (refer to “Packet View Toolbar” on page 186)
 Toolbar (allows you to customize the toolbar with the options given below)

 Main
 Record+Capture
 Analysis
 Navigation+View
 Packet View
 Column View
 Cursor position
 Target Emulator
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 Status Bar (refer to “Cursor Position Status Bar” on page 197)

1.19.8 Window

The Window menu has the following options:

 Cascade: Displays all open windows in an overlapping arrangement.
 Tile Horizontal: Displays all open windows in a above‐below arrangement.
 Tile Vertical: Displays all open windows in a side‐by‐side arrangement.
 Arrange Icons: Arranges minimized windows at the bottom of the display.
 Close All: Closes all windows.

1.19.9 Help

For more information see “Help Menu” on page 223.

1.19.10 Toolbars

The toolbars enable you to perform several actions, some of which are listed below. 

 Show or hide fields and ports, change port names, and change data format.
 Show the layers and channels using their toolbars.
 Decode using the Decode toolbar.
 Search and Filter.

There are five sets of toolbars (see Figure 1.24 on page 35):

 Main Toolbar ‐ For details on the Main Toolbar refer to “SAS Main Toolbar” on 
page 41 and “SATA Main Toolbar” on page 41.

 Record Capture Toolbar ‐ For additional information see “SAS Main Toolbar” on 
page 41 and “SATA Main Toolbar” on page 41.

 Navigation + View Toolbar ‐ For additional information see “Navigation + View 
Toolbar” on page 161.

 Show Analysis Toolbar ‐ For additional information see “Show Analysis Toolbar” 
on page 114.

 Packets View Toolbar ‐ For additional information see “Packet View Toolbar” on 
page 186.

 Column View ‐ For additional information see “Column View” on page 123.
 Cursor Position‐ For additional information see “Using the Cursors and Book‐

marks” on page 197.
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Figure 1.24: SAS/SATA Protocol Suite Toolbars

1.20 Port Status

You can display an overview of the active ports by clicking the buttons at the bottom right 
of the main window (see “Port Status” on page 195).

1.21 InFusion

The Teledyne LeCroy InFusion™ Error Injector and Traffic Modifier is an error injector and 
traffic modification tool for traffic passing through the Jammer. It allows you to verify real‐
world fault handling for Serial Attached SCSI (SAS) and Serial ATA (SATA) systems. Click on 

the Jammer icon   to invoke the Teledyne LeCroy SAS or SATA InFusion, see 
“InFusion Overview” on page 345.

You can toggle between the InFusion and Analyzer panes by using the Alt+Tab keys, the 
Windows Task Bar or by pressing the respective toolbar button in each pane. 

1.22 Trainer

The SAS Trainer is a traffic generator that can emulate a SAS initiator/target or 
SATA host/device. Traffic generation enables engineers to test designs under realistic 
conditions and to transmit known errors, allowing engineers to observe how devices 
handle faulty link conditions. 

Traffic generation is performed via the execution of text‐based scripts. These traffic 
generation files (*.ssg) contain statements about the types of traffic to be generated. 
These script files can be edited with either a simple text editor such as Notepad or with 
the included Script Editor utility. 
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Click on the Trainer icon   to invoke the Teledyne LeCroy SAS or SATA Trainer, 
see “Sierra Trainer Traffic Generation” on page 407.

You can toggle between the Trainer and Analyzer panes by using the Alt+Tab keys, the 
Windows Task Bar or by pressing the respective toolbar button in each pane. 
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Chapter 2

Protocol Analysis
A default analyzer project is created automatically when the application starts. An 
analyzer project contains all the settings for capturing, triggering and memory usage. A 
project can be saved as a *.sac files for later use.

2.1 Easy Mode (Pre-Defined Setups)

After you install the Protocol Suite software (see “Software Installation” on page 12) and 
set up the Analyzer (see “Hardware Setup” on page 12), launch the Protocol Suite 
software (see “Launching Your Analyzer” on page 26) to display the default Protocol 
Analyzer in Easy Mode at the Capture tab.

The default Protocol Analyzer uses the Easy Mode which allows triggering and data 
capture.

2.1.1 Main Window

Use the Easy Mode to get a comprehensive overview of your analyzer’s capabilities. Use 
the default Analyzer Project or create a new project. 

For SAS: on the Analyzer Menu Bar, click File > New > SAS Protocol Analyzer to open a SAS 
Protocol Analyzer dialog (see Figure 2.1 on page 38).
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Figure 2.1: SAS: New Analysis Project Dialog.

The New Project dialog opens with default settings to capture Everything on the bus and 
to Trigger On on Snapshot. (The analyzer captures everything immediately without 
triggering on anything in particular.)

Project Tree display 
What analyzer triggers on Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree
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For SATA: On the Analyzer Menu Bar, click File > New > SATA Protocol Analyzer to open a 
SATA Protocol Analyzer dialog.

Figure 2.2: SATA: New Analysis Project Dialog.

SAS vs. SATA: SATA Dialog does not show “Exclude RRDY” or “Exclude NOTIFY”.
SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”.

2.1.2 Project Tree

The Project Tree on the right side of the main window displays a comprehensive tree 
structured overview of the project. The project tree shows the capture configuration, 
trigger setups, and the capture memory settings.

Capture Tab Fields

The Capture tab has the following fields:

Exclude SATA_CONT (SAS) or Exclude CONT (SATA)

Check this to exclude SATA_CONT primitives from the data capture.

Exclude SATA_SYNC (SAS) or Exclude SYNC (SATA)

Check this to exclude SATA_SYNC primitives from the data capture.

Exclude OOB Signals
Check this to exclude OOB signals from the data capture.

Project Tree display 
What analyzer triggers on Capture memory settings

Collapse All button hides details in Project Tree
Expand All button expands collapsed Project Tree
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Exclude XXXX

Check this to exclude XXXX patterns from the data capture.

Note:The validity of time stamps during Idles is traded off against good buffer memory utilization 
when using ‘Exclude XXXX’.

Exclude Dev Slp Packets (SATA)

Check this to exclude Dev Slp Packets from the data capture. 

Exclude Payload except

Check this to exclude Payload of Data Frames from the data capture. You can except a 
number of DWORD(s). 

Note:The Data Report (refer to “Data Report” on page 152) does not reflect excluded Payload of Data 
Frames.

Note:When showing truncated data in the Data Payload View, the truncation points are marked with 
a separator placed between payloads. You can get more information about the data exclusion 
using the tooltip over the separator.

Exclude ALIGN

Check this to exclude ALIGN primitives from the data capture.

Exclude RRDY (SAS only)

Check this to exclude RRDY primitives from the data capture.

Exclude NOTIFY (SAS only)

Check this to exclude NOTIFY primitives from the data capture.

Exclude Idle

Check this to exclude Idles from the data capture.

Define different patterns for pre‐trigger and post‐trigger data captures

Replaces the Capture tab with a Pre‐Trigger Capture tab and a Post‐Trigger Capture tab.
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2.2 SAS/SATA Software Menus and Toolbars

The SAS and SATA software has the following menus and toolbars.

2.2.1 SAS Main Toolbar

The following figure displays the SAS main toolbar.

Figure 2.3: SAS: Software Menus and Toolbar.

2.2.2 SATA Main Toolbar

The following figure displays the SATA main toolbar.

Figure 2.4: SATA: Software Menus and Toolbar.
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2.2.3 Start Recording

To get an immediate overview of the bus traffic to and from your Analyzer:

1. Click the   Record button.

2. The analyzer begins filling the defined memory buffer with traffic captured from the 
bus. After the traffic fills the memory buffer, the traffic is uploaded to the viewer 
and the Packet View display opens. Packet View is the default display. However, 
more views are available by selecting View on the menu bar and choosing the 
desired View.

Figure 2.5: SAS: Typical Packet View .

Note:When using the Advanced Mode sequencer, the analyzer logs the state transitions in the trace, 
with the name the user gives to the state.

In the Packet View, right‐click on any packet and select Show‐>State, to display the states 
and their transitions in the trace.

SAS: In case of an STP interface, the expander displays STP addresses provided to the 
SATA drive and the SAS software integrates the STP addresses in the ATA command.

Layer ID with different colors

Data direction arrows

X,Y,T
Cursors

Show/Hide Layers buttons

Relative time display
(Between two sequential

Source and destination addresses in SCSI commands

Transport Layer command interpretation

not shown in this capture

Show/Hide Data Ports

Link 
Layer

packets on the same 
layer and port)
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The results display shows each transaction for every layer identified in a different color 
and the data direction identified with data direction arrows. Upstream traffic has an 
arrow from right to left:. Downstream traffic has an arrow left to right: .

Layers can be hidden by clicking the corresponding Show/Hide button on the menu bar. 
The system retains all captured data, but the display has fewer data layers for simpler 
viewing.

You can configure the viewer display for test and viewing preferences (see “Viewer 
Display” on page 111 for details about configuring the viewer display).

The Analysis Project dialog offers you a comprehensive set of choices to create a trigger 
and capture project satisfying some specific need. You can set the Analyzer to:

 Capture specific patterns (see “Patterns and Data Capture Setup” on page 54).
 Capture different patterns pre‐ and post‐trigger.
 Exclude parameters from capture.
 Trigger on a pattern or sequence of patterns (see "Trigger Setup" on page 68).
 Configure trace capture memory (Settings tab).
 Select file to save trace capture in memory (Settings tab).
 Include a project note (Notes tab).

2.2.4 Launch Jammer

The Launch Jammer option invokes InFusion. For more information refer to “InFusion 
Overview” on page 231.

2.2.5 Launch Trainer

The Launch Trainer option invokes Trainer. For more information refer to “Sierra Trainer 
Traffic Generation” on page 291.

2.2.6 CrossSync Control Panel

The CrossSync Control Panel allows you to select analyzers for synchronization and 
manage the recording process. It supports a wide combination of Teledyne LeCroy’s 
flagship analyzers including PCI Express, USB, DDR, Serial ATA (SATA), Serial Attached SCSI 
(SAS), Fibre Channel (FC) and Ethernet.

CrossSync is Teledyne LeCroy’s analyzer synchronization solution that enables time‐
aligned display of protocol traffic from multiple daisy‐chained analyzers showing packet 
traffic from multiple high‐speed serial busses. A lightweight software control panel allows 
users to select analyzers for synchronization and manage the recording process. Captured 
traffic is displayed using the latest Protocol Suite software (in separate windows) with all 
the protocol specific search and reporting features.

Captured packets are displayed in separate windows that share a common time scale. 
Navigating the traffic in either direction will scroll to the same timestamp in a 
synchronized window. When using the CrossSync option, users can access the full 
complement of analysis capabilities available within the individual Teledyne LeCroy 
software. Search, reporting, and decoding all operate normally. 
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This feature is available with the Teledyne LeCroy SAS/SATA Protocol Suite application.

Launching the CrossSync Control Panel

To launch CrossSync from the SAS/SATA Protocol Suite software application, click on File 
and select Launch CrossSync Control Panel (see the screens below). Or, you can launch 
CrossSync from the ‘Start’ menu.

Figure 2.6: Launching CrossSync from the SAS/SATA Protocol Suite Application.

Please refer to the CrossSync Control Panel User Manual for more information.

2.2.7 Save Workspace

Viewing parameters can be saved in a workspace as a .wss file. 

After you open a trace and select views, you can save the viewing parameters in a 
workspace file. Select File > Save Workspace to open a Save As dialog. Save the current 
workspace as a .wss file.

To set default workspace viewing parameters, select Setup > Preferences . In the Default 
Workspace field, enter the path and name of a saved workspace .wss file.

The workspace can be switched after opening a trace file. Select File > Open to open 
another workspace and select a .wss file.

2.2.8 Saving a Trace Capture

You can save a Trace Capture by selecting Save from the File menu, or select Save As to 
save as the trace capture for review at a later time using the following dialog (see 
Figure 2.7 on page 45).
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Figure 2.7: Save As Dialog.

You can limit the range of the saved file. You can save:

 All Samples
 Range between selected cursors
 Range between selected Idle, link, commands
 Range between bookmarks

The Save Filtered Sample checkbox saves a trace file without filtered data. The Apply 
Show/Hide Link Setting checkbox filters the saved data further by also applying the 
current status of the port buttons of the toolbar.

2.2.9 Exporting

From the File menu, you can Export to Text/Excel, Export Read‐Write Command Report, 
or Export Paired SAS Address Report.

Export to Text/Excel

From the File menu, you can export to Text/Excel, using the Export to Text/Excel. The 
Save as Text dialog displays (see Figure 2.8 on page 46).
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Figure 2.8: Save As Text Dialog.

 From the Save as type: drop‐down select Text Files.txt or Text Files Version 1.0 
.txt for text format or Excel File.csv or Excel Files Version 1.0.csv for Excel format 
(see “Save As Display Formats” on page 46). 

 Check the box Export the whole payload (more than 32KB) to export the whole 
payload (more than 32KB).

 You can limit the range of the saved file. You can save:
 All Packets
 Range between selected cursors

 Range between bookmarks

Save As Display Formats

The following figure describes the four different Save As type formats:

Excel File.csv format Excel Files Version 1.0.csv format Text Files.txt format Text Files Version 1.0.txt format
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Export to Initiator Emulator (SAS) or Host Emulator (SATA)

From the File menu, you can Export to Initiator Emulator (SAS) or Export to Host Emulator 
(SATA), using the Extract Sample File dialog (see following figures).

Figure 2.9: Export to Initiator Emulator (SATA) Dialog.

Figure 2.10: Export to Host Emulator (SAS) Dialog.
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You can limit the range of the saved file. You can save:

 All Trace
 Range between selected cursors
 Range between SCSI Commands or Transport

You can export SCSI Commands, Task Management, FIS, ATA Commands, Device Sleep, 
SSP Frames, SMP Frames, SMP Commands, or STP Frames.

You can select the Port.

In the Project Name, enter a valid file name.

2.2.10 Export to Trainer

The Export to Trainer dialog, accessible from the File menu, allows exporting data to a file 
in a format supported by the timer.

Figure 2.11: Export to Trainer Dialog (SATA).

In the Export to Trainer dialog you can: 

 Limit the range of the saved file. You can save:
 All Traces
 Range between selected cursors
 Range between SCSI Commands, SMP Commands or Transport

 Import SSP Frames, SMP Frames, or STP Frames (see “Events and Event Proper‐
ties” on page 372).

 Insert Waits inserts the appropriate Wait_for commands in the Trainer script as 
a function of the protocol state machine. An example would be to insert a 
Wait_for open_accept after an open command is exported. This allows the 
script to work, even if the DUT has different timing than the DUT in the original 
trace. See “Wait Commands” on page 346.
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 Insert Delays inserts the exact delays as they appear in the original exported 
trace. This may result in the closest match in terms of timing to the original trace, 
but may not work with other DUTs. 

 Use Auto Alignment (see “The Global Setting “AutoAlign”” on page 303).
 Select the Port (see “Setup Menu” on page 293).
 Indicate Trainer Generation File Name and click Export to export the trainer 

generation file.

Note:The resulting Trainer Generation file cannot exceed 2MB or 1,000,000 packets.

SATA has different options including Device Sleep.

Export Read/Write Command Report

You can create an Export Read/Write Command Report as an Excel file (*.csv), using the 
Export... dialog from the File menu.

In Setup > Preferences > Trace Viewer, you must first select Create statistical report 
read/write page in order to create this report. 

If this choice was not made when the trace was taken, then use Save As to save the trace 
file with this preference. This will append the Read/Write Command Report to the trace 
file, so this action need only be done once. When you re‐open the trace file, you should 
be able to export the report as described above.

2.2.11 Export Paired SAS Address Report

If Text View is activated, from the File menu you can save a Paired SAS Address Report as 
an Excel file, using the Export Paired SAS Address Report dialog.
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Figure 2.12: Export Paired SAS Address Report Dialog.

 Check the box Export the whole payload (more than 32KB) to export the whole 
payload (more than 32KB).

 You can limit the data range of the saved file. You can save:
 All Packets
 Range between selected cursors

You can view expanded traffic (particularly during discovery) in a spreadsheet format. You 
can use column headers with SAS Address Pairs. For example, instead of I1, T1, I2, T2, and 
so on, the columns are Source/Destination SAS Address pairs, such as S1:SEP or S2:EXP 0.

2.2.12 Trace Properties

Select File > Trace Properties to see the properties of the trace. For more information refer 
to “Trace Properties” on page 113.

2.2.13 Edit Comment

You can write comments and edit them for a trace for future use. Select File > Edit Comment 
to view the edit window. Key in the comments and close the window.
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2.2.14 Projects

You can define a new project, starting with the default project definition, or modify the 
settings for the last project run.

New Default Project

To start a New project, select File > New on the main menu bar and choose SAS 
Protocol Analyzer or SATA Protocol Analyzer to open a new project with default settings 
that you can modify (see “Main Window” on page 37).

Last Project

Clicking the Green button   opens the last project run, so you can modify it.

Project File Types

Projects have the following file types:

*.asl Decoding script file (in the Examples folder “User Define Decoding Script” 
subfolder)

*.cfg Display Configuration file (in the System folder “Config” subfolder)

*.dat DataBlock file (in the System folder “DataBlock” subfolder)

*.sac SAS Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 
“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)

*.saf Device Identifier file

*.scs SAS Sample file (in the SAS Examples folder “Sample” subfolder)

*.sfl Filter configuration file

*.spg Single‐role Pattern Generator file (in the Examples folder 
SAS “PatternGenerator\Single role (spg files)” subfolder and 
SATA“PatternGenerator\Single Role” subfolder). Single role means the file is for 
a Device or Host.

*.ssh SAS Search configuration File

*.stc SATA Protocol Analyzer/Capture Project/Viewer file (in the Examples folder 
“EasyCaptr”, “AdvanceCaptr”, or “Exerciser” subfolders)

*.sts SATA Sample file (in the SATA Examples folder “Sample” subfolder)

*.tsh SATA Search configuration file

*.wss SAS Workspace file (in the SAS System folder “Predefined\Workspace” 
subfolder)

*.wst SATA Workspace file (in the SATA System folder “PreDefined\Workspace” 
subfolder)

Example Projects
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The Analyzer includes example projects that you can use to perform an immediate 
analysis without any setup.

The Analyzer system software has a pre‐defined folder (directory) structure for storing all 
files. All example files are in the Examples folder under the Sierra M124 folder.

It is strongly recommended that you open some example files to see types of projects 
that you can create.

Run an Example Analysis Project

To run an example project:

1. Select File > Open.

2. Locate example analysis projects by looking in the Examples folder. Examples are 
available for AdvanceCaptr, EasyCaptr, Exerciser, Samples, and User Define Decoding 
Script.

3. In the EasyCaptr folder, choose an example *.sac file and click Open to display the 
example project dialog.

Figure 2.13: File Open Dialog
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Figure 2.14: SAS: Sample Protocol Analysis Project

SAS vs. SATA: For Pattern Parameters, SATA Dialog adds FIS, FIS Pattern, and ATA 
Command Pattern and does not have SSP Frame, SMP Frame, and Address Frame.

4. Click the Record button to execute the pre‐defined example.

5. After the project runs, you see an analyzer trace capture display similar to the one 
shown in Figure 2.15 on page 54
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Figure 2.15: SAS: Analyzer Trace Capture Display

For details about the results display, see “Display Manipulation” on page 111 and 
“Display Configuration” on page 198.

Patterns and Data Capture Setup

You can refine data capture by choosing Pattern and then selecting specific patterns for 
capture. Additionally, you can define a different set of patterns to capture after trigger.

To define specific patterns for capture, click the Pattern button (see Figure 2.16 on 
page 55.)
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Figure 2.16: SAS: Choosing Capture Patterns

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”.

The SAS Parameters window displays the following pattern capture choice categories:

 STP Frame
 Address Frame
 SMP Frame
 SSP Frame
 Data Pattern
 Protocol Errors

The SATA Parameters window displays the following pattern capture choice categories:

 FIS
 STP Frame
 Data Pattern
 Protocol Errors

Choose a Parameter

To choose a parameter for capture from any of these categories, highlight the category in 
the parameter window and click the Add>> button. This opens selection dialogs for each 
of the categories, displaying all parameters for that category. All of the patterns added 
appear in the project tree.
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Exclude Patterns

Check this box to allow capture of everything except the patterns added to the 
Project Tree. When you check this box, the system adds the Primitive category to the 
parameter window and enables Exclude Idle.

Figure 2.17: SAS: Exclude Patterns Checked

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has “ Exclude Dev Slp Packets”. 
SATA Dialog has different Pattern Parameters (see “Patterns and Data Capture Setup” on 
page 54.)

To remove an item from capture, highlight it in the Project Tree and click the <<Remove 
button.

Pre- and Post-Trigger Data Capture

You can define one set of patterns for capture prior to the occurrence of a trigger and 
another set of patterns for capture after the occurrence of a trigger. The selections and 
setup procedure is the same for both, the Pre‐Trigger capture and the Post‐Trigger 
capture. To define different patterns for pre‐trigger and post‐trigger data capture, check 
Define different patterns for pre‐trigger and post‐trigger data capture to enable the 
Post‐Trigger Capture tab (see Figure 2.18 on page 57).
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Figure 2.18: SAS: Post-trigger Capture Dialog Enabled

SAS vs. SATA: SATA Dialog replaces “Exclude SATA_CONT” with “Exclude CONT” and 
“Exclude SATA_SYNC” with “Exclude SYNC”. SATA Dialog has different Pattern Parameters 
(see “Patterns and Data Capture Setup” on page 54.)

Defining Patterns

To select an item for capture, either highlight the category and click the Add>> button or 
double‐click the category to open a corresponding definition dialog. You can define 
patterns for specific ports by checking or unchecking Port ID.
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Primitive

Double‐click Primitive (available only if you check Exclude Patterns) to open the Primitive 
selection dialog.

Figure 2.19: SAS: Primitive Dialog

SAS vs. SATA: SATA Dialog has no radio buttons and has different drop‐down options.

Click the down arrow next to the Primitive drop‐down list, choose a Primitive to exclude, 
and click OK. Repeat for additional Primitives.

Data Pattern

Double‐click Data Pattern to open the Data Pattern definition dialog.

Figure 2.20: SAS: Data Pattern Dialog

SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Port ID
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Define the data pattern for capture or exclusion from capture and click OK.

Note:When entering the data pattern in the “data” section of this screen, if you are reading the data 
pattern from a recorded trace, you must reverse the order of the bytes listed for each DWORD 
entered. For example, if you want to capture (or exclude) “00 01 02 03” (as displayed in the 
trace), you must enter this pattern as “03 02 01 00”.

Protocol Errors

Double‐click Protocol Errors to open the Protocol Errors selection dialog.

Figure 2.21: SAS: Protocol Errors Dialog

SAS vs. SATA: SATA dialog does not show ACK/NAK Timeout and has FIS signal‐latency and 
state‐transition errors, not STP ones. SATA dialog does not show ALL. SSP and SMP radio 
buttons.

Check protocol error(s) to omit or not capture, then click OK.

Protocol Errors

SMP Response Time Limit: is outside the specification requirements.

Code Violation: Wrong 10b symbol detected.
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Disparity Error: Wrong disparity detected. 

ALIGN Error: ALIGN primitive frequency is outside the specification requirements.

STP Signaling Latency Error [SAS only] or FIS Signaling Latency Error [SATA only]: 
DWORD difference between HOLD and HOLDA is greater than entered value in the HOLD/
HOLDA Response Timeout field.

STP Invalid State Transition (Unexpected Primitive) [SAS only] or FIS Invalid State 
Transition (Unexpected Primitive) [SATA only]: Second SATA_SOF is encountered before 
SATA_EOF, and other unexpected primitives.

STP Invalid State Transition (Primitive Timeout) [SAS only] or FIS Invalid State Transition 
(Primitive Timeout) [SATA only]: Timeout between two paired primitives is above 
entered value. 65000 DWORDs is default. For example, it can occur between WTRM and 
R_OK, or X_RDY and R_RDY. It expects device (or host) to send a response, but response is 
not received after 65000 DWORDs. You can configure Primitive Response Timeout and 
HOLD/HOLDA Response Timeout in the Settings tab Analyzer Settings section.

Frame Type Error: Wrong frame type.

Frame Length Error: Reported frame length is different than actual frame length.

Frame Direction Error: Wrong frame direction. For example, Register Device to Host 
coming from the Host.

CRC Error: CRC error detected.

ACK/NAK Timeout [SAS only]: ACK or NAK primitive missing or encountered 
unexpectedly.

Delimiter Error: Detects two SOF primitives without an EOF between them. Also detects 
two EOF primitives without an SOF between them. 

Radio Buttons: All, SSP, SMP and STP ‐ By selecting one of these radio boxes you can 
specify that you want to trigger(or filter) on a specific protocol error on a specified frame 
type. If you check CRC error and select the SSP radio button, if a CRC error occurs on a 
SMP frame, the analyzer does not trigger on it. 

Hashed Destination SAS Address (SSP trigger only): Specify the destination address for 
the analyzer to locate specific protocol errors. 

Hashed Source SAS Address (SSP trigger only): Specify the source address for the 
analyzer to locate specific protocol errors.
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STP Frame

Figure 2.22: STP Frame Type Dialog

Click the down arrow next to the Type drop‐down list box, choose an FIS type to capture 
or exclude, and click OK. Repeat for additional types.

Available FIS Types:

 Register Host to Device

 Register Device to Host

 Set Device Bits

 DMA Activate

 DMA Setup

 BIST

 PIO Setup

 Data

 Vendor
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Address Frame (SAS only)

Double‐click Address Frame to open the Address Frame Type Pattern dialog.

Figure 2.23: Address Frame Type Pattern Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Address Frame Types list box and choose an address 
frame type.

SMP Frame (SAS only)

Double‐click SMP Frame to open the SMP Frame Pattern dialog.

Figure 2.24: SMP Frame Pattern Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SMP Frame Type list box and choose a frame type. 
Assign a specific function to the frame by clicking the down arrow next to the Function 
list box and choose a function.
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SSP Frame (SAS only)

Double‐click SSP Frame to open the SSP Frame Pattern dialog.

Figure 2.25: SSP Frame Type Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SSP Frame Type list box and choose an SSP Frame type.

FIS (SATA only) 

Double‐click FIS (Frame Information Structure) to open the FIS Type selection dialog.

SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Type drop‐down list box, choose a FIS type to capture, 
and click OK. Repeat for additional types.

Available FIS Types:

 Register Host to Device
 Register Device to Host
 Set Device Bit
 DMA Activate
 DMA Setup
 BIST
 PIO Setup
 Data
 Any Type

STP Frame Pattern
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Double‐click STP Pattern to open the STP Pattern selection dialog.

Figure 2.26: SATA: STP Pattern Dialog

The STP Pattern dialog opens with the default FIS Type as Register Host to device. To 
choose another available FIS Type, click the down arrow next to the FIS Type list box.

Choose FIS Type and complete the corresponding dialog.

Register Host to Device

Figure 2.27: FIS Pattern - Register Host to Device Dialog
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Register Device to Host

Figure 2.28: FIS Pattern - Register Device to Host Dialog

Set Device Bits

 

Figure 2.29: FIS Pattern - Set Device Bits Dialog
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DMA Activate

Figure 2.30: FIS Pattern - DMA Activate Dialog

DMA Setup

Figure 2.31: FIS Pattern - DMA Setup Dialog
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BIST 

Figure 2.32: FIS Pattern - BIST Dialog

PIO Setup

Figure 2.33: FIS Pattern - PIO Setup Dialog
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Data

Figure 2.34: FIS Pattern - Data Dialog

Vendor

Vendor is for FIS Pattern.

Figure 2.35: FIS Pattern - Vendor Dialog

2.2.15 Trigger Setup

 The Trigger tab in the analysis project dialog allows you to specify when the analyzer 
completes a data capture. Three trigger modes are available: 

 Don’t care (Snapshot) is the default
 Manual Trig 
 Pattern

When data capture starts with Don’t care (Snapshot) selected, the analyzer triggers on 
the first data pattern on the bus. 
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Starting a data capture with Pattern selected triggers when specific pattern(s) are 
detected in the captured data stream. The following three ways can trigger the analyzer 
with Pattern selected.

 Trigger on any pattern (Any Trigger Mode)
 External Trigger
 Trigger on a sequence of patterns (Sequential Trigger Mode)

Snapshot Mode

To trigger immediately on any pattern, check the Don’t care (Snapshot) button.

Figure 2.36: Default Trigger Selected

Manual Trigger Mode

To perform a manual trigger, check the Manual Trig radio button. In the Manual Trigger 
mode, the analyzer captures bus traffic continually from when you use the Manual Trigger 
until you click the Stop Recording button (on the analyzer toolbar), which triggers the 

analyzer. Clicking the Manual Trigger   button on the application toolbar creates a 
Trigger Event and uploads the trace with the specified trigger position.

Any Trigger in Pattern Mode

In Pattern mode, the Analyzer triggers whenever any of the patterns selected for 
triggering occurs (an OR condition). The procedure for selecting trigger parameters is 
identical to that for selecting capture parameters. All items selected for triggering appear 
in the Project Tree.
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To define patterns for triggering, check the Pattern button in the Trigger dialog (see 
Figure 2.37 on page 70.)

Figure 2.37: SAS: Select Patterns for Trigger

The SAS Parameters window displays the following trigger pattern categories:

 Timer
 Timeout
 External/Manual Trigger
 Device Sleep
 Bus Condition
 Symbol
 Primitive
 STP Frame
 ATA Command
 ATAPI
 Address Frame
 SMP Frame
 SSP Frame
 SCSI Command
 Data Pattern
 Training Sequence
 Protocol Errors
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Define Sequential Trigger Mode

This is enabled when more than one pattern is used. It allows for the use of a simple state 
machine of “pattern A then pattern B”. When checked, the Count field in each pattern’s 
dialog is enabled (see Figure 2.38 on page 71).

Figure 2.38: Count Field Dialog

The SATA Parameters window displays the following trigger pattern categories:

 Timer
 Timeout
 External/Manual Trigger
 Device Sleep
 Bus Condition
 Symbol
 Primitive
 FIS
 STP Frame
 ATA Command
 ATA Command Pattern
 ATAPI
 Soft Reset
 Data Pattern
 Protocol Errors

Note: In packet view, you can right‐click on any frame, select Add to Trigger, and add the pattern to 
DataPatternCapture to make it a trigger pattern. 

Count field disabled Count field enabled
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Choosing a Parameter

Either highlight the category and click the Add>> button, or double‐click the category, to 
open a corresponding definition dialog.

To remove an item, highlight it in the Project Tree, then click the <<Remove button.

Triggering on a Timer

Selecting a timer for a trigger in the Any Trigger Mode limits the time that the analyzer 
looks for selected triggering conditions before triggering. The timer activates when the 
Project runs. If none of the selected triggering conditions occurs during the timer’s active 
time, the Analyzer triggers at the end of the time set for the timer.

You can set a timer independently of any other trigger selection, to cause an 
unconditional trigger after a set time.

To set the timer value, double‐click Timer in the Pattern window to open the Timer 
dialog.

Figure 2.39: Timer Dialog

Check a Time Unit, enter the Timer Value, and click OK.

Timeout

Selecting Timeout for the pattern opens the Timeout Pattern dialog.
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Figure 2.40: Timeout Dialog

"Start Events" starts the timer in Timeout Trigger and "End Events" triggers the analyzer (if 
first trigger mode is selected) or resets the trigger (if second trigger mode is selected). 
Repetitions of the Start Events are ignored until the End Event is encountered or the timer 
expires.

Select a pattern for Start Events or End Events, enter a Timeout value, then select Trigger 
Mode: 

 If End Events occur before timer expires
 If timer expires before End Events

Note:Timeouts can only be configured from the Timeout Pattern dialog. The Timeout Pattern dialog 
allows configuring other patterns as triggers in combination with timeouts. Other pattern dialogs 
do not allow configuration of timeouts.

External/Manual Trigger

To set up an external trigger click the External/Manual Trigger category.
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Figure 2.41: External/Manual Trigger Dialog

Device Sleep

To set up Device Sleep click the Device Sleep category. Select Rising Edge or Falling Edge.

Figure 2.42: Device Sleep Dialog

Bus Condition

Double‐click Bus Condition in the Patterns window of the Capture Project dialog to open 
the Bus Conditions dialog.

Figure 2.43: SAS: Bus Condition Dialog

SAS vs. SATA: SATA Dialog separates the COMINIT and COMRESET check boxes and 
replaces COMWAKE with Host COMWAKE and COMSAS with Device COMWAKE.

Check the Conditions to trigger on and click OK.

Note:You can define triggering for specific ports by checking or unchecking Port IDs. 

Port ID
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Symbol

Double‐click Symbol in the Patterns window of the Capture Project dialog to open the 
Symbol dialog.

Figure 2.44: SAS: Symbol Dialog

Choose a symbol type by checking either the K Symbol or D Symbol option, then click the 
down arrow in the Symbol drop‐down list, choose a symbol to trigger on, and click OK. 
Note that the D Symbol choice does not have a down arrow. 

To choose a D symbol, click the D symbol option button and enter a Hex value.

Primitive

Double‐click Primitive in the Patterns window of the Trigger dialog to open the Primitive 
dialog.

Figure 2.45: SAS: Primitive Dialog

SAS vs. SATA: SATA Dialog has no radio buttons and has different drop‐down options.

Click the down arrow next to the Primitive dropdown list, scroll the list to choose a 
primitive on which to trigger, and click OK. 

Note:Users need to exclude the ALIGN capture for the SAS SOF / EOF trigger and exclude the XXX 
capture for the SATA SOF / EOF trigger, in order for the trigger to precisely display on those 
primitives in the Link Data frame.
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Note:Check the box to the right of the Primitive Type to use the logical NOT.

.

Figure 2.46: SAS: Primitive Selection Choices
SAS vs. SATA: SATA Dialog has different choices.

Primitive Traffic Speed Option (SATA only)

You can change the speed for triggering as well as search by speed for Primitives.

Figure 2.47: Primitive Dialog

ATA Command

Double‐click ATA Command in the Patterns window of the Trigger dialog to open the ATA 
Command dialog (see Figure 2.48 on page 77) and (see Figure 2.49 on page 77).
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Figure 2.48: SAS: ATA Command Pattern Dialog

SAS vs. SATA: SATA Dialog has different dropdown options.

Figure 2.49: SATA: ATA Command Dialog

Click the down arrow next to the Command dropdown list, scroll the list to choose a 
command to trigger on, and click OK.

A powerful triggering choice is Any Command, which causes the analyzer to trigger on 
any ATA command.

Note:The command code and feature set are not the only parameters that describe an 
ATA command. For parameters such as LBA and sector count, you must use the ATA Command 
Pattern dialog.
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Data Pattern

Double‐click Data Pattern in the Patterns window of the Trigger dialog to open the Data 
Pattern dialog (see Figure 2.50).

Figure 2.50: SAS: Data Pattern Dialog

SAS vs. SATA: SATA Dialog shows Port at the top and does not show SSP or STP.

Define the data pattern for triggering and click OK.

Note:When entering the data pattern in the “Data” section of this screen, if you are reading the data 
pattern from a recorded trace, you must reverse the order of the bytes listed for each DWORD 
entered. For example, if you want to trigger on “00 01 02 03” (as displayed in the trace), you 
must enter this DWORD pattern as “03 02 01 00”.
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Training Sequence

Double‐click Training Sequence in the Patterns window of the Trigger dialog to open the 
Training Sequence dialog.

Figure 2.51: SAS: Training Sequence Dialog

SAS vs. SATA: Not available in SATA.

Define the training sequence for triggering and click OK.
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Protocol Errors

Double‐click Protocol Errors in the Patterns window of the Trigger dialog to open the 
Protocol Errors dialog.

Figure 2.52: SAS: Protocol Errors Dialog

SAS vs. SATA: SATA Dialog shows Port and does not show SSP, SMP, or STP radio buttons.

Check the protocol error(s) on which to trigger and click OK.
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ATAPI

Double‐click ATAPI in the Patterns window of the Trigger dialog to open the 
ATAPI Patterns dialog.

Figure 2.53: SAS: ATAPI Patterns Dialog

SAS vs. SATA: SATA Dialog has different dropdown options.

Click the down arrow next to the CDB dropdown list, scroll the list to choose a CDB Type, 
and click OK.

Address Frame (SAS only)

Double‐click Address Frame in the Patterns window of the Trigger dialog to open the 
Address Frame Type Pattern dialog.

Figure 2.54: SAS: Address Frame Type Pattern Dialog
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SAS vs. SATA: Not available in SATA.

Click the down arrow next to the Address Frame Type dropdown list, scroll the list to 
choose an address frame type on which to trigger, and click OK.

STP Frame

Double‐click STP Frame in the Patterns window of the Trigger dialog to open the STP 
Frame Type dialog.

Figure 2.55: SATA: FIS Pattern Dialog

Click the down arrow next to the FIS type dropdown list, scroll the list to choose an FIS 
type on which to trigger, and click OK.
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SMP Frame (SAS only)

Double‐click SMP Frame in the Patterns window of the Trigger dialog to open the SMP 
Frame Pattern dialog.

Figure 2.56: SAS: SMP Frame Pattern Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SMP Frame Types dropdown list and scroll the list to 
choose an SMP frame type on which to trigger. Then click the down arrow next to the 
Function dropdown list, choose a function, and click OK.

SSP Frame (SAS only)

Double‐click SSP Frame in the Patterns window of the Trigger dialog to open the 
SSP Frame Pattern dialog.

Figure 2.57: SAS: SSP Frame Type Dialog
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SAS vs. SATA: Not available in SATA.

Click the down arrow next to the SSP Frame Type dropdown list, scroll the list to choose 
an SSP frame type on which to trigger, and click OK.

SCSI Command (SAS only)

Double‐click SCSI Command in the Patterns window of the Trigger dialog to open the SCSI 
Command Pattern dialog.

Figure 2.58: SAS: SCSI Command Pattern Dialog

SAS vs. SATA: Not available in SATA.

Click the down arrow next to the CDB dropdown list, scroll the list to choose a CDB Type, 
and click OK.
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Timeout

Choosing timeout as a trigger condition allows you to define a timer with a timeout value 
that is reset to 0 and starts by occurrence of any events that you add to the Start Events 
list. You can then add one or more events to the End Events list and then choose a trigger 
to occur if an End event occurs before the timer expires, or if the timer expires before the 
occurrence of an end event. 

You add and define the Start and End events identically to the way that you define and 
add patterns to capture.

Figure 2.59: Timeout Pattern Dialog
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ATA Command Pattern (SATA only)

Double‐click ATA Command Pattern to open the ATA command pattern selection dialog.

Figure 2.60: SATA: ATA Command Pattern Dialog

SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Command list box, choose an ATA command, and click 
OK.
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FIS (SATA only)

Double‐click Frame Information Structure (FIS) to open the FIS Type selection dialog.

Figure 2.61: SATA: FIS Type Dialog

SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Type drop‐down list box, choose a FIS type on which to 
trigger, and click OK. Repeat for additional types.

Available FIS Types

Note:You cannot trigger on a Vendor FIS.

FIS Pattern (SATA only)

Double‐click FIS Pattern to open the FIS Pattern selection dialog (see Figure 2.62 on 
page 88).

 Register Host to Device
 Register Device to Host
 Set Device Bit
 DMA Activate
 Any Type

 DMA Setup
 BIST
 PIO Setup
 Data
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Figure 2.62: SATA: FIS Pattern Dialog

SAS vs. SATA: Not available in SAS.

The FIS Pattern dialog opens with the default FIS Type as Register Host to device. To 
choose another available FIS Type, click the down arrow next to the FIS Type list box.

SATA: FIS Pattern Dialog Choices

SAS vs. SATA: Not available in SAS.

Choose a FIS Type and complete the corresponding dialog.
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ATA Command Pattern (SATA only)

Double‐click ATA Command to open the ATA Command Pattern selection dialog.

Figure 2.63: SATA: ATA Command Pattern Dialog

SAS vs. SATA: Not available in SAS.

Click the down arrow next to the Command list box, choose an ATA command, and click 
OK.

Soft Reset (SATA only)

Double‐click Soft Reset to open the Soft Reset dialog.

Figure 2.64: SATA: Soft Reset Dialog

SAS vs. SATA: Not available in SAS.
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Sequential Trigger Mode

In the Sequential Trigger mode, triggering occurs whenever the system detects a specific 
sequence of patterns. The order in which you define triggering patterns establishes the 
sequence. You must define at least two patterns to enable the selection of the sequential 
trigger mode.

Note:Primitives and Symbols or Frames occurring very close together on different ports cause an 
error in triggering.

To define a triggering sequence, select more than one pattern, then check the 
Define Sequential Trigger Mode check box.

Figure 2.65: SAS: Select Sequential Trigger Mode

SAS vs. SATA: SATA Dialog has different patterns.

Timer

The sequential triggering mode offers the option of triggering on a timer or inserting a 
timer in the triggering sequence to delay detection of the next pattern in the sequence. 
To insert a timer in the trigger list, double‐click Timer to open the Timer definition dialog.

Enter a Time Value, choose the Time Unit, and click OK.
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Defining Patterns

The definition of patterns for the sequential trigger mode is identical to the Any Trigger 
mode, with the following exception: 

In the sequential triggering mode, the definition dialogs for these triggering patterns have 
an additional setting, to count the number of occurrences. This setting allows you to 
specify the number of times that the pattern must occur before triggering or proceeding 
in the trigger sequence.

Figure 2.66: Number of Occurrences DIalog

Note:The system counts events on each link independently, causing a trigger whenever the number of 
occurrences on any link equals the specified value.

Triggering Order

As you define and add triggering patterns, they display under the Trigger category in the 
Project Tree sequentially, in the order in which you entered them. When the project runs, 
the Analyzer detects the occurrence of each pattern in order and triggers on the last one.

You can reorder the sequence of triggering patterns. To change the sequence order, 
highlight a trigger pattern and use the Up or Down arrow to move it to a new position.

Figure 2.67: Triggering Order
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Pre-Trigger

You can set the amount of data to capture before and after the trigger, as a 
percentage of pre‐trigger, between 1% and 99%. Position the pre‐trigger slider to a 
percentage. This feature allows the evaluation of bus activity leading up to and after the 
triggering event. Figure 2.68 illustrates the operation of pre‐trigger in data memory.

Pre‐trigger data is capture of the specified percentage of data prior to the triggering 
event. It cannot be guaranteed and may be 0. This can occur when the triggering event 
occurs before storing the required amount of pre‐trigger event data. In such a case, the 
data display shows fewer than the specified data points prior to the triggering event.

Figure 2.68: Pre-Trigger Example, 20% Pre-Trigger

2.2.16 Project Settings

To set project options, click the Settings tab (see Figure 2.69 on page 93).
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Figure 2.69: SAS: Setting Project Options

SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows options 256 
and 258, and does not show 2048 or 2049.
For Speed, SATA Dialog shows H1, D1 to H4, D4 and does not show I1, T1 to I4, T4.
SATA Dialog does not show MUX Setting button.

SATA dialog shows DevSlp min detection time field to enter the debouncer value.

Memory Settings

The Trace Memory Status section has the following fields.

Trigger Position

Pre‐Trigger defaults to 50%, which defines the percentage of data to capture before and 
after the triggering event. You can change this percentage by dragging the slider.

Capture of the specified percentage of the data prior to the triggering event cannot be 
guaranteed and may be 0. This can occur if the triggering event occurs before storing the 
required amount of pre‐trigger event data. In such a case, the data display shows fewer 
than the specified data points prior to the triggering event. For more detail, (see “Pre‐
Trigger” on page 92.)

Note:Trigger Position only works when the triggering option is Pattern.
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In certain cases, when one port is recording traffic and filling up the memory much faster 
than another port, you might see traffic appearing only on one port for a while, and the 
other port's traffic will only appear later. This occurs as a function of the trigger position, 
and is normal, expected behavior of the analyzer.

Trace File Name

Click the ellipses next to the Sample File Name text box and choose a file name and 
location for the results of your current project.

Auto Run

To repeat the current capture and trigger setup automatically, check the Auto Run 
checkbox and enter the number of times in the Number of Run text box. The capture and 
trigger repeat automatically for the specified number of times, and the results are saved 
in consecutively numbered Sample.scs files.

Memory Size

In the Protocol Analyzer Settings tab, you can allot memory for the trace recording. Check 
Entire Memory to allow recording to use the whole memory, to capture the maximum 
amount of trace data. (Minimum size of memory is 2 GB. Maximum size of memory is 
16 GB.)

Partial Memory

To reduce the memory size, check Partial Memory and enter a buffer size in kilobytes, up 
to the memory size in megabytes.

Note: If the size of a data packet exceeds the buffer memory allocation, the project runs, but no data 
capture occurs. You must increase buffer memory size to a value greater than the packet size.

Segmented Memory

Alternatively, you can use Segmented Memory. Enter an integer # of Segment, from 1 to 
32, then enter an integer Segment Size in kilobytes, up to the memory size in megabytes 
divided by the number of segments. The default segment size is 10 MB. 

Each time a trigger condition occurs, the system records a new segment. You can use a 
Snapshot or Pattern trigger, but not Manual Trigger. As the same trigger automatically 
repeats, the system makes the number of segments that you entered.

Upload Manager

To upload segments manually in the Upload Manager, select the Don’t upload segments 
and open upload manager automatically checkbox. 
To upload segments automatically for display as the system creates them, do not select 
the checkbox.

To view segmented trace files, click the Upload Manager   button, beside the Record 
button, to display the Upload Manager dialog (see Figure 2.70 on page 95.)
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Figure 2.70: Upload Manager Dialog

The dialog displays the segments in the format Segment1, Segment2, and so on.

Select segments by clicking the checkbox. You can also Select All or Deselect All 
segments.

You can Upload segments for display, Save segments as sample files, and Delete 
segments.

The Preview radio button allows a preview of an integer number of megabytes around 
the trigger position. You can set the trigger position as a percentage and select the 
segment number. Click the radio button to Show Traffic Summary with the preview. To 
show the preview, click the Preview button.

2.2.17 Analyzer Settings

Primitive Response Timeout

The Primitive Response Timeout parameter specifies the number of DWORDs between 
two pair primitives after which the analyzer detects a protocol error. Default value is 
65000. When host or device sends a primitive, such as X_RDY, HOLD, or WTRM, it expects 
device or host to reply with a primitive, such as R_RDY, HOLDA, or R_OK. This parameter 
detects FIS Signaling Latency error, between HOLD and HOLDA, and FIS State Transition 
error, between X_RDY and R_RDY, between SOF and EOF, or between WTRM and R_OK or 
R_ERR.You can set a trigger on these protocol errors.

Disable Scrambling

If checked, causes the Analyzer to assume that no traffic is scrambled. By default, the 
Analyzer assumes the scrambling state of the devices under test. 
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Show XXXX value

Check this option to display XXXX values.

Pack Training Sequence

Checking this option allows hiding the details of the Training Sequence, which can take up 
large portions of the trace unless packed.

ALIGN Transmission Period (differs for SAS and SATA)

Choose the ALIGN Transmission Period for SSP and STP by clicking the corresponding 
option button, then open the Protocol Error Mask dialog.

Protocol Error Mask

Click the Protocol Error Mask button to open the Protocol Error Mask dialog.

Figure 2.71: Protocol Errors Dialog

Check the Protocol Errors that you want the Analyzer to ignore.

When “RD Error” and “Code violation Error” are set as trigger events: 
“RD Error” or “Code violation Error” can occur right after the OOB sequence.
“RD Error” or “Code violation Error” can occur right after the recovery from the PM state.

These errors are mainly caused by the long synchronization time of the analyzer. If these 
errors, caused by the Analyzer, become triggers, you cannot detect some other errors 
that you really need to detect. To NOT detect the above two errors, enable the software 
setting Disable ‘Disparity Error’ and ‘Symbol Violation’ during Speed negotiation. After 
this, the code violation is not triggered during the speed negotiation phase, but is 
triggered if the violation happens after the speed negotiation phase. 

External Trig Out Setting

The Analyzer can send a Low or High external signal when a trigger occurs. Under Setup 
select External Trig Setting to choose Trig Out Setting: High Active, Low Active, or Toggle 
from High to Low or Low to High once (3.3 V output). Enter the External TrigOut pulse 
width. 
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The pulse width is programmable in the software. The Voltage level is 0 to +3.3 Volt. The 
trigger out is derived by NL17SZ126 buffer. The delay for OOB traffic external trigger out is 
190 ns. The delays for non OOB external trigger out are:

 12G ~ 380 ns 
 6G ~ 530 ns 
 3G ~ 730 ns 
 1.5G ~ 1020 ns

External Trig In Setting

An external Low or High input signal can cause triggering. Under Setup select External 
Trig Setting to choose External Trig In Setting: High Active, Low Active, or Toggle from 
High to Low or Low to High once (3.3 V output).

Choose Port Speed

Figure 2.72: Speed Setting

The default speed is Autospeed. You can also select the port speed from the 
drop‐down list: 1.5 Gbps, 3.0 Gbps, 6.0 Gbps or 12.0 Gbps.

By selecting Autospeed 6G, you can limit the port speed to 6 Gbps, to eliminate the 
possibility of some speed‐related errors.
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Note: If a Port ID check box has no check, the analyzer does not capture any patterns for that port. The 
system allocates trace memory for that port to its adjacent port, for example: I1, T1 <‐> I2, T2 or 
I3, T3 <‐> I4, T4.

Ports Configuration

Click the Port Configuration button to display the Set Port Configuration dialog.

Figure 2.73: SAS: Set Port Configuration Dialog
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The dialog shows the current port configuration. To select a port configuration, click the 
down arrow to display the Select Port Configuration dialog.

Figure 2.74: SAS: Select Port Configuration Dialog

Port configuration depends on the application you run. Use the checkboxes at the top to 
filter the list of port configurations by the required function. 

Note:To display the current Port Configuration, click the green button in the lower right corner to 
display the Port Status window (see “Port Status” on page 195).
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2.2.18 Add a Project Note

To enter and save information about the current project, click the Notes tab and enter 
the data about the project.

 

Figure 2.75: Project Notes Tab

2.2.19 Advanced Mode (User-Defined)

Advanced Mode expands Analysis capability by allowing you to program complex 
triggering and data capture projects.

The Advanced Mode is a state machine with up to 23 different states. You can program 
each state individually to:

 Trigger on a different event or trigger unconditionally.
 Capture Everything, Nothing, or a user‐defined pattern.
 Include up to three ELSE IF statements, allowing a jump to any other state based 

on a user definition.
 Use up to three timers, which you can set to a maximum value of 42949 ms. You 

can set a timer in the state or continue the timer set in the previous state.
 Output an external trigger High or Low.

Note: In Advanced Mode, events on each link are counted independently. A condition is met if the 
number of events on a link equals the defined occurrence.
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Working in Advanced Mode

To start working in the Advanced Mode, click the Easy, Switch to Advanced Mode button 
in an open Analyzer window.

You can:

 Display the state definition
 Set Output Trigger level
 Select up to three timers
 Define the If condition and up to three Else If conditions
 Set number of occurrences before trigger
 Set captured data
 Set excluded data
 Go to next state
 Add state
 Choose link for Sequencer setup

 

Figure 2.76: SAS: State Programming Dialog
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Figure 2.77: SATA: State Programming Dialog

SAS vs. SATA: SATA Dialog removes Exclude ALIGN, Exclude RRDY, and Exclude NOTIFY.
SATA Dialog replaces Exclude SATA_CONT with Exclude CONT and Exclude SATA_SYNC 
with Exclude SYNC.
SATA Dialog has patterns Bus Condition, Primitive, FIS, FIS Pattern, Data Pattern, and 
Protocol Errors and does not have STP Frame, SMP Frame, STP Frame, or Address Frame.

Figure 2.78: SAS: Advanced Trigger with Multiple Branches
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State Number for Complex Trigger Sequences

To follow the path of complex trigger sequences, you can display state number. 

To see state number, in Packet View right‐click a link layer packet, show field, and select 
state number.

Setting Trigger Conditions

To set the If and Else If trigger condition:

1. Click the Add Pattern button  for a Pattern field and choose a trigger condition 
from the drop‐down list.

Figure 2.79: SAS: Choosing a Trigger Condition

2. Define each selected pattern in the same way as in Easy Mode, as described starting 
on page 57. To use a timer, define it first.

Note:You can set a timer for any If or Else If condition.

3. Enter a value for the number of occurrences before trigger in the Cont field, up to a 
maximum of 65535 occurrences.

4. Choose a capture option: Everything, Nothing, or Pattern.

5. If you choose Pattern, you can select patterns for inclusion or exclusion. Clicking the 
Pattern option enables a pattern definition dialog (see Figure 2.80 on page 104).
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Figure 2.80: SAS: Choosing a Pattern

6. Choose pattern(s) and click the +>> button to add them for capture or exclusion. You 
define each pattern the same way as in Easy mode (see “Defining Patterns” on 
page 57).

7. For an output trigger, click the down arrow in the Ext. Out field and choose an 
output trigger level. Note: Do not use the LOW setting in Advanced Mode.

8. To go to another state, click the down arrow in the Go To field and select a state. If 
no other state has been defined, choose New State to add a state.

2.2.20 Multi - Link Triggering

You can set different triggering for each link. To set different trigger conditions for a link, 
check the Multi Sequencer check box and select the link for setup from the Port drop‐
down list. Clicking the Make Same as Current button displays a warning: all sequencers 
will be changed to have same states as current sequencer. Click Yes to do so.

Figure 2.81: SAS: Multi - Link Triggering Setup

2.2.21 Set Timers

You can set and use up to three timers for triggering. You can set each timer for each 
state, or set it to continue from one set in the previous state. The timer defined for a 
particular state starts when the system enters that state. You can set a timer for any IF or 
ELSE IF condition. To set up the timers, click the ellipses in the Timer field next to the IF or 
ELSE IF condition in each state and define each of the timers in the Set Timers dialog (see 
Figure 2.82 on page 105).
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Figure 2.82: Set Timers Dialog

Note:Three timers are available. You have to set and start each timer in order to continue the next 
timer. For example, you have to start Timer 1, continue it, then set Timer 2 in order to continue 
it. It will not allow you to continue Timer 2 until you first set it.

2.2.22 Timeout

In the Timeout Pattern dialog (see Figure 2.83 on page 106) you can do the following:

 Set a Timeout. 
 Select a Pattern for the Start Event. (Start Event resets the timer.)
 Select a Pattern for the End Event. 
 Enter the Timeout Value in milliseconds or microseconds.
 Select a Trigger Mode:

 If End Event occurs before timer expires.
 If timer expires before End Event occurs.
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Figure 2.83: Timeout Dialog

WARNING: In Advanced Mode, Short State Jump Intervals Can Cause Hardware Queue 
Overflow and Corrupt Frames.
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When using Advanced Mode, if too many state jumps occur in a short time, the hardware 
queue can overflow, which may corrupt frames. For example, an infinite loop can cause 
many state jumps in a short time. Hardware overflow can occur if interval between state 
jumps is less than 60 DWORDs.

In Advanced Mode, infinite loops are usually used to check if an event occurs before a 
timeout. In this case, you can use the Timeout dialog to avoid hardware queue overflow.

 

Figure 2.84: State Machine with Multiple Patterns and Timer Elapse

In Figure 2.84, the port detects HARD_RESET, which starts the Timer. When the timer 
expires, it jumps to another state. If a trigger occurs between timer start and end, the 
captured trace will have corrupt frames because of hardware queue overflow.
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Figure 2.85: State Machine with Timeout Pattern to Replace Timer

To overcome this limitation, use a Timeout Pattern instead of Timer. Figure 2.85 shows 
the state machine using Timeout instead of Timer.

Figure 2.86 on page 108 shows the Timeout settings.

Figure 2.86: Timeout Settings
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Timeout begins when the port detects the Start Event. Timer begins when the port 
detects the Hard RESET primitive. In the Trigger Mode window, set the Trigger to trigger 
when the port detects the End Event, before the Timeout occurs. In our example, this is 
the Bus Condition. Capture begins when the ports detects the Bus Condition before the 
Timeout occurs. If the port does not detect the Bus Condition until the Timeout occurs, 
the State Machine in Figure 2.85 on page 108 jumps to State 0. 

2.2.23 Useful Key Sequences

The following key sequences are active to assist you in navigating a defined state 
machine:

Ctrl+a Add State
Insert Insert State
Del Delete State
Ctrl+c/Ctrl+Ins Copy
Ctrl+v/Shift+Ins Paste
Up/Down arrow keys Moves selection between states
Page Up/Page Down Page Up and Page Down states
Home Go to first page
End Go to end page

2.3 Project Settings

Prior to running the Advanced mode project, click the Settings tab. The options in the 
Settings dialog are the same as for the Easy Mode, described starting on page 92.

SAS vs. SATA: For the ALIGN Transmission Period section, SATA Dialog shows options 256 
and 258, and does not show 2048 or 2049.

For Speed, SATA Dialog shows H1, D1 to H4, D4 and does not show I1, T1 to I4, T4.
SATA Dialog does not show MUX Setting button.

2.3.1 Notes

To include some descriptive information about the project, click the Notes tab and enter a 
brief descriptive note (see “Add a Project Note” on page 100).
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Chapter 3

Display Manipulation
3.1 Viewer Display

After data is captured (Recorded), the Viewer displays a sample file (.scs for SAS and .sts 
for SATA) in Packet View.

Figure 3.1: SAS: Packet View of .scs Sample File.
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Figure 3.2: SATA: Packet View of .sts Sample File.

3.1.1 Quick View

Quick View is enabled as the default setting in Preferences > Trace Viewer tab. Quick 
View allows full access to the whole trace more quickly, especially when using a Gigabit 
Ethernet connection. However, the trace is NOT written to the host machine’s hard drive. 
To save the trace, you must manually click Save. 

If you uncheck Quick View in the Preferences > Trace Viewer tab to disable Quick View, 
the trace loads more slowly, but is automatically saved to the host machine’s hard drive. 
When Quick View is disabled, the Viewer displays successive parts of trace data as they 
upload. As soon as a trace part uploads, it is available in all trace views. 

If you only need quick successive traces, and do not need to save them, keep the default 
setting to enable Quick View.

If you need to save all captured traces, unchecking the Quick View setting loads traces 
faster, especially for larger traces and slower connections than Gigabit Ethernet.

To refresh the viewer display with more uploaded data, scroll to the end of the trace, 
using scroll bars, page down, arrow down, or CTRL‐End. Newly uploaded data then 
appears there.

Note:High‐level decoding and statistics are available only after the whole trace has uploaded.

The software automatically switches to full trace view after trace uploading finishes.

Note:Users must press CTRL Home to go to the beginning of an uploaded trace, and CTRL End to go to 
the end of an uploaded trace.
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3.1.2 Using the Viewer Display

To configure the data viewer display, use the toolbars. You can display the same data in:

 Packet view
 Spreadsheet view
 Column view, with transactions grouped for each active port
 Text view, with transactions grouped for each active port
 Waveform view
 Frame Inspector view
 Histogram view
 Bus Utilization view
 Data Report
 Statistical Report view
 Power Tracker View (SATA)

To change the view type when opening a sample, change the default workspace or save 
options in the Preferences dialog.

To toggle among open windows, use CTRL ‐ TAB. 
To reverse toggle order, use CTRL ‐ SHIFT ‐ TAB.

To make a frame a trigger pattern, in Packet View, right‐click any frame, select 
Add to Trigger, and add the pattern to DataPatternCapture. 

Viewer Display enables you to also perform the following:

 Decode Assignments (Refer to Decoding Assignments on page 115 for more 
details.)

 Compare Two Data Payloads (Refer to Compare Two Data Payloads on page 155 
for more details.)

 Run Verification Scripts (Refer to Running Verification Script Engine (VSE) on 
page 157 for more details.)

3.2 Trace Properties

You can view the Trace Properties from the File menu. Click File > Trace Properties, the 
Trace Properties dialog displays (see Figure 3.3 on page 114) with the following 
information:

 Software version
 Sample file version
 Grouping Type
 Hardware bin file version
 Analyzer armed at
 Analyzer triggered at
 Sample saved at
 Original Capture Project: Open displays the project settings used to capture the 

sample.
 Licensing Information
 Simpass Information
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Figure 3.3: Trace Properties Dialog

3.3 Analysis

The Analysis menu options allows you to see the trace in various views and switch views.

3.3.1 Show Analysis Toolbar

To display the capture in any of the other available views you can make the selection on 
the View Type toolbar as shown below or select the menu option under Analysis as 
shown in Figure 3.5 on page 115. 

Figure 3.4: View Type Toolbar

Compare 2 Data
Show Hide Fr. Inspector View

Show/Hide Statistical Report ViewShow/Hide Packet View

Show/Hide Spreadsheet View

Show/Hide Column View

Show/Hide

Decoding Assignments
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Show/Hide Bus 
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Show/Hide Histogram View
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Payloads

Verification Scripts
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Figure 3.5: SAS/SATA Analysis Menu

3.3.2 Decoding Assignments

Click on the Decoding Assignments icon   to display the Decoding Assignment dialog. 
Check a Hash Destination SAS Address checkbox to select it and select a SCSI Spec(s). 
Click the Add to Assigned List button to decode. Select a spec and click Remove it or click 
on Remove All to remove all the specs.

Figure 3.6: Decoding Assignments Dialog for SAS
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1

Figure 3.7: ATAPI Assignment Dialog for SATA 

3.3.3 Packet View

After you select a view, it appears in a separate window. To increase the new window

display size, select Analysis > Packet View or, click the   Show/Hide Packet View 
button.

When you scroll through either display using the scroll bar, the corresponding display in 
the other view scrolls with it.

You can rearrange the tiling by clicking Window and choosing Vertical or Horizontal 
tiling.

You can customize the color of any operation code field using either of the following two 
methods:

1. Right‐click on any command field in the trace. Select "Color of ..." option to set the 
color for the selected operation code field.
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2. In the Preferences window, select the Packet View tab. select the "Based on Specific 
Command Type" option. In the commands list, search for any command that you 
want, and change the background and foreground colors.

Packet View Metrics

The Metrics feature provides quick access to additional information about the packet 
data. Click the Metrics + icon as shown in Figure 3.8 to display the details.

Figure 3.8: Packet View Metrics

The following additional information of the packet is displayed when the Metrics field is 
expanded. Refer to Figure 3.9 on page 118.

Trp. No. ‐ Number of Transports

The total number of transports that compose this exchange.

Resp. Time ‐ Response Time

The time taken to transmit this command on the link(s) from the beginning of the 
first frame in the command to the end of the last frame in the command.

Pld. Bytes ‐ Payload Bytes

The number of payload bytes this operation transferred.

Latency Time
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The time measured from the transmission of the command to the first data 
transmitted for this IO operation.

Data‐Stat. Time ‐ Data to Status Time

The time between the end of data transmission for this command and the Status 
frame.

Thrpt MB/s‐ Data Throughput

The payload divided by response time expressed in MB per second.

Duration

The time taken from the first DWord to the last DWord in a line.

Figure 3.9: Packet View Metrics Expanded

Copying Packets from a Trace to a Host Emulator Script

This check mark in the illustration below shows packet (s) selected to copy. You can copy 
packet(s) from a trace and paste it into a host emulator script. That is why you can only 
mark packets that we support in emulator and host side packets. You can also mark 
multiple packets by left‐clicking and moving the mouse over multiple packets and then 
right‐click to select them, and paste them in an emulator script.

Figure 3.10: Packets Selected to Copy

This is applicable only when using M6‐4 or M6‐2 as only they support emulation.
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Device Sleep (DevSlp)

The Device Sleep status is displayed throughout the trace by right‐clicking and selecting 
Device Sleep in Packet View.

Figure 3.11: Right-click Device Sleep Menu.

The trace now displays the Device Sleep fields of all the packets (see Figure 3.12 on 
page 119). Current measurement accuracy is +/‐ 10mA for 5V and lower signals, and +/‐ 
100mA for 12V. Voltage measurement accuracy is +/‐ 100mV for 5V and lower and +/‐ 
150mV for 12V.

Figure 3.12: Device Sleep Fields.
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Viewing Check Condition Sense Data

When a Check Condition error occurs, you can view decode data from it. This info is 
shown in Packet View. Under Transport layer, expand Info Unit, then expand Sense Data. 
In Column View, check the "Show Field View in Column View" check box in SW settings, 
then display Field View while column View is open.

Figure 3.13: Check Condition Data. 

1. Open Packet View.

Figure 3.14: Packet view. 

2. Show Transport layer.

Figure 3.15: Transport layer.
120 Sierra M124 SAS/SATA Protocol Analyzer User Manual



Analysis  Teledyne LeCroy
3. Expand the Information Unit.

Figure 3.16: Information unit. 

4. Expand Sense Data. The hidden fields are revealed.

Figure 3.17: Sense data.

Figure 3.18: Figure 3.18: Sense data expanded. 
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3.3.4 Changing the Default View

Perform the following steps to change the default view of all trace files to Packet View: 

1. Open a trace file.

2. Select the Packet View. Close all other views.

3. Select File > Save Workspace to open a Save As dialog. Save the current workspace 
as a .wss file.

4. Select Setup > Preferences to open the Preferences dialog.

5. In the Default Workspace field, enter the path and name of the workspace .wss file 
that you saved in step 3.

Because the default workspace contains only Packet View, the software opens trace files 
in Packet View.

3.3.5 Spreadsheet View

Spreadsheet View displays all of the Packet View fields in a time sequential spreadsheet 
format. To display the Spreadsheet View of the current capture, click 

Analysis > Spreadsheet View or click the   button on the toolbar.

Figure 3.19: SAS: Spreadsheet View.

Figure 3.20: SATA: Spreadsheet View.

Right‐click a column heading to go to Preferences, make all columns the same width, 
choose Time Stamp Format, or Goto a position. 

Right‐click a column heading to Hide or Show the column. To show the same columns 
permanently, select Setup> Preferences > Trace Viewer > As Previously Saved. 

Right‐click a packet to change the background and foreground color.
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Right‐click the column to Add Bookmark or Edit Bookmark, Set Time Stamp Origin, go to 
Preferences, choose Time Stamp Format, Change Background (or Foreground) Color, or 
Goto a position.

Note:You can double‐click a data frame to display the data payload view. 
The Status column can show ABRT and UNC status. 

Export As Text/Excel

Select File > Export > Export to Text/Excel to open the Save As Text dialog. 

For Save As Type, select Text Files or Excel Files.

Select options from With comma delimiter, Export Duration and Save in a Single CSV File.

For Save As Range, select All Packets or enter a cursor range.

Enter a File Name and click Save.

Note:When SpreadSheet View is exported to text, the XFER‐Length field is always in hexadecimal 
format.

Note:The Export As Excel option is available only for Column View and Spreadsheet View.

Change Format of Logical Block Address (LBA)

You can set different LBA formats in Packet View and Spreadsheet View. To change the 
LBA format, right‐click the LBA column to display the popup menu, select Format, and 
change the format to Decimal, Hexadecimal, or Binary.

In Spreadsheet View, you can also click the Trace Viewer Configuration icon to display the 
Trace  Viewer Configuration dialog. Expand the Frame List/Spread Sheet View, select 
LBA/Sector#, and change the Format. If you cannot change the format there, select the 
Link Fields, Transport Fields, ATA Cmd. Fields, or SCSI Cmd. Fields node, select the field 
(such as “LBA High”), and then change the Format.

3.3.6 Column View

Column View displays the captured data grouped in columns by port (see Figure 3.21 on 
page 124). Each row shows captured DWORDs on different ports related to the 
timestamp. It also shows different speed (1.5G, 3G, 6G, 12G) DWORDs. Different DWORD 
cell height shows the duration of the DWORD. To display Column View of the current 

capture, click Analysis > Column View or click the   button on the toolbar.

You can click the + sign to expand the packet and ‐ sign to collapse the packet. Hovering 
over the signs displays a tooltip showing the contents of the packet (see the arrows in 
Figure 3.21 on page 124). Right‐click a packet to change the background and foreground 
color. 
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Figure 3.21: SAS: Column View

Right‐click in the Column View to display commands: 

 Add Bookmark
 Expand All
 Preferences
 Time Stamp Format (LeCroy Format, Milli Second, Micro Second)
 Go to (Trigger Position, X Position, Y Position, Packet Number, Time Stamp, Book‐

mark, Begin, End)
 Set X‐Pointer
 Set Y‐Pointer
 Change Background Color
 Change Foreground Color

Note:The Column View displays the CRC value. To see different formats (10b, 8b, scrambled, and so 
on), select a format by clicking its Tool menu button.

Resize Columns

You can resize the columns in Column View by clicking in the column boundary and 
dragging the boundary to a new position.

Rearrange Columns

You can rearrange columns by left‐clicking in the column title and then dragging the drag‐

and‐drop icon   to a new position.
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3.3.7 Text View

Text View displays the captured data interpreted as transaction frames, grouped in 
columns by port.

To display Text View, select Analysis > Text View or click the   button on the 
toolbar.

Figure 3.22: SAS: Text View

.

Figure 3.23: SATA: Text View

Note:The LBA and Tag Number value are shown in the All Lanes column.

3.3.8 Frame Inspector View

Frame Inspector View has lots of information that is available in Packet View, but not 
Spreadsheet View, so it is most useful in conjunction with the Spreadsheet View.
This view has the following three tabs:

Spec View: 

This view shows the Frame as it would appear in the spec, with the field names and values 
spelled out clearly. Fields that are too short to clearly contain the description can be 
viewed as tooltips by hovering the mouse over them. Some fields might have a a 
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lowercase ‘e’ button at the top right corner. Pressing this button displays an ‘expanded’ 
view of the sub‐fields in this field.

Field View: 

This view shows, when applicable, a hierarchical display of the selected Packet, with the 
relevant fields in each level.

To open a Frame Inspector View of the current capture, select View > Frame Inspector 

View or click the   button on the View Type toolbar.

Figure 3.24: Frame Inspector View

3.3.9 Waveform Display

You can enable a waveform display for all active ports, and perform timing 
measurements, by positioning timing cursors within the waveform display.

Select Analysis > Wave Form View or click the Show/Hide Waveform button on 
the toolbar to enable the waveform display (see Figure 3.25 on page 126).

The Compact View shows the OOB Sequence with speed negotiation.

Figure 3.25: SAS: Waveform View
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Figure 3.26: SATA: Waveform View

Making a Timing Measurement

Timing measurements are made with two timing cursors T1 and T2. Click the left mouse 
button in the gray bar on the top of the waveform display at a point for the T1 cursor, and 
the right mouse button at a point for the T2 cursor. The time difference between the 
cursors is on a line connecting the two cursors (see Figure 3.27 on page 127).

Figure 3.27: SATA: Timing Cursors Enabled

Expanded Waveform View

To see a 10x time scale expansion of the waveform, uncheck the Compact View checkbox in 
the Waveform View window. The OOB Sequence has speed negotiation (Hardware version 4 
or later). 

Figure 3.28: SATA: Expanded Waveform View

3.3.10 Statistical Report 

Whenever a captured sample is in the Sample Viewer, a Statistical Report selection in the 
Report menu and a Statistical Report Button on the viewer toolbar are enabled. You can 
create a Statistical Report for the entire capture or select a portion of it.
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To display a Statistical Report, click the   Statistical Report button on the viewer 
toolbar or select Report > Statistical Report to display the Select Statistical Report Range 
dialog (see Figure 3.29 on page 128).

Figure 3.29: Statistical Report Range Dialog

The default statistical report has All Samples. You can set a specific Statistical report range 
between defined cursor positions or events.

Generating Statistical Read/Write Report

To create a statistical read/write page perform the following steps:

1. Click on Setup > Preferences.

2. Click on the Trace Viewer tab.

3. Check the box Create statistical report read/write page (see Figure 3.30 on 
page 129.)
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Figure 3.30: Enabling Read/Write Statistical Report

Note:This setting should be enabled before you capture the trace file. 

If you have already captured a trace file and want to create a read/write statistical report 
for the sample, perform the following steps: 

1. Enable the read/write settings as mentioned above.

2. Open the trace file. 

3. Set the X pointer on the first packet in the viewer. 

4. Set the Y pointer on last packet in the viewer. 

5. Save as the trace file using the X to Y option. 

Now the saved trace file will contain the read/write statistical report. 

Report Between Cursors

Click the option button next to the From cursor selection drop down list. Then click the 
From down arrow and choose the 1st cursor, click the To down arrow to choose the 2nd 
cursor, and click OK. The resulting report has only the capture between the cursors (see 
Figure 3.31 on page 130).
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Figure 3.31: Report between Cursors

Report Between Events

Click the option button next to the From the event selection dropdown list, click the 
From down arrow to choose the 1st event, then enter the number of its occurrence. Next 
click the To down arrow to choose the 2nd event, then enter the number of its 
occurrence.

Figure 3.32: SATA: Report between Events

Click OK. The resulting report are limited to the capture between the defined events.

SAS vs. SATA: SAS adds Transport, SCSI Cmd, SMP Cmd, and Task Mng to the drop‐down 
list and deletes FIS and Phy Reset.

Statistical Report Content

SAS: A complete SAS statistical report consists of the following reports, accessed by 
clicking the corresponding tab in the dialog:

 General
 Bus Condition
 Primitive
 SSP Transport
 SMP Transport
 STP Transport
 ATA Command
 SCSI Command
 SMP Command
 Task Command
 SAS Address
 Read/Write Command
 Protocol Error
 Performance
 Lanes
 Others
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SATA: A complete SATA statistical report consists of the following reports, accessed by 
clicking the corresponding tab in the dialog:

 General
 Bus Condition
 Primitive
 FIS
 ATA Command
 ATAPI Command
 Read/Write Command
 Protocol Error
 Performance
 Others
 PM Statistic
 PM Performance

Note:Results are displayed only for items that have been captured in the sample.

Report Options

Some report categories offer options to display only specific items.These report 
categories incorporate drop‐down list boxes offering pre‐defined and custom options. For 
details see Formatting the Statistical Report View on page 146.

General Report

To display the General Report, click the General tab. The General Report displays the 
report data in columns with the following information (see Figure 3.33 on page 131).

 Type: All, Custom, Bus Condition, FIS, Identify Address Frame, 
Open Address Frame, SMP Frame, SSP Frame, STP Frame

 Direction: All, H‐>D, D‐>H, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.33: General Statistical Report
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Primitive Report

To display the Primitive Report, click the Primitive tab. The Primitive Report displays 
information in the following columns:

 Primitive: All, Custom, Unknown
For SATA: CONT, EOF, HOLD, HOLDA, R_IP, R_OK, R_RDY, SOF, SYNC, WTRM, 
X_RDY, ALIGN
FOR SAS: SATA_CONT, SATA_EOF, SATA_R_IP, SATA_R_OK, SATA_R_RDY, SATA_‐
SOF, SATA_SYNC, SATA_WTRM, SATA_X_RDY, ACK, EOF, SOF, EOAF, SOAF, 
AIP_WAITING_ON_DEVICE,AIP_NORMAL, DONE_NORMAL, READY_NORMAL, 
CLOSE_NORMAL, OPEN_ACCEPT, ALIGN0, ALIGN1, NOTIFY_ENABLE_SPINUP

 Direction: All, H‐>D, D‐>H, I‐>T, T‐>I, or Custom
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.34: Primitive Report

Bus Condition Report

To display the Bus Condition Report, click the Bus Condition tab. The Bus Condition 
Report displays information in the following columns.

 Bus Condition: All, Custom, Activity On, COMININT/COMRESET, COMSAS, COM‐
WAKE, Keep Alive Activity

 Direction: All, H‐>D, D‐>H, I‐>T, T‐>I, or Custom
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.35: Bus Condition Report
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ATA Command Report

To display the ATA Command Report, click the ATA Command tab. The ATA Command 
Report displays information in the following columns:

 Command: All, Custom, Check Power Mode, Execute Device Diagnostic, 
Flush Cache, Identify Device, Read DMA Ext, Read FPDMA Queue, Set Feature, 
Write DMA Ext, Write FPDMA Queue

 PM Port
 Direction: All, H‐>D, D‐>H, I‐>T, T‐>I, or Custom
 Number of FIS: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Incomplete, Normal Output
 Timeout: such as All, Custom, N/A, Yes, No (see Time out of ATA Command 

Report on page 133)
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.36: SATA: ATA Command Report

Time out of ATA Command Report

The Time out shows the NCQ time out. It is applicable for only NCQ commands. A 
threshold can be set in the "NCQ commands Timeout Threshold", the default value is 
1000 sec (the user can change it to any value). The statistical report provides a "Time 
out" report based on this threshold. Any NCQ command that takes more than the given 
threshold is flagged as "yes", which means that a timeout occurred for that command.

ATAPI Report

To display the ATAPI Report (see Figure 3.37 on page 134), click the ATAPI tab. The ATAPI 
Report displays information in the following columns:

 Command: All, Custom, Inquiry, Mode Sense 10, Read10, Request Sense
 Direction: All, H‐>D, D‐>H, or Custom
 Number of FIS or Number of Transport: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Check Condition, Good
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: of total count
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 133



Teledyne LeCroy Analysis
Figure 3.37: SATA: ATAPI Report

Protocol Error Report

To display the Protocol Error Report, click the Protocol Error tab.The Protocol Error 
Report displays the report data in columns with the following information:

 Protocol Error: All, Custom, Code Violation, CRC Error, Disparity Error, Align‐
Notify Error

 Direction: All, H‐>D, D‐>H, I‐>T, T‐>I, or Custom
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.38: SAS: Protocol Error Report

Others Report

To display the Others Report (see Figure 3.39 on page 135), click the Others tab. The 
Others Report displays information in the following columns:

 Items
 Idle No: Number of idle packets
 Payload Size: Total number of payloads in trace files (SCSI + ATA commands)
 Sample Time: Sample time
 Idle (Initiator): Host idle time
 Idle (Target): Device idle time (total)
 SSP Bus Utilization: SSP bus utilization time (SSP frames)
 SMP Bus Utilization: SSP bus utilization time (SMP frames) 
 STP Bus Utilization: SSP bus utilization time (STP frames)

 Report
 Count or Time
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Figure 3.39: Others Report

SSP Transport Report (SAS)

To display the SSP Transport Report, click the SSP Transport tab. The SSP Transport Report 
displays the report data in columns with the following information:

 Type: All, Custom, Command, Data, Response, XFER_RDY
 Direction: All, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.40: SAS: SSP Transport Report

SMP Transport Report (SAS)

To display the SMP Transport Report, click the SMP Transport tab. The SMP Transport 
Report displays the report data in columns with the following information:

 Type: All, Custom, Request, Response
 Direction: All, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.41: SAS: SMP Transport Report
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STP Transport Report (SAS)

To display the STP Transport Report, click the STP Transport tab. The STP Transport 
Report displays the report data in columns with the following information (see 
Figure 3.42 on page 136):

 FIS Type: All, Custom, Data, PIO Setup, Register Host To Device, 
Register Device To Host

 PM Port
 Direction: All, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.42: SAS: STP Transport Report

SCSI Command Report (SAS)

To display the SCSI Command Report, click the SCSI Command tab. The SCSI Command 
Report displays the report data in columns with the following information:

 Command: All, Custom, Inquiry, Mode Sense6, Pause Resume, Play Audio 10, 
Read Capacity, Read10, Receive Diagnostic Results, Send Diagnostic, Write10, 
Start Stop Unit, Test Unit Ready, Report Luns, Synchronize Cache10

 Direction: All, I‐>T, T‐>I, or Custom
 Number of Transport: All, Custom, or a number
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Good, Incomplete, Response Data Present
 Task Attribute: Simple
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.43: SAS: SCSI Command Report

SMP Command Report (SAS)

To display the SMP Command Report (see Figure 3.44 on page 137), click the SMP 
Command tab. The SMP Command Report displays the report data in columns with the 
following information:

 Function: All, Custom, Discover, Report General, 
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Report Manufacture Information, Report PHY Error Log
 Function Result: SMP Function Accepted
 Direction: All, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.44: SAS: SMP Command Report

Task Command Report (SAS)

To display the Task Command Report, click the TASK Command tab. The Task Command 
Report displays the report data in columns with the following information:

 Function
 Status
 Direction: All, I‐>T, T‐>I, or Custom
 Duration: All, Custom, or time unit
 Count: All, Custom, or a number
 %: of total count

Figure 3.45: SAS: TASK Command Report

SAS Address Report (SAS)

To display the SAS Address Report, click the SAS Address tab.The SAS Address Report 
displays the report data in columns with the following information. See the following 
screen capture:

 Source SAS Address: All, Custom, or an address
 Destination SAS Address: All, Custom, or an address
 Protocol Type: SMP, SSP, STP
 Frame Type: All, Custom, Command, Data, DMA Activate, 

Register Host To Device, Register Device To Host, Response, XFER_RDY
 Count: All, Custom, or a number
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Figure 3.46: SAS: SAS Address Report

Lanes Report (SAS)

To display the Lanes Report, click the Lanes tab. The Lanes Report displays the report data 
in columns with the following information:

 Port
 Open Accept: All, Custom, or a number
 Open Reject: All, Custom, or a number
 AIP Waiting on Con.
 Break
 SCSI Command: All, Custom, or a number
 ATA Command: All, Custom, or a number
 SMP Command: All, Custom, or a number
 Out Standing Command: All, Custom, or a number
 Transfer Bytes: All, Custom, or a number
 Link Utilization (time)
 Link Utilization%

Figure 3.47: SAS Lanes Report

Read/Write Command Report (SAS)

To display the Read/Write Command Report (see Figure 3.48 on page 139), click the 
Read/Write Command tab. You can enable or disable creation of this page by selecting 
Create statistical report read/write page in the Trace Viewer tab (see Trace Viewer Tab 
on page 212). The Read/Write Command report displays the report data in columns with 
the following information:

 Source SAS Address
 Destination SAS Address
 Protocol Type
 OpCode/Command
 Tag
 LBA
 Sector Count
 Xfer Length
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Good
 Completion Time
 Performance
 Standard Deviation
 Count: All, Custom, or a number
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Figure 3.48: SAS: Read Write Command Report

Performance Report (SAS)

To display the Performance Report, click the Performance tab.The Performance Report 
displays the report data in columns with the following information:

 Minimum Completion Time
 Average Completion Time
 Maximum Completion Time
 Initiator Bus Utilization
 Target Bus Utilization
 Efficiency
 Total Read Cmd
 Total Read (Bytes)
 Total Read Duration
 Cmd Minimum Read (MB/S)
 Cmd Average Read (MB/S)
 Cmd Maximum Read (MB/S)
 Total Write Cmd
 Total Write (Bytes)
 Total Write Duration is the sum of all write commands duration.
 Cmd Minimum Write (MB/S)
 Cmd Average Write (MB/S) is the Total Write (Total payload size of all write com‐

mands in sample file in MB) / Total Completion Time (Total completion time of all 
write commands in sample file in seconds).

 Cmd Maximum Write (MB/S)
 Average Byte per SSP Frame
 Average Byte per STP Frame

Figure 3.49: SAS: Performance Report

Performance Report (SATA)

To display the Performance Report, click the Performance tab. The Performance Report 
(see Figure 3.50 on page 140) displays information in the following columns:

 Minimum Completion Time
 Average Completion Time
 Maximum Completion Time
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 Host Bus Utilization
 Device Bus Utilization
 Efficiency (%)
 Total Read Cmd
 Total Read (Bytes)
 Total Read Duration
 Cmd Minimum Read (MB/S)
 Cmd Average Read (MB/S)
 Cmd Maximum Read (MB/S)
 Total Write Cmd
 Total Write (Bytes)
 Total Write Duration is the sum of all write commands duration.
 Cmd Minimum Write (MB/S)
 Cmd Average Write (MB/S) is the Total Write (Total payload size of all write com‐

mands in sample file in MB) / Total Completion Time (Total completion time of 
all write commands in sample file in seconds).

 Cmd Maximum Write (MB/S)
 Average Byte Per FIS
 FIS Minimum Difference Time
 FIS Average Difference Time is the difference between two back to back FIS in 

the same link and is the average.
 FIS Maximum Difference Time

Figure 3.50: SATA: Performance Report

FIS Report (SATA)

To display the FIS Report (see Figure 3.51 on page 141), click the FIS tab. The FIS Report 
displays information in the following columns:

 FIS Type: All, Custom, Data, PIO Setup, Register Host To Device, 
Register Device To Host

 PM Port
 Direction: All, H‐>D, D‐>H, or Custom
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: of total count
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Figure 3.51: SATA: FIS Report

Queue Command Report (SATA)

To display the Queue Command Report, click the Queue Command tab. The 
Queue Command Report displays information in the following columns:

 Command: All, Custom, Read DMA Queued
 PM Port
 Status: All, Custom, Normal Output
 Payload Size: All, Custom, or a number of DWORDs
 Direction: All, H‐>D, D‐>H, or Custom
 Duration: All, Custom, or time unit (accumulative)
 Count: All, Custom, or a number of occurrences
 %: of total count

Figure 3.52: SATA: Queue Command Report

PM Statistic Report (SATA)

To display the PM Statistic Report (see Figure 3.53 on page 142), click the PM Statistic 
tab. The PM Statistic Report displays information in the following columns:

 Request Type: PMREQ_P
 Request Port
 Response Type: All, Custom, PMACK
 Response Time
 Request Entering Delay
 Response Entering Delay
 Wakeup Type
 Request DC Idle Time
 Response DC Idle Time
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 Request Wakeup Time
 Response Wakeup Time
 Count: All, Custom, or a number

Figure 3.53: SATA: PM Statistic Report

PM Performance Report (SATA)

To display the PM Performance Report, click the PM Performance tab. The 
PM Performance Report displays information in the following columns:

 Port
 Partial Request
 Partial ACKed
 Partial NACKed
 Slumber Request
 Slumber ACKed
 Slumber NACKed
 Partial Time / Slumber Time %
 Partial Time / Total Time %
 Slumber Time / Total Time %

Figure 3.54: SATA: PM Performance Report
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Read Write Command Report (SATA) 

To display the Read/Write Co

To display the Read/Write Command Report, click the Read/Write Command tab. You can 
enable or disable creation of this page by selecting Create statistical report read/write 
page in the Trace Viewer tab (see Trace Viewer Tab on page 212). The Read/Write 
Command Report displays information in the following columns:

 Time Stamp
 OpCode/Command
 LBA
 Sector Count
 Payload Size: All, Custom, or a number of DWORDs
 Status: All, Custom, Good
 Completion Time
 Count: All, Custom, or a number

Figure 3.55: SATA: Read Write Command Report

3.3.11 Statistical Report Toolbar

 The Statistical Report toolbar provides the following functions accessible by but‐
tons on the toolbar:

 Export to Excel
 Save as Text
 Print Report
 Print Preview
 Report Display Settings
 Move to X‐Cursor, Y‐Cursor, or None
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Export as Microsoft® Excel file

Save as Text file

Print Statistical Report

Print Preview

Figure 3.56: Sample Print Preview of Report

The Export to Excel button opens the Export to Excel dialog. Choose a folder in 
which to save the Excel file, choose an appropriate file name, and click Save.

The Save as Text button opens the Export to Text dialog. Choose a folder in 
which to save the Text file, choose an appropriate file name, and click Save.

The Print button opens the select printer dialog. Choose an available printer 
and click OK.

The Print Preview button displays a preview of the report to print.
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Report Display Settings

You can set up the report columns for display to suit a particular analysis need, 
eliminating the need to show/hide columns individually. Use the Setting dialog to 
configure the display for each page (see Figure 3.57 and Figure 3.58).

Figure 3.57: SAS: Statistical Report Column Setting

Figure 3.58: SATA: Statistical Report Column Setting

The Setting button opens the Setting dialog.
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Link With Sample View

When you select a type on any page of the Statistical Report, a set of navigation buttons 
allows you to examine each instance of that type in the Sample Viewer.

3.3.12 Formatting the Statistical Report View

Initially the Statistical Report View contains all of the information in columns, but you can 
customize the display by:

 Filtering columns by item
 Sorting items by column
 Hiding any column on the display

Filtering Column Content

To filter column content, click the down arrow in the heading for that column and choose 
the items to display. The default is All. By checking a specific item, you exclude everything 
but that item for display.

Figure 3.59: SAS: Type

The Jump to Previous button goes to the previous instance of the selected type 
in the Sample Viewer.

The Jump to Next button goes to the next instance of the selected type in the 
Sample Viewer. 

The Jump to Specific button goes to the instance specified as N of M items on 
the Statistical Report toolbar.

The Move drop‐down list moves to the X‐Cursor, Y‐Cursor, or None.
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Choosing Custom allows you to specify more than one item for display (see Figure 3.60).

Figure 3.60: SAS: Custom Filter

.

Figure 3.61: SATA: FIS Type

Choosing Custom allows you to specify more than one item for display (see Figure 3.62 on 
page 148).
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Figure 3.62: SATA: Custom Filter

Check the items to display and click OK.

Sorting Column Content

To sort column content, click the heading for that column. Repeated clicking of the 
column heading sorts the column in ascending or descending order.

Figure 3.63: Toggling Type Sort Order

Hiding Columns

To hide a column, right‐click in the column and choose Hide. To unhide a column, right‐
click any column and choose Unhide.
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3.3.13 Histogram View

The Histogram View displays a histogram of frame‐type transfers.

To display the Histogram View of the current capture, click Analysis > Histogram View or 

click the   button on the toolbar.

Figure 3.64: Histogram View

Hide Frames

You can customize the histogram by including only frame types that you want.

To choose frame types to include in the display, click the down arrow on the Frame 
button on the Histogram toolbar and check frame types:

Figure 3.65: SAS: Histogram Frames

Figure 3.66: SAS: Histogram Frames

Hide Error Frames

Frames with errors are displayed in red. To hide error frames from the histogram, click the 

 button.

Note:To display the error code of a protocol error, click the error icon (with the red 'x').
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User Defined

You can define additional items for inclusion in the Histogram by clicking the 

button to open the User Defined dialog.

Figure 3.67: SAS: Histogram User Defined Dialog

You can include Primitive and/or Outside Connections frames.

Primitives

To include Primitives, check the Primitive check box, click the down arrow on the 
Primitive list box, and choose a Primitive.

 

Figure 3.68: SAS: Choosing a Primitive

.

Figure 3.69: SATA: Choosing a Primitive

Check a Connection Type option radio button, if available, and click OK.
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Zoom

You can Zoom from x1 to x256.

3.3.14 Bus Utilization View

The Bus Utilization View displays information on pending IO. To display the Bus Utilization 
View of the current capture, 

click Analysis > Bus Utilization View or click the   button on the tool bar.

Figure 3.70: SAS: Bus Utilization View for Pending SCSI IO

Figure 3.71: SATA: Bus Utilization View for Pending ATA IO

Available Bus Utilization Views are:

 Pending SCSI IO (for SAS)
 Pending ATA IO (for SATA)

Hovering the mouse over the graph heading displays the graph legend:

 Go to ATA/SCSI Cmd. #: Jump to command.
 Synchronize with Trace View: Synchronize all open views to that location in the 

trace.
 Fit to Graph Area: Zoom to fit.
 Hide: Do not display the graph.

To synchronize all open views to that location in the trace, double‐click the graph.
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Bus Utilization Buttons

The Bus Utilization window has a row of buttons for changing the format of the displayed 
data. The buttons have the following functions: 

3.3.15 Data Report

When a captured sample is in the Sample Viewer, the Data Report button is on the 
Viewer toolbar, and Data Report is in the Report menu.

The data report displays all the data sent from the host to the device and from the device 
to the host. All PIO In =>In commands are grouped as a data packet until the occurrence 
of a PIO Out =>Out command, creating a new data packet.

To display a Data Report, click the   Data Report button on the Viewer toolbar or 
select Analysis > Data Report.

Figure 3.72: SAS: Data Report

Click the Down Arrow in a data field to display Data Report details (see Figure 3.73 on 
page 153).

Horizontal zoom in Vertical zoom in

Horizontal zoom out Vertical zoom out
Graph Areas
Presents options for displaying additional 
graphs.

Click and Drag zoom
Click diagonally to select and 
zoom in on part of the graph.

Hide graph. Graph legend (see previous 
page)
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Figure 3.73: SAS: Data Report Details

Click the Statistics button  at the end of a row to display data report 
statistics.

Figure 3.74: SAS: Data Report Statistics

Data Payload View

To display the Data Payload View, double‐click a data payload field in a Packet or 
Spreadsheet view, or right‐click a data payload field and select Open as Data View (see 
Figure 3.75 on page 154).
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Figure 3.75: Data Payload View

Note:When showing truncated data in the Data Payload View, the truncation points are marked with 
a separator placed between payloads. You can get more information about the data exclusion 
using the tooltip over the separator.

Note:You can control the number of bytes per line.

Find Data Pattern

To quickly locate a data pattern in the current frame, enter the pattern in the Text Box 
and click the Find button.
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3.3.16 Compare Two Data Payloads

To compare two data payloads, select two different payload packets, one as reference. 
Right‐click a payload field in Packet View or a related frame in Text View or Spreadsheet 
View to display a menu, then select Set As Reference Data Payload.

Right‐click a payload field in Packet View or a related frame in Text View or Spreadsheet 
View to display a menu, and choose Set as Second Data Payload.

To compare data payloads, click the
Show/Hide Compare 2 Data Payloads button on the toolbar:

Figure 3.76: Compare Two Data Payloads
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3.4 Power Tracker View (SATA only)

Click the   Power Tracker View button on the Viewer toolbar or select Analysis > 
Power Tracker View. The Power Tracker View displays all the power, current and voltage 
information captured while recording a trace as well as the sample time. See Power 
Management Setting (SATA only) on page 107 for more information.

The power, voltage and current is displayed on the vertical axis and time on the 
horizontal axis. Hover anywhere over the view to display the information pop‐up.

Figure 3.77: SATA: Power Tracker View 

The Zoom In button on the toolbar magnifies the data display area on the 
screen.

The Zoom In button on the toolbar magnifies the data display area on the 
screen. 

The Zoom By Selection button on the toolbar magnifies the user selected 
area in the view.

Information Pop-up Time MarkerVoltage saved during capture
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3.5 Using the Power Expansion Card

You can use the Power Expansion Card to power the drives under test. See Using the 
Power Expansion Cards on page 21.

3.6 Running Verification Script Engine (VSE)

You can perform custom post‐process analysis of the open trace by running a verification 
script over the trace. A verification script instructs the application to send trace and 
analysis information to the script. A verification script also contains script code, written 
using CATC Script Language (CSL) (see the CSL_RefManual.pdf document in the docs 
directory of the installation), used to process trace data and output that data in different 
formats.

The Zoom By H Drag button on the toolbar magnifies the area selected by 
horizontally dragging and selecting in the view.

The Zoom By V Drag button on the toolbar magnifies the area selected by 
vertically dragging and selecting in the view.

The Full Screen button on the toolbar Toggles between normal and full 
screen view.

The Pointer Mode button on the toolbar changes the cursor to a pointer.

The Hand Panning button on the toolbar changes the cursor to a hand for 
panning.

The Insert Time Marker button on the toolbar enables inserting a time 
marker at selected spot in the view (see Figure 3.77 on page 156).

The Sync by Time button on the toolbar toggles between synchronizing and 
un‐synchronizing all the views by time.

The Show/Hide Power Tracker types: W, V, A button on the toolbar allows 
the user to select the parameters to view from the list.

The Change Power Tracker graph type: W, V, A button on the toolbar allows 
the user to select one of the three graph types to view from the list.

Displays the voltage saved during trace capture. This is selected in 
the Power Management Setting dialog (see Power Management 
Setting (SATA only) on page 107).
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Note:You may write your own verification scripts to perform custom verification and analysis. For 
information on how to write a verification script, see the Verification Script Engine Reference 
Manual.

To run a verification script over a trace:

1. Select the main menu item Analysis > VSE or click the Running verification scripts 

button on the main tool bar. The Run Verification Scripts dialog opens, from 
which you choose and then run one or several verification scripts.

Figure 3.78: Run Verification Scripts Dialog.

To expand the Log window, click the Expand Log button. The Log window fills the 
whole window. To see the Verification Scripts window again, click the Collapse Log 
button.

To save output, click the Save Output button.

2. After choosing Settings from the drop‐down list or the button, the Settings dialog 
displays:
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Figure 3.79: Run Verification Scripts - Settings Dialog.

Choose the editor application: Notepad or other.

Edit all selected scripts in one process: If the editor supports multiple documents, you 
can edit all scripts in the editor.

Open all included files: You can edit included files, as well as the main script.

Launch editor application in full screen: You can use whole screen.

Path to the template file for a new script: You can use a template for the script.

Display Settings can show full trace‐file path, restore dialog at start, load last output from 
save log files, activate dialog after scripts have run, remember dialog layout, and ignore 
errors and warnings.

Saving Settings can save log files to relative file folder, indicate output‐log‐file path, and 
save logs automatically.

3. Click the Run scripts button after you select scripts to run. VSE starts running the 
selected verification scripts, shows script report information in the output windows, 
and presents the results of verifications in the script list:
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Figure 3.80: Run Verification Scripts Dialog.

4. Right‐clicking in the script list displays some additional operations over selected 
scripts:

Figure 3.81: Run Verification Scripts - Menu new.
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Run verification script(s): Start running selected script(s).

Edit script: Edit selected scripts in the editor application specified in Editor settings.

New script: Create a new script file using the template specified in Editor settings.

Show Grid: Show/hide a grid in the verification script list.

Show Description window: Show/hide the script description window (Shortcut key F2).

Show Output: Show/hide the script output windows (Shortcut key F3).

Settings: Open a special Setting dialog to specify different settings for VSE.

3.7 Navigation + View Toolbar

The Navigation + View toolbar allows you to navigate, search filter, hide RRDY/all 
primitives and unassociated traffic, zoom, tile views and select ports.

The down arrow on the Go To button allows location of cursors or specific 
packets: Trigger Position, X Position, Y Position, Packet Number, Timestamp, 
Bookmark, Begin, and End.

The Search button opens the search dialog (see Search on page 179).

The Filtering Setup button opens the Filter dialog (see Filtering on page 166) 
and allows you to specify the criteria for filtering the result.

The Enable Disable Filtering button toggles the result between a filtered and 
unfiltered view (see Filtering on page 166).

The Filter Idle button toggles the display to show/hide idle packets (see 
Filtering on page 166).

The Hide RRDY Primitives button toggles the display to show/hide RRDY 
primitives (see Filtering on page 166).

The Hide Unassociated Traffic button toggles the display to show/hide 
unassociated traffic (see Filtering on page 166).

The Hide All Primitives button toggles the display to show/hide all primitives 
(see Filtering on page 166). Note: When capturing PM traces, you need the 
ability to filter the PM primitives so you can find commands quicker. 
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3.7.1 Go To Menu

Locate Cursors

To quickly locate any cursor within the data viewer display, click the Go To button and 
choose the cursor to locate. You can also locate a cursor by selecting Go To from the Edit 
menu and choosing the cursor to locate.

Figure 3.82: Locate Cursor

The Zoom In button on the Viewer Setting Toolbar magnifies the data display 
area on the screen. Clicking this button in Column or Text View increases 
column width only.

The Zoom Out button on the Viewer Setting Toolbar scales the data display 
area to display more data lines on the screen. Clicking this button in Column 
or Text View decreases column width only.

The Normal Zoom button on the Viewer Setting Toolbar resets the zoom to 
default normal on the screen. Clicking this button in Column or Text View 
resets column width only.

You can use Tile Horizontally All Views icon or select View > Tile Views to 
revert any unintended window docking or sizing, or maximize screen 
utilization. This function only tiles views inside a trace window.

Note that there is no command to tile views vertically.
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Go to Time Stamp

To locate a timestamp, click the Go To button and choose Timestamp (see the following 
screen capture.)

Figure 3.83: Time Stamp.

Enter a time stamp value in the Go To Timestamp dialog and click OK.

Figure 3.84: Go to Time Stamp.

Bookmarks

Bookmarks are a convenient way to mark a point in the data viewer display by name, so 
that you can rapidly return to that point. To create a bookmark, right‐click the mouse in 
the data viewer area on a packet in which to place the bookmark.

Figure 3.85: Bookmark.
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Click Bookmark from the fly out menu to open the Bookmark Comment Dialog.

Figure 3.86: Bookmark Dialog.

Enter a description for the bookmark and click the Add button. Repeat for additional 
bookmarks.

You can save the bookmark as a text file or Excel CSV file.

Note:Column View has a different bookmark mechanism than other views, and you can set a 
bookmark on each DWORD in the view. This makes Column View bookmarks unavailable in 
other views and vice versa.

Editing a Bookmark

If a packet has a bookmark, you can edit the bookmark by right‐clicking the data viewer 
area of the packet, selecting the Edit Bookmark command from the
pop‐up menu, and changing the information in the Bookmark dialog (see above). 

Finding a Bookmark

To find a bookmark in the data viewer display, right‐click the mouse in the sample viewer 
and select Bookmark (see Figure 3.87 on page 165).
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Figure 3.87: Go To Bookmark Dialog Box

Highlight the bookmark to which to go, then click the Go To button, or 
double‐click the selection.

Figure 3.88: Bookmark Found Example in Data Viewer Display

Bookmark Description

To get a quick description of a displayed bookmark, position the tool tip over a bookmark. 
The name and description of the bookmark display.

Set Time Stamp Origin

Right‐click in the sample viewer to open the fly out menu (see Figure 3.88 on page 165):
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Figure 3.89: Bookmark Found Example in Data Viewer Display

Highlight Set Time Stamp Origin and choose either Absolute, Trigger, Current Position, or 
Based on system time.

3.7.2 Filtering

The Filtering menu and options allow you to modify data in the sample viewer display to 
exclude packets with a set of user‐defined patterns and show the results in all views.

To set up filtering, you must have a viewer display open.

The Filtering menu has the options:

 Enable Filtering (see Enable Filter on page 178)
 Filtering (see Filter Setup on page 167)
 Link Layer (SAS)
 Transport Layer (SAS)
 Application Layer (SAS)
 Physical Layer (SATA)
 FIS Layer (SATA)
 Command Layer (SATA)
 Filter Idles (see Filter Idle on page 179)
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3.7.3 Filter Setup

To display the Filter setup dialog, click the   Filter button on the Viewer tool bar or 
select View > Filtering.

Figure 3.90: SAS/SATA: Filter Setup Dialog

You can select or deselect each of the items shown in the Filter Options window for 
filtering, by checking or unchecking a corresponding check box. Items not in the current 
sample are in shade. See Selectable Filter Options for SAS on page 171 and Selectable 
Filter Options for SATA on page 177.

Note: If you select a group, that also selects all child items. 

Note:Only packets captured at run time are available for selection for filtering.

Filter Type

You can choose to show or hide the Filter Type items by checking the Show or Hide 
option button.
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Note:When capturing PM traces, you need the ability to filter the PM primitives so you can find 
commands quicker. 

Filtering Direction

You can select items for filtering in a single direction or both directions by checking the 
corresponding Port. By default, all ports are enabled. Uncheck the port check boxes for 
ports not to include in the filter.

Filter Idle

Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are shown 
or hidden.

Save Filter Setup

After you have set up a Filter configuration, you can save it as an SAS Filter file (*sfl) or 
SATA Filter file (*.tfl) by clicking Save. You can then use it on a different capture by 
clicking Load in the Filter dialog.

Filter Logic

After you have set up Filter options, you can set filter logic to And Related Items to apply 
“AND” logic on related selected options (for example, SCSI commands and SAS Addresses) 
or OR to apply “OR” logic on all selected options.

After you have set up Filter options, you can set filter logic to And Related Items to apply 
"AND" logic on related selected options (for example, SCSI commands and SAS 
Addresses) or OR to apply "OR" logic on all selected options.

Filter only applies to entities in a trace. When you choose SCSI command AND SSP frame, 
for instance, Filter affects all entities in the trace that are SCSI commands, AND are SSP 
frames. Any SCSI commands that are NOT SSP frames, will not, in this case, be filtered. 

If you choose OR, Filter affects all entities that are SCSI commands, as well as all SSP 
frames.

The AND operator is only applicable for certain cases, such as:

 A SCSI command AND a Tag.
 A SCSI command AND a source/destination address.

For example, when you choose a SCSI command AND a tag = 0x1, you will filter all entities 
on a trace that are SCSI commands that have tags equal to "0x1" in that SCSI command.

As a general rule, it is not possible to apply AND to two packet types (frames, commands, 
primitives, training sequences or bus conditions). It only works when you apply AND to 
one packet type with other items such as source/Destination Addresses, TAG, Task 
attribute.

Multilevel Filtering

You can set up a filter in a sequential steps by Multi level filtering. In each level, you can 
select specific items to “AND” to the previous level. The results of all levels show in views 
(see the following three figures).
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Figure 3.91: First Level of Multilevel Filtering

Figure 3.92: Second Level of Multilevel Filtering
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Figure 3.93: Third Level of Multilevel Filtering

Filter descending packets from trace highlight bar

If you check the Filter descending packets from trace highlight bar checkbox, the 
application will only filter onward from the highlighted trace selection bar.

If you uncheck this option, the software only filters the filtered packet. For example, if 
this option is checked and any SCSI command is selected, all transport and link packets of 
this command are filtered. If you unchecked this option, only selected SCSI commands 
are filtered.

3.7.4 Selectable Filter Options for SAS

The SAS Filter Options are:

 Command Data Pattern
 Bus Condition
 Primitive
 Incomplete Frames
 Address Frames
 SSP Frames
 SMP Frames
 STP Frames
 SCSI Commands
 SMP Commands
 Task Management Functions
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 ATA Commands
 SCSI Command Status (see Filter Check Condition on page 173)
 Source SAS Address
 Destination SAS Address
 Pair SAS Address
 Protocol Error
 STP Port
 Tag (see Filter by Tag Number on page 174)
 ATAPI SCSI Command
 Device Sleep
 Miscellaneous (see Filter Miscellaneous on page 174)
 Training Sequence

Command Data Pattern
When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Command Data Patterns in the Trace Viewer.

Bus Condition

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Trace Viewer.

Incomplete Frames

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Trace Viewer. 

ATA Command

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Trace Viewer.

Protocol Error

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Trace Viewer.

ATAPI SCSI Command

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands (see Figure 3.94 on page 173).
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Filter Check Condition

Checking the SCSI Command Status check box enables Check Condition for filtering.

Figure 3.94: SAS: Filter Check Condition
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Filter by Tag Number

Checking the Tag check box displays tags available for filtering. Check the corresponding 
check boxes for tags to filter.

Figure 3.95: SAS: Filter by Tag Number

Filter Miscellaneous

When you choose Miscellaneous, an additional dialog displays, allowing you to specify 
the filtering of State Range and/or External Signal In (see Figure 3.96 on page 175).
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Figure 3.96: Filter State and/or Device Sleep

Filter TTIU Events

When you choose Training Sequence, an additional dialog displays, allowing you to filter 
Training Sequence TTIU fields in a Training Sequence trace (see Figure 3.97 on page 176). 
Select Training Sequence > Control Status and click Advanced to display the Control 
Status dialog (see Figure 3.98 on page 176). Select the Fields and the Values for them 
from the drop‐down list.
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Figure 3.97: Filter Training Sequence TTIU Fields

Figure 3.98: Select Field and Values to Filter
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Use Pair SAS Addresses 

You can use all available pair SAS addresses (Source ‐> Destination) instead of using SAS 
source and destination addresses. To enable the pair SAS address filter option, check Use 
Pair SAS Addresses check box in the Filter dialog (see Figure 3.99 on page 177).

Figure 3.99: SAS: SAS Address Filtering before and after Using Pair SAS Addresses

Note: If you enable pair SAS addresses, the source/destination SAS addresses options are disabled and 
filtering on them is ignored at filtering time. If you disable pair SAS addresses, the pair SAS 
address option is disabled and filtering on it is ignored at filtering time.

Training Sequence

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Training Sequences in the Trace Viewer.

3.7.5 Selectable Filter Options for SATA

The SATA filter options are:

 Bus Condition
 Incomplete Frames
 FIS
 ATA Command
 Protocol Error
 Port
 ATAPI SCSI Command
 Device Sleep
 Miscellaneous
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Bus Condition

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured Bus Conditions in the Trace Viewer.

Incomplete Frames

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
Incomplete Frames in the Trace Viewer. 

FIS

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured FIS items in the Trace Viewer. 

ATA Command

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured ATA commands in the Trace Viewer.

Protocol Error

When selected, depending on the Filter Type, the Hide/Show selection shows or hides 
captured packets with the specified Protocol Errors in the Trace Viewer.

Port

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
packet traffic for the selected port.

ATAPI SCSI Command

When selected, depending on the Filter Type, the Show/Hide selection shows or hides 
ATAPI SCSI commands.

Miscellaneous

When you choose Miscellaneous, an additional dialog displays, allowing you to specify 
the filtering of State Range and/or External Signal In (see Filter Miscellaneous on 
page 174).

3.7.6 Enable Filter

Select Filtering > Enable Filtering or click the   Filter Enable button on the display 
menu bar to toggle between Filtered and Unfiltered display.
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3.7.7 Filter Idle

Depending on the Filter Type (Hide/Show), Idle packets in the Sample Viewer are shown 
or hidden.

You can quickly filter idles by clicking the   Filter Idle button. This button toggles 
between Show and Hide items.

3.7.8 Search

The Search menu and toolbar options permit you to examine any data capture file to 
quickly locate the packet or data pattern. 

To perform an initial search, select Navigation > Search or click the   Search button 

to open the Search setup dialog (see Figure 3.100 on page 180).

Note:Only items captured in the sample file are enabled for search.
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Figure 3.100: SAS/SATA: Search Data Pattern

Figure 3.101: Search Parameter Definition Dialog

You can continue to search the output file using Next Search (F3) or Previous Search (F4) 
for the same pattern, until you redefine the data capture search parameters.

Save Search Setup

After you have set up a Search configuration, you can save it as a SAS Search configuration 
file (*.ssh) or a SATA Search configuration file (*.tsh) by clicking Save. You can then use it 
on a different capture by clicking Load in the Search dialog.

Search By

Choose Hashed SAS Address to search on hash address, or choose SAS Address to search 
for address. 

Search Direction

Choose either Forward or Backward direction in which to perform the search.
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Search From

Choose a starting point to begin or continue a search: Start of the sample file, 
Trigger Pointer, X Pointer, Y Pointer, or Last Found.

Search Logic

The default setting is Or Selected Items. With this setting, clicking Find Next locates all 
selected items in turn. If you choose And Selected Items, you can set a logical AND 
combination of items to find. Both options allow setting Advanced search features.

Search looks for entities in a trace. When you choose SCSI command AND SSP frame, for 
instance, search will return all entities in the trace that are SCSI commands, AND are SSP 
frames. Any SCSI commands that are NOT SSP frames, will not, in this case, be returned.

If you choose OR, search will return all entities that are SCSI commands as well as all SSP 
frames.

The AND operator is only applicable for certain cases, such as:

 A SCSI command AND a Tag.
 A SCSI command AND a source/destination address.

For example, when you choose a SCSI command AND a tag = 0x1, you will get all entities 
on a trace that are SCSI commands that have tags equal to "0x1" in that SCSI command.

As a general rule, it is not possible to apply AND on two packet types (frames, commands, 
primitives, training sequences or bus conditions). It only works when you apply AND on 
one packet type with other items such as source/Destination Addresses, TAG, Task 
attribute.

Search For

Choose a category to search in the Search For window. Each of the search categories 
offers additional choices in the Search Items window to refine the search. Check items 
for the selected category.

Data Pattern

Search for Data Pattern allows you to search for a specific Data Type, Pattern, and Length 
(see Figure 3.100 on page 180).

 Data Pattern Only
 Data Payload Length Only
 Data Pattern and Data Payload Length
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Advanced options

Some of the Search For categories offer advanced options for search. To set these options, 
highlight the search item in a category and click the Advanced button to open the 
Advanced options dialog.

Figure 3.102: Advanced Options Dialog Example: Set Device Bits

Set the options and click OK.

Search Domain

Click the Domain button and choose a search domain from all ports or a specific port.

Protocol Error

You can refine the search to locate packets with an error or without an error.

Note:When searching for Protocol Errors in Column View, you cannot search for a specific Protocol 
Error type. Search returns any protocol error.

Search Sub Items

When searching SCSI Command Status, you can refine the search by selecting from a list 
of Sub Items.

Note:Some of the search categories allow you to refine the search by specifying specific SAS addresses 
and STP ports to search.
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Figure 3.103: Search Sub Items

When you check the SCSI Command Status, the Check Condition item appears in the 
Search Items Window, if a check condition has occurred. Clicking this enables Search Sub 
Items, allowing you to refine the search by specifying Sense Key, ASC, and ASCQ.
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Search by Tag Number 

To search by Tag Number, check the Tags box in the Search For window and then check 
the Tag(s) for which to search in the Search Items dialog (see Figure 3.104 on page 184).

Figure 3.104: Search by Tag Number

Search TTIU Events

See Filter TTIU Events on page 175 for details.
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Search by Speed

To search by Speed, check the Speed box in the Search For window to look for points 
where speed changes occurred in the trace.

Figure 3.105: Search by Speed Changes
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3.7.9 Show/Hide Ports

You can Show/Hide a Single Port or you can Show/Hide Multiple Ports. To do so click on 
the Ch Down Arrow.

Show/Hide Single Port

If Show/Hide Single Port is selected, you can click on one port button at a time to show/
hide the capture for that port. Show/Hide Single Port is time consuming as it shows or 
hides one port at a time.

Show/Hide Multiple Ports

If Show/Hide Multiple Ports is selected, you can click on multiple ports to show or hide 
them. This mode is much faster. Click on multiple ports to show or hide them.

Figure 3.106: SAS: Show/Hide Ports Toolbar

.

Figure 3.107: SATA: Show/Hide Ports Toolbar 

You can also show or hide a port by right‐clicking a Port ID in Text View or Column View 
and choosing Show or Hide (see Figure 3.111 on page 190).

3.8 Packet View Toolbar

The Packet View toolbar allows wrapping, zooming, and configuration.

 

The Wrap Packets button on the Viewer Toolbar wraps the packet data in the 
display to eliminate the need for horizontal scrolling.

Go to CATC Navigation View. Click this button to change the trace display to a 
CATC Trace™. 
You can change the colors, fonts, and so on, in the Trace Viewer Configuration 
(see Trace Viewer Configuration on page 198).

The Show/Hide Link Packet button displays/hides the Link layer (SAS only). 
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The Show/Hide Transport Packet button on the Layers Toolbar displays/hides 
the Transport layer and below (SAS only). 

The Show/Hide All Commands Packet button shows/hides the 
Command layer and all layers below: SCSI Cmd and Task Mng, SMP 
Cmd, and ATA Cmd (SAS only). 

Click the down arrow on the Show/Hide All Commands Packet 
button to choose command types to show/hide.

The Show/Hide Physical Packet button toggles the display of physical layer 
packets (SATA only). 

The Show/Hide FIS packet button toggles the display of FIS layer packets. 
When “OFF”, the FIS layer and its links are hidden (SATA only). 

The Show/Hide CMD packet button toggles the display of the CMD packets. 
When “ON”, only the command layer displays (SATA only). 

The Show/Hide Command Queue button displays queued commands. (SATA 
only.)

The CQ button’s hierarchy only applies to ReadDMAQueued and 
WriteDMAQueued. The hierarchy for other queued commands is displayed 
as part of the regular application layer decoding.

The Order/Reorder button toggles the time order of packets. (SATA only)

The Pack/Unpack Repeated Primitives toggles packing repeated primitives in 
one port. (SAS only)

The 10B button displays the payload data as 10‐bit encoded data.

The 8B button displays the payload as 8‐bit scrambled or unscrambled data, 
depending on the Scrambled setting.

The SC button selects scramble/unscramble for the 8‐bit payload data.

The PV button shows/hides the primitive value.
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3.8.1 CATC Navigation View

To change the trace display to a CATC Trace™ (see Figure 3.108 on page 188), click the 

CATC Navigation   button. You can change the colors, fonts, and so on, in the Trace 
Viewer Configuration (see Trace Viewer Configuration on page 198).

Figure 3.108: CATC Navigation View

3.8.2 Spec View

Spec View shows packet header information. 

To obtain the Spec View from the CATC View, left‐click to display a popup menu, then 
select the View Fields option (see Figure 3.109 on page 189).

To obtain the Spec View from the Catalyst View, right‐click to display a popup menu, then 
select the View Fields option.
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Figure 3.109: Spec View

The tabs allows you to display Hexadecimal or Binary. 

The buttons allow you to go to Previous or Next.

You can Save As a text file.

3.8.3 Decode Icons

The Decode Toolbar controls encoding and scrambling features.

To view corresponding Unscrambled and Scrambled payload data values instantaneously, 
position the mouse pointer over a data field.

Figure 3.110: Payload Data Display

Running Disparity indication
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3.8.4 Customize Display

You can customize the display as explained below.

Rename Port

You can rename each port for easy identification. To rename a port, right‐click the port ID 
in Text View or Column View.

Figure 3.111: Rename Port

Choose Rename title of port to open the Rename Title of Port dialog.

Figure 3.112: Rename Title of Port

Show/Hide Single Port

If Show/Hide Single Port is selected, you can click on one port button at a time to show/
hide the capture for that port. Show/Hide Single Port is time consuming as it shows or 
hides one port at a time.

Show/Hide Multiple Ports

If Show/Hide Multiple Ports is selected, you can click on multiple ports to show or hide 
them. This mode is much faster. Click on multiple ports to show or hide them.

Figure 3.113: SAS: Show/Hide Ports Toolbar
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Figure 3.114: SATA: Show/Hide Ports Toolbar

You can also show or hide a port by right‐clicking a Port ID in Text View or Column View 
and choosing Show or Hide (see Figure 3.111).

Show/Hide Field

You can simplify the Viewer display by hiding some fields. You can hide the Duration, 
Relative Time, External Signals, and Packet number fields by right‐clicking the 
corresponding field title and choosing Hide Field.

Figure 3.115: Hide Field

To restore a field to the display, right‐click a Port ID field and choose the hidden field to 
restore

Figure 3.116: Show Field

Note:Only the fields previously hidden appear in the restore list.

Related Frames

Right‐click a Command frame for an SSP frame, or Register Device to Host for an STP 
frame, to open a short‐cut menu (see Figure 3.117 on page 192), then choose Goto 
Response to jump to the corresponding Response frame in the viewer.
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Figure 3.117: Goto Response

Similarly, right‐click a Response frame for an SSP Frame, or Register Device to Host for an 
STP frame, to open a short‐cut menu, then choose Goto Command to jump to the 
corresponding Command frame in the viewer.

Figure 3.118: Goto Command

In Column View, you can right‐click a DWORD inside a frame to display the 
Goto Within Packet command. You can jump to an SOF, EOF, HOLD, or R_IP.

Figure 3.119: Goto Within Packet Command
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Byte Order

You can change the byte order in fields marked by an arrow and other fields. 

Right‐click in the field, select Byte Order, and choose the ordering.

Figure 3.120: Byte Order

Note:A blue arrow in the byte order field indicates that it has been changed.

Choose Data Format

You can display data values either in hexadecimal (default) or binary. To choose data 
format, right‐click the mouse over a data field, and choose Format and the format.

Figure 3.121: Format

Show All Data

To display all captured data, click the data expand toggle arrow in a data field, to examine 
the data in detail.

Figure 3.122: Show All Data

Data expand toggle
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You can expand or collapse all data fields globally. To expand all data fields, 
right‐click the mouse in a data field and choose Expand All.

Figure 3.123: Expand All

To collapse all fields, right‐click the mouse in a data field and choose Collapse All.

You can expand or collapse all FIS’s and commands. To expand, right‐click the mouse in a 
data field and choose Expand All FIS’s or Expand All ATA Cmd.s. See Figure 3.124.

Figure 3.124: Expand All FIS’s

To collapse, right‐click the mouse in a data field and choose Collapse All FIS’s or Collapse 
All ATA Cmd.s.
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You can expand or collapse specific packets and commands by clicking on the   or   
buttons. 

Figure 3.125: Expand/Collapse Specific Layers.

3.9 Port Status

You can get an overview of the active ports by clicking the Port Status button at the 
bottom right of the application window.

The Port Status displays the Port, Speed, and Analyzer.

In addition to displaying OOB, Link, Frame, and Error, a display showing the % buffer full 
opens when a trigger occurs.

Figure 3.126: Port Status Window and Capturing Time

1.Pre‐trig capturing (trig is 50%)
2. Trig point (shown by red bar; 36% pre trig was captured)
3. Post‐trig capturing (50% post‐trig was captured and capturing has stopped)

Note: If sample capture occurs with more than one unit active, additional Port Status windows display.
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The OOB, Link, Frame and Error LEDs in the Port Status dialog mimic/follow the LEDs on 
the Front panel of the unit. 

When the LEDs are dim, it indicates they were lit in the past. Pressing the Reset button 
erases this history and the illuminated LEDs are removed from the dialog.

3.10 Toolbars

3.10.1 Enabling Tool Bars

To customize the Viewer Display workspace, you can enable and reposition the available 
toolbars. To display or hide toolbars, select View > Toolbar, then check or uncheck 
toolbars.

LEDs illuminatedReset button
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Toolbars are:

 Main
 Record + Capture
 Analysis
 Navigation + View
 Packet View
 Column View
 Cursor Position

Once enabled, the toolbars can dock at the Viewer Display window or float on the 
windows desktop.

3.10.2 Cursor Position Status Bar

To display the cursor position status bar, select View > Status Bar.

Figure 3.127: Cursor Position Toolbar

See Using the Cursors and Bookmarks on page 197.

3.11 Status Bar

The Status bar is located at the bottom of the main display window.

3.11.1 Search Status

The right most segment displays the current search direction: Fwd (forward) or 
Bwd (backward). Change the search direction from the Search Menu or double‐click the 
Search Status segment. 

3.12 Using the Cursors and Bookmarks

3.12.1 Cursors

The data viewer display incorporates three cursors labeled X, Y, and T. All cursors are 
initially overlaid and positioned at location 0, which is the trigger position of the display. 
The Trigger, or T, cursor is the measurement reference and is always at location 0 in the 
display.

Positioning the X Cursor

To position the X‐Cursor within the viewer data display, click the left mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 

Positioning the Y Cursor

To position the Y‐cursor within the viewer data display, click the right mouse button in the 
gray bar on the left side of the sample viewer next to the line in which to place the cursor. 
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Note:You can also left‐click to set the X‐cursor and right‐click to set the Y cursor in the Frame and 
Column View by clicking in the narrow strip on the very left side of a cell. Similarly, you can set 
the cursors in the Waveform View by left and right clicking at the beginning of a waveform.

Time

Time differences between the cursors are displayed in the Cursor Position toolbar. To 
display the cursor position tool bar, select Toolbar from the view menu and choose Cursor 
Position.

Figure 3.128: Cursor Position Toolbar

3.13 Display Configuration

The Analyzer ships with a default display configuration of field and viewer settings. You 
can define your own field and viewer settings for a particular testing scenario. Right‐click 
in the Packet View and select Preferences or select Setup>Preferences>Trace 
Viewer>Configuration. The Trace Viewer Configuration dialog displays (see Figure 3.129 
on page 199).

3.13.1 Trace Viewer Configuration

The Trace Viewer Configuration dialog allows you to change the following display settings:

 Field Setting
 Format (Decimal, Hexadecimal, Binary)
 Visible
 Byte Order (Right Align, Left Align)

 Field Header Setting
 Text (color)
 Name
 Abbreviation
 Foreground (color)

 Viewer Setting
 Wrap Packet
 Enable Tooltips

 Data Payload
 Columns in Row (1, 2, 4, 8, 16)
 Bytes in Column (1, 2, 4, 8, 16)

 Time Stamp Origin: Absolute, Trigger, User Defined, Based on System Time
 Same color for start time and port
 Enable Packet View Condense Mode
 Time Stamp Format (LeCroy, Milli, Micro)
 Save Trace Viewer Configuration in a file
 Load Trace Viewer Configuration from a file
 Factory Setting (restores default settings)
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 Font (opens Font dialog)

Figure 3.129: Trace Viewer Configuration
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Field Settings

To view a packet field, select a field from the packet field tree and check the Visible box. 
Uncheck it to hide the field. To change the data format of a packet field, select the field 
and choose a data format from the Format drop‐down list.

Figure 3.130: ATA Command Fields
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Field Header Setting

You can use the Name or Abbreviation.

To change the color of the text in a packet field header, select a field from the packet field 
tree and click the Foreground button.

Figure 3.131: Color

Choose an appropriate color and click OK.

Viewer Setting

Check the Wrap Packet box to enable the wrapping of packets in the display.

Check the Enable Tooltip box to enable tool tips for packet fields.

Data Payload

You can format the Data Payload display.

For Columns in Row, select 1, 2, 4, 8, or 16.

For Bytes in Column, select 1, 2, 4, 8, or 16.

Time Stamp Origin

Select Absolute, User Defined, Trigger, or Based on System Time.

Start Time and Port

You can use the same color for the start time and port.

Packet View Condense Mode

You can enable Packet View Condense Mode to minimize Packet View rows.

Time Stamp Format

Select Teledyne LeCroy, Milliseconds, or Microseconds.
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Font

To change display fonts, click the Font button to open the Font dialog box.

Figure 3.132: Font

Choose the font, font style, and size, and click OK.

Save/Load Settings

You can save the customized configuration settings in a *.cfg file by clicking the Save 
button and completing the Save As procedure. To load a previously saved configuration 
file, click Load and choose an appropriate file.

3.14 Set Port Alias

Port Alias allows you to assign a meaningful name to each port to assist in interpreting the 
results displayed in the sample view (see Figure 3.133 on page 203).

To assign port names in an open sample view, select Setup > Set Port Alias.
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Figure 3.133: Assign Port Alias

Assign a meaningful name to each port in use and click OK. The assigned names replace 
the port numbers in the sample view.

If you elect to save the capture sample file, the assigned port names are saved together 
with the result, so that when you open the sample file later, the assigned names are 
retained.

Restore Factory Presets

Click the Restore Factory Presets button to restore the settings to the factory settings.

Set As Default

If you want to set these port aliases for sample files that will be captured later, you can 
set them as default, and new samples will be opened by these default port aliases.

3.15 SAS Address Alias (SAS only)

SAS Address Alias allows you to assign a meaningful name to each SAS address to assist in 
interpreting the results displayed in the sample view. To assign SAS address names in an 
open sample view, select Setup > Set SAS Address Alias to display the SAS Address Alias 
dialog (see Figure 3.134 on page 204).
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Figure 3.134: SAS: Assign SAS Address Alias

Assign a meaningful name to each SAS address in use and click OK. The assigned names 
replace the SAS address in the sample view, Search, filter, and Statistical report.

Figure 3.135: SAS: SAS Address Alias

If you elect to save the captured sample file, the assigned SAS address names are saved 
together with the result, so that when you open the sample file later, the assigned names 
are retained.

Set As Default

If you want to set these SAS address aliases for sample files that will be captured later, you 
can set them as default, and new samples will be opened by these default SAS address 
aliases. 

3.16 TxRxVout & Preemphasis

The analyzer incorporates the ability to select TxRx Vout for the transmitter and receiver 
on each port. Using TxRx Vout can increase the output voltage swing above the nominal 
value, for test and characterization purposes. This feature is also useful to compensate for 
line loss when driving long cables. 
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To select TX Vout, select Setup > TxRx Vout & Preemphasis to display the 
Rx/Tx Settings dialog:

Figure 3.136: Choose Port for TxRx Vout

Port displays ports to select from. 

Copy Selected Port Settings to All Ports implements selected port's setting into all other 
port settings.

PMA Analog Control Settings allows you to select values for RX equalization DC and RX 
equalization (Write Only)

Advanced displays the Advanced Probe Setting dialog (see Advanced Probe Setting on 
page 206).

References displays the References Probe Setting dialog (see References Probe Setting on 
page 206).

Overwrite Tx Settings check this box to overwrite the Tx settings.

Disable Rx Training check this box to use the manually entered settings.

Port Status displays number of errors per second.

Apply applies the selected settings.

Start Reading Port Status implements reading of number of errors displayed in Port 
Status. 

Restore Factory Settings restores default values.

Save saves the new values as a *.sng file.

Load loads back the saved *.sng file.

Auto Calibration displays the Auto Probe Calibration dialog (see Auto Probe Calibration 
on page 209).
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3.16.1 Advanced Probe Setting

The Advanced Probe Setting dialog allows you to set the TX Signals and DFE_Control 
(Decision Feedback Equalization) parameters.

You can set the TX Signals values for:

 VOD (Programmable Differential Voltage)
 Pre‐emphasis Pre‐tab
 Pre‐emphasis first
 Pre‐emphasis second

You can set the DFE_Control values for:

 DFE_Tap1
 DFE_Tap2
 DFE_Tap3
 DFE_Tap4
 DFE_Tap5
 reference voltage

Figure 3.137: Advanced Probe Setting Dialog

3.16.2 References Probe Setting

The References Probe Setting dialog (see Figure 3.138 on page 207) allows you to set the 
three reference points defined by the SAS 3.0 specification (Reference 1, Reference 2 and 
NoEq), in cases when the default reference points do not result in a clean link. 

These settings only need to be applied once for each analyzer as they are saved by the 
SAS/SATA Protocol Suite application on the host machine. Connecting to a different host 
machine requires reapplying the settings.
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Figure 3.138: References Probe Setting Dialog

3.16.3 Manual Calibration of Tx Path from Jammer or Trainer

To manually calibrate perform the following steps:

1. Select Setup > TxRx Vout & Preemphasis to display the 
Rx/Tx Settings dialog (see Figure 3.139 on page 208).

2. Press the Read button to read the current values for all ports (values achieved 
through automatic Training when the link has come up), then press the Advanced 
button to see and tweak the values.

3. The typical set of values for the Initiator are shown in Figure 3.140 on page 208. If 
you see these values then no changes are required.
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Figure 3.139: Rx/Tx Settings Dialog

Figure 3.140: Advanced Probe Setting Dialog

4. To see the Target values, click Cancel on the Advanced Probe Setting dialog. 

5. Select T1 on the Rx/Tx Setting dialog (see Figure 3.141 on page 208), and then click 
the Advanced button (no need to re‐read the values). 

6. Manipulate the "Pre‐emphasis first" and "Pre‐emphasis pre‐tap" fields by making 
small changes to the values achieved by Training (see Figure 3.140). This is an 
iterative process to eliminate errors. After each value change, press OK to make the 
change in the software copy of the value, and then press Apply in the Rx/Tx Settings 
(see Figure 3.141 on page 208) dialog to write the new value to the Serdes.

Figure 3.141: Rx/Tx Settings Dialog

Overwrite Tx Settings: Check this box (see Figure 3.141) to retain the optimal values 
reached through manual calibration every time the link goes through Training due to port 
reset, power cycle or disconnection.
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3.16.4 Auto Probe Calibration

The Auto Probe Calibration dialog will attempt to optimize the receiver settings. The 
accuracy is controlled by the time interval spent on each setting. Note that this action 
might take a very long time depending on the values entered.

Figure 3.142: Auto Probe Calibration Dialog
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3.17 Preferences

Preferences allows you to define template files for new Analyzer projects, to specify how 
sample files appear when opened, and to set ATAPI and SCSI Spec Assignments. Click 
Setup on the toolbar and choose Preferences to display the General tab (see 
Figure 3.143).

3.17.1 General Tab

Figure 3.143: Preferences Dialog General Tab.

Paths

User Path specifies the “User” folder path, used by the software after launching the Open 
dialog. 

Template Files

Protocol Analyzer: You can use a pre‐saved analyzer and/or analyzer project file as a 
template. Whenever you make a new project file, the software uses the template to 
initialize the project file. 

New Protocol Analyzer Project in Advanced Mode: When you use the New menu item to 
create a new project file, the software switches to Advanced mode automatically.
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Other

Default Workspace specifies the default workspace file for opening a sample file. You can 
save any viewer configuration as a workspace and then specify it as the default 
workspace. The software always open a trace file based on the default workspace file.

NCQ Commands Time out Threshold: The software uses this setting in the statistical ATA 
command page for NCQ commands. If the time out exceeds this setting, the software 
reports an error.

Maximum Number of Uploader Threads: If Quick View is not enabled, during cascading, 
specifies the number of concurrent processes for uploading a sample file.

ATAPI spec assignment: Specifies the ATAPI default spec.

SCSI spec assignment (SAS only): Specifies the SCSI default spec.

Convert port configuration without prompt for confirm: If the current attached board 
does not support the project file port configuration, the software converts it to a 
supported port configuration without asking for confirmation. If this setting is unchecked, 
the software asks for confirmation 

Ask user to close the previous captured sample before running the new project: When 
you start to run a new project, the software prompts you to close the current sample.

Found Device List Mode

Reset (clear) the list of found devices: Lists only the currently found devices.

Refresh (append to) the list of found devices: Adds new devices to the list of devices 
found previously.

Browse Default Path

Software default: After you select File > Open, the Open dialog shows the default user 
folder.

Windows default: After you select File > Open, the Open dialog shows the path selected 
when the Open dialog was last used.

Port Configuration Setting

These options pertain to Port Configurations that have unused ports (as marked by a dash 
in the Port Configuration table, eg AA‐‐). This allows the user to control these ports, if 
unused by the analyzer platform, are to be disconnected or are to be used as pass 
through, meaning the traffic will simply pass through them (default setting). It is 
sometimes useful to force disconnect on unused ports, to cause all traffic to pass through 
the used ports. Select the desired option:

Disconnect unused ports

Pass through unused ports
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3.17.2 Trace Viewer Tab

Figure 3.144: Preferences Dialog Trace Viewer Tab

Open Trace file In

Default Workspace: The software opens a trace file in view(s) based on the specified 
default workspace.

As previously saved: The software opens a trace file in view (views) based on the last 
saved configuration for the trace file. 

Optimization

Sampling memory usage optimization: Enables memory cascading for two ports. The 
analyzer will use memory of another port if there is not data on another port. (see 
Sampling Memory Usage Optimization on page 217)

Quick View: Quick View allows full access to the whole trace more quickly, especially 
when using a Gigabit Ethernet connection. However, the trace is NOT written to the host 
machine’s hard drive. To save the trace, you must manually click Save.
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If you do not check Quick View, the trace loads more slowly but is automatically saved to 
the host machine’s hard drive.

Other

Switch to CATC Navigation: Packet view will open in CATC mode. 

Reverse Link Data: The software shows DWORDs of link data as reversed.

Pack Repeated Primitives: The software packs repeated primitives just after opening a 
sample file. 

Pack Repeated Primitives: The software packs repeated primitives just after opening a 
sample file. 

Scroll Horizontally to Show matched Column in Search: When unchecked makes 
columns stationary even during search.

Use new PHY capabilities decoding: Decodes PHY capability bits in reverse order per the 
latest specification.

Cancel button kills upload immediately: The software kills the uploading process if you 
press Cancel. 

Close previous sample file when new sample file opens: When you want to open a new 
sample file, the software closes any open sample files.

Create statistical report read/write page: The software creates a Read/Write page in the 
statistical report. Enabling this setting displays the Read/Write Stream DMA command in 
the Read/Write page.

Show Quick View Warning: The Quick View Warning pops up when attempting to close a 
trace that has not yet been saved, and is only shown in Quick View "mode". This 
checkbox allows to turn off this popup.

LBA mode: Checking this box enables LBA mode for ATA decoding.

CHS mode: Checking this box enables CHS mode for ATA decoding.

According to LBA mode in ATA command: Checking this box enables decoding according 
to LBA mode in ATA command for ATA decoding.

Configuration: Clicking Configuration displays the Trace Viewer Configuration dialog (see 
Figure 3.145 on page 214).
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Figure 3.145: Preferences Dialog Trace Viewer Configuration Tab

Select a view in the left pane and set the trace viewer display options in the right pane.
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3.17.3 Spread Sheet View Tab

Figure 3.146: Preferences Dialog Spread Sheet View Tab

Color Setting

Based on Cell Type: Each column has its own color. 

Based on Port No.: Data of each row are shown based on the specified color for its port. 
You can set the color of ports in the Viewer settings. 

Based on Read/Write Command Type: You can specify a color for Read commands, 
another color for Write commands, and other color for other commands. The software 
shows each row based on the command type: Read, Write, or others.

Based on Specific Command Type: You can specify a color for each command. The 
software applies the setting on the Command column.
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Anchor the Selection Bar

You can anchor the selection bar of the Spreadsheet View.

Set the Anchor row as sync. point: Other views synchronize based on the contents of the 
anchor row.Other

Repeat decoded command in frame column: The spreadsheet shows the name of the 
command in front of all frames in the Command column. Otherwise, it will show the 
name of the command only in front of the SSP command frame.

Decode CDB of Commands: The spreadsheet shows name of command in command 
column, otherwise shows CDB of command in command column.

Show ‘Sector Count’ instead of ‘Xfer Length’ (SATA only): Display sector count.

3.17.4 Column View Tab

Figure 3.147: Preferences Dialog Column View Tab

Show Warning in Search Primitive In Column View: If searching in Column View takes a 
long time, the software asks if you want to continue search. Otherwise, the software 
continues searching with no pause.
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3.17.5 Packet View Tab

Figure 3.148: Preferences Dialog Packet View Tab

Based on Command Layer: You can specify a color for the Command Layer. The software 
shows each row based on the command layer.

Based on Specific Command Type: You can specify a color for each command. The 
software applies the setting on the Command column.

3.17.6 Sampling Memory Usage Optimization

The Preferences dialog has a Sampling Memory Usage Optimization option in the Trace 
Viewer tab. This Memory Assignment (MA) feature optimizes sampling memory 
utilization.

If the Sampling Memory Usage Optimization Option is Checked

The system tries to use empty space in all memory banks to prevent any memory bank 
from filling completely. Each physical link is not necessarily assigned to a specific memory 
bank. The system can capture more sample data than if the MA option is unchecked, and 
sample file size is closer to the user‐defined Sampling Memory Size.

Memory Assignment efficiency varies with Port Configuration and Trigger Position:

 FPGA: The Memory Assignment feature works for a pair of ports connected to 
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one FPGA, for example ports 1 and 2 (or ports 3 and 4). Memory Assignment 
does not work for two ports connected to different FPGAs, for example ports 1 
and 3.

 Triggering: Memory Assignment only starts after the trigger point. During 
pre‐trigger, each physical link is always assigned to a specific memory bank.
Post‐trigger, the system can try to use empty space in all memory banks, if you 
check the MA option. Therefore, Memory Assignment efficiency is maximum 
when Trigger Position is set to 0% (snap‐shot trigger) and is minimum when Trig‐
ger Position is set to 99% or when there is no triggering (you stop recording man‐
ually).

 MUX: When MUX is enabled, each segment has four memory banks, limiting 
Memory Assignment somewhat.

Here are examples of different Port Configurations and Trigger Positions:

 One port configuration (A ‐ ‐ ‐): Sample size is user‐specified sample size.
 Two port configuration (AA ‐ ‐): Ports 1 and 2 are on the same FPGA, so 

Memory Assignment has an effect. If you use snapshot triggering, the sam‐
ple size is near specified size.

 Two port configuration (AA ‐ ‐): If you use manual stop, Memory Assignment 
has no effect. Sample size depends on port traffic loads.

 Two port configuration (AA ‐ ‐): If trigger is set at 50%, and there is enough 
data to fill pre‐trigger, Memory Assignment has an effect. Sample size is typi‐
cally near specified size.

 Two port configuration (AA ‐ ‐): If trigger is set at 50%, but there is not 
enough data to fill pre‐trigger, Memory Assignment has an effect. Sample 
size is typically more than half specified size, with size determined by the 
amount of data captured before trigger.

Note:Checking this option does not affect the sample. It only allows larger sample sizes.

Note: If traffic is balanced on ports, sample size is the same whether you check or uncheck the 
Sampling Memory Usage Optimization option.

Note:Memory Assignment depends on traffic load distribution at the time when the system tries to 
re‐assign physical links to memory banks. Therefore, if you repeat a capture with the same 
Sampling Memory Size and Segment Number parameters, the resulting sample size may not be 
the same. However, if traffic load distribution is similar, sample size will be similar. 

Note:The buffer status indicator shows buffer by FPGA, not by port.

If the Sampling Memory Usage Optimization Option is Not Checked

Each physical link (or logical link if MUX is enabled) is assigned to a specific memory space 
(memory bank), depending on the Sampling Memory Size and Segment Number 
parameters.
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Important: If any physical link fills its memory bank, the recording process stops. Other 
memory banks will typically be less than full (and can be empty). The sample file might be 
smaller than the user‐defined Sampling Memory Size. You might even think that the 
Analyzer malfunctioned.

3.18 Floating License

Note: License Manager is only available when in Cascading mode. For example, if one unit is licensed 
only for JJJJ and a second unit is licensed only for AAAA, cascading the two units and using the 
License Manager allows each unit to do JJAA.

To manage the license, select Setup > Manage Setup Licenses.

The Floating License dialog (see Figure 3.149 on page 219) displays the available 
functionality by Function, Total Ports, Assigned To ports, and Not Used. It also displays 
the Current License Configuration by License Type, Serial Number, Analyzer, 
Device Emulator, Host Emulator, and InFusion.

Note:Sierra M124 currently does not support Device Emulator, Host Emulator, and InFusion.

Figure 3.149: Floating Licence Dialog
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3.19 External Trig Setting

To display the External Trig Setting dialog, select Setup > External Trig Setting. The 
External Trig Setting dialog displays the External Trig Out Setting and External Trig In 
Setting as High Active, Low Active, or Toggle.

Figure 3.150: External Trigger Setting Dialog

To display the External Trig Setting dialog, select Setup > External Trig Setting.

External Trig Out Setting
The Analyzer can send a Low or High external signal anytime a trigger occurs. Select the 
External Trig Out Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Enter the External TrigOut pulse width. 

Note:The External TrigOut pulse width field supports increments of 16 ns, starting from 64 ns and 
up to 1024 ns.

External Trig In Setting
An external Low or High input signal can cause triggering. Select the 
External Trig In Setting: High Active, Low Active, or Toggle from High to Low or Low to 
High once (3.3 V output).

Note:The nominal External Trigger voltage is 0.818 volts. Trigger In can work with 1 volt to 5 volts 
input voltage.
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3.20 Update Device

The Update Device command allows you to update a Sierra M124 Analyzer or CATC‐Sync 
expansion card whose current version is incorrect.

1. Click Setup > Update Device to display the Device Setup dialog.

Figure 3.151: Device Setup Dialog with BAD Device Status

Devices whose version is correct have an OK status. 
A device whose version is incorrect has a BAD status.

Note:You can click the ellipses (...) at the end of a file path and name to display an Open dialog, in 
which you can browse for files.

2. Click the checkbox to the left of a device with BAD status, then click 
Update Selected to begin the process that will make the Analyzer version correct 
(see figure on next page).

Figure 3.152: Device Setup Dialog Beginning to Update Status of a Device

After the update, the device must restart.
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Figure 3.153: Info Dialog

Then the update is complete.

Figure 3.154: Device Setup Dialog with DONE Device Status

3.21 User-Defined Decoding

User‐defined decoding allows you to create a definition file to interpret commands and 
frames that are not in the standard set recognized by the software.

Select Setup > User Defined Decoding to open the User Defined Decoding dialog.

Figure 3.155: SAS: User Defined Decoding

SAS vs. SATA: SAS adds SCSI Commands, SSP Frames, and SMP Frames.
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Check ATA Commands and/or STP frames. Click the ellipses next to a command type text 
box to display the Open dialog. Choose an appropriate script file and click Open.

Figure 3.156: Choosing a Script File

3.22 Help Menu

3.22.1 Tell Teledyne LeCroy

Report a problem to Teledyne LeCroy Support via e‐mail. This requires that an e‐mail 
client be installed and configured on the host machine.

3.22.2 Help Topics

Displays online help. You can also select F1.

3.22.3 VSE Help Topics

Displays VSE online help. You can also select F1. 

3.22.4 Update License

A current license agreement with Teledyne LeCroy entitles the Analyzer owner to 
continued technical support and access to software updates as they are published on the 
Teledyne LeCroy website. When you obtain a license key, from the Help menu select 
Update License to display the Select License Key File dialog box. Enter the path and 
filename for the license key, or browse to the directory that contains the license key and 
select the *.lic file. Click Open.
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3.22.5 Display License Information

Open a license information dialog to display a list of named features supported by the 
current software version (see Figure 3.157 on page 224). Named features that are not 
enabled on your system are indicated by No in the Purchased column. Whether or not 
named features are enabled depends on the license key stored in your analyzer. If you try 
to use a feature for which you do not yet have a license, the program displays the License 
Protection Message. To use the feature, you must purchase a license.

Figure 3.157: Licensing Dialog
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3.22.6 Check for Updates

Check whether a new software version is available. If so, you can download from the 
Teledyne LeCroy web site. 
You can select to Check for updates at application startup.

Figure 3.158: Check for Updates

3.22.7 About

Displays version information.

3.23 Find DUT

Saving device information allows you to import the specific device information into the 
Target/Device emulator.

The Find DUT utility obtains all vendor‐specific information and detailed device 
parameters.

This feature only works in "SAS address" mode. It finds SAS addresses only and works up 
to one expander level. 

Find device finds any devices that are attached to any port.

Select Setup on the main menu bar and choose Find DUT (see Figure 3.159 on page 226).
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Figure 3.159: Find DUT

The Find DUT dialog displays.

Figure 3.160: Find DUT Dialog
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 225



Teledyne LeCroy SAS Verification (SAS)
Click the Find Device button to search for connected devices. After a brief period, the 
dialog displays all device information.

Figure 3.161: SAS: Identified Devices

Click a device in the Device List to display information about that device.

Aliasing

You can enter a 16‐character alias name for a device. In the Device List, right‐click the 
device name and enter an alias after the colon.

The alias name appears in the Device List. 

Exporting

You can export a device specification to a text file. Click the Export button to open the 
Export dialog. 

3.24 SAS Verification (SAS)

SAS Verification consists of a set of selectable tests to verify compliance with the 
SAS specification. 

Note:Speed Negotiation and all other SAS tests are documented in the SAS Verification Test 
Descriptions.pdf. file in the installed documents directory. 

Note:With the exception of the NACA test, the SAS Verification tests can be run at 12G.
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To run a SAS Verification Test:

1. Select Analysis on the main toolbar and choose SAS Verification to open the SAS 
Verification dialog (see Figure 3.162 on page 228).

Figure 3.162: SAS Verification Dialog.

 Speed Negotiation has Speed Negotiation Window Three and 
Train Speed Negotiation Window.

 Link Layer has Link Reset, Connections, SSP Frames,
Closing SSP Connections, Connections through Expanders, and Break.

 Transport Layer has SSP Frames Structures, Command IU, Data IU,
XFER_RDY IU, Response IU, and Error Handling.

 Application Layer has SCSI CDB, STP Operations and NACA.

2. Choose the tests in the left pane of the dialog and click the Add>> button.

3. Enter a value for DUT Type: Target, Initiator, or Expander.

4. Enter a value for the Number of Runs to run a particular test more than once.

5. Enter the DUT Name.

6. Enter the Connection Rate as Autospeed or a value. 

7. To view failed test traces in the sample viewer, check the 
Automatically load failed test traces into Sierra trace viewer check box.

8. To save the failed test traces only, check the Save only failed test traces check box.

9. Enter a path and file name for Report file, or use the default file name and path: 

For Windows XP:

C:\Program Files\LeCroy\SAS SATA Protocol 
Suite\User\SASVerification_Device1.rtf
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For Windows 7:

C:\Users\Public\Documents\LeCroy\SAS SATA Protocol 
Suite\User\SASVerification_Device1.rtf

10. Enter a path and file name for Saved Traces, or use the default folder: 

For Windows XP:

C:\Program Files\LeCroy\SAS SATA Protocol Suite\User\

For Windows 7:

C:\Users\Public\Documents\LeCroy\SAS SATA Protocol Suite\User\

11. After you select tests, click Start. 

12. The test runs and, after a brief period, displays the result.

13. To save the current compliance setup for later use, click the Save button to open the 
Save As dialog. Assign a meaningful name to the setup and save it as a *.cst 
compliance file.

14. To run a previously defined setup, click the Load button and choose a previously 
defined setup to run.

Note:For the NACA test, both ports of the SAS device must be connected to two Host Emulation ports, 
I1 and I2, using two SATA cables.

Note:When you are running SAS Verification, you cannot work with Trainer and Emulator while device 
is connected to D connector and HBA is connected to H connector.

Note:You must use a Power Expansion Card (ACC‐EXP‐004‐x or ACC‐EXP‐005‐X) for SAS Verification. 
See Using the Power Expansion Cards on page 21.

Note:Connecting to an HBA, while running in Emulation/Trainer mode, will impact test results.
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Chapter 4

InFusion Overview
The LeCroy InFusion™ Error Injector and Traffic Modifier is an error injector and traffic 
modification tool that allows you to verify real‐world fault handling for 
Serial Attached SCSI (SAS) and Serial ATA (SATA) systems. InFusion can sit unobtrusively in 
the data path on a live system to programmatically alter or corrupt traffic. InFusion is the 
ideal tool for stress‐testing systems using actual workloads.

Figure 4.1: InFusion Windows.
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InFusion supports SAS SSP, SMP, STP, and SATA‐based protocols operating across a single 
SAS or SATA link up to 12 G. InFusion monitors traffic from both directions in real‐time 
and relies on predefined rules to replace any bit, primitive, or parameter with one you 
specify. InFusion can change traffic when it detects a specific sequence or reaches a 
designated time interval, yet it requires no complicated scripts, programming, or 
simulation tools.

InFusion can monitor traffic in both directions and act on events occurring in either 
direction of the communications link. InFusion can modify traffic in only one direction 
within a given test scenario, but that direction can be either from the Initiator or from the 
Target.

InFusion is specifically designed to verify recovery characteristics within a subsystem. An 
easy pop‐up menu interface allows you to create specific test scenarios in just minutes. 

Once a InFusion session starts, the system automatically handles protocol handshaking 
between devices. InFusion transmits a faithful copy of the original data stream down to 
the CRC value which, if needed, it recalculates. InFusion allows test engineers to 
systematically verify error recovery in ways not possible with other test platforms.

An Infusion event can trigger an analyzer.

4.1 Key Features

The key features of InFusion are:

 Error Injection: Injects CRC, disparity, 8b/10b encoding, framing, and coding 
errors.

 Break Link Recovery: Programmatically breaks the connection to test link recov‐
ery.

 Value Replacement: Monitors the link for specific values, patterns, or primitives 
(as low as bit level) and replace with user‐defined values. You can replace values 
on every occurrence, after a specified number of occurrences, or after a speci‐
fied time interval.

 Packet Drop: Removes individual primitives, address frames, or data frames 
from the stream to verify retry behavior.

 Primitive Manipulation: Replaces handshaking and flow control primitives to 
help validate robustness of a design. 

 Traffic Monitoring: Operates as a traffic monitor, collecting statistical data on 
user‐specified parameters. In this mode, data passes unchanged in both direc‐
tions. 

 Menu‐Driven Interface: Allows easy set‐up of test scenarios.
 API based on C++: Allows development of custom test applications.
 Scenario Batch Files: Allows scenario scripts.

With respect to traffic modification, in the Link Layer you can modify primitives, CRC, 
scrambled traffic, and SSP, SMP, and STP connection events. You cannot modify clock 
skew management, OOB and power management, and signal integrity.

InFusion consists of a hardware device that connects to the line under test and a 
Windows‐based software application used to create and download test scripts to the 
232 Sierra M124 SAS/SATA Protocol Analyzer User Manual



Interface  Teledyne LeCroy
device. You also can use the software application to configure and control the device 
across an Ethernet link.

InFusion test scripts are called scenarios. Scenarios determine how the hardware device 
monitors and modifies line traffic. You must use the application to create and download 
scenarios.

For the InFusion connections, the device is connected between the SAS/SATA host and 
the PHY of the test target (DUT). Link training is not performed transparently because the 
FPGA cannot manipulate the required physical probe settings. Hence, training sequences 
and speed negotiation cannot be jammed. Another side effect is that pre‐jam and post‐ 
jam recordings during these events are not the same.

4.2 Interface

4.2.1 Buttons

The InFusion interface has the following command buttons:

New Scenario: Begins the scenario creation process by listing Scenario Name, Direction 
for traffic changes, and Global Rules in the scenario window.

New Batch Script: Starts a scenario batch file in Batch Script window.

Open Library: Lists the InFusion Library Files (.infdb), which contain the available 
scenarios, in an Open dialog.

Save: Saves the current scenario in the UserData folder.

Print: Prints the current scenario.

Show Library: Displays/hides the Main Library window (on the right), which displays the 
available scenarios. You can create a new scenario, save a selected scenario, save the 
library, save a copy of the library, display the selected scenario, insert a copy of the 
selected item, or delete the selected scenario.

Show Output: Displays/hides the Output window (at the bottom), which displays 
InFusion output. Use the buttons to save output, print output, display options 
(automatically save the log file, with a path and size), start logging, stop logging, and clear 
the Output window.

Show Port Assignment: Displays/hides the current port assignment.

Port Configuration: Displays the port configuration dialog. See “Port Configuration for 
InFusion” on page 237.

Launch Analyzer: Returns to the Protocol Analyzer or Target/Host Emulator window.

Launch Trainer: Goes to the Trainer window.

Run Batch Script: Runs a scenario batch file.
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 233



Teledyne LeCroy Interface
Stop Batch Script: Stops a running scenario batch file.

Record: Starts recording on the current analyzer, using the current project.

Stop: Stops recording on the current analyzer.

Abort: Aborts recording.

4.2.2 Menus

The InFusion interface has the following menus:

File
(see command descriptions in the “Buttons” section above)

 New Scenario, Open Scenario (File Library or Main Library)
 Open an InFusion database (.infdb file)
 Launch Analyzer
 Launch Trainer
 New Batch Script, Save Batch Script As
 New Library, Close Library (File Library or Main Library), Save Library, Save Copy 

of Library As
 Open Log File
 Print Setup
 Recent Trace Files
 Recent Project Files
 Close

Setup
 External Trig Setting (see “Floating Licence Dialog” on page 219)
 Update Device (see “Update Device” on page 221)
 All Connected Devices
 Status Bar

View
 Views (Library, Output, Port Assignment, Customize ‐ commands, Toolbars, Key‐

board, Menu and Options)
 Smart Docking
 Toolbar
 Status Bar

Configuration
 Port Configuration (see “Port Configuration for InFusion” on page 237)
 Batch Script Setting (see “Scenario Batch Files” on page 281)

Tools

Browse UserData, System, or InFusion folder.

Help

Help Topics and About InFusion.
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4.2.3 Main Library

You can Show Main Library.

Figure 4.2: Main Library.

The Main Library has Scenarios.

Using the buttons from left to right, you can:

 Create a new scenario and save a scenario.
 Save a library and save a copy of a library.
 View/edit a scenario, insert copy of a scenario and delete scenario.
 Copy and paste.

4.2.4 File Library

You can display the File Library.

Figure 4.3: File Library.



Teledyne LeCroy Interface

2

A File Library has Scenarios currently available in the device.

Using the buttons from left to right, you can:

 New scenario.
 Save selected scenario.
 Save library.
 Save a copy of the library as.
 View/edit a selected item.
 Insert a copy.
 Delete a selected scenario.
 Copy
 Paste

4.2.5 Device Ports

If a device is connected, the software displays the Device Ports.

Figure 4.4: Device Ports.

Using the first row of icons, you can Run/Stop All Ports or Run/Stop individual ports.
The columns display the Port, Function/Configuration, Library, and Scenario.
You can Float, Dock, Auto‐Hide, or Hide the window.

Note:A port row is grayed‐out when that port has not been configured to be a Jammer in the 
Port Configuration dialog (see “Port Configuration for InFusion” on page 237).

Using the Device Ports Dialog

After you have finished Port Configuration (see “Port Configuration for InFusion” on 
page 237), you use the Device Ports dialog (see “Scenario Libraries” on page 242) to 
assign specific scenarios to ports, so that different scenarios can run on different ports. 

To assign a scenario to a port, drag and drop the scenario from any library window to the 
port. The Device Ports dialog then displays the Library and Scenario on the row for that 
Port/Configuration.
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Figure 4.5: Device Ports Dialog.

Alternatively, assign the scenario using the Library and Scenario drop‐down lists.

Figure 4.6: Scenario Drop-down List.

After you have assigned scenarios to ports, in the first row of icons, use the first green 
arrow icon to Run/Stop All Ports, or use the numbered green arrows to Run/Stop an 
individual port.

Note:A port row is grayed‐out when that port is running a scenario.

4.3 Port Configuration for InFusion

The InFusion (Jammer) port configurations must match the Analyzer port configurations 
for the infusion‐analyzer to work. 

Select Configuration > Port Configuration to display the Select Port Configuration dialog 
(see Figure 4.7 on page 238).

To record traffic both before and after the InFusion modifies (jams) it, select 
Analyzer/Jammer/Analyzer on the port that you want to jam. In the following figure, 
there is a match on Port 0.
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Figure 4.7: Ports Configuration Dialog with InFusion/Analyzer Port Match.

Note:You can select only one Jammer port at a time with this configuration. 

To record traffic from two ports after the InFusion modifies (jams) them, select a 
combination of ports that have Jammer/Analyzer specified under them. The different 
configurations accommodate different possible user setups and requirements.

Note:To display the current Port Configuration, click Show Analyzer to go to the analyzer application, 
then click the green button in the lower right corner to display the Port Status window (see 
“Port Status” on page 195).

4.4 InFusion Scenarios

You can create and execute InFusion scenarios. A scenario is a test script that defines how 
InFusion monitors and modifies line traffic.

4.4.1 Scenarios Overview

The InFusion application provides a menu‐driven interface for building scenarios. The 
interface prompts you for simple decisions and choices from drop‐down menus. As you 
make your selections, the script takes shape automatically in the scenario window. The 
script is in the form of simple English sentences. You need not understand any formal 
scripting language (see Figure 4.8 on page 239).
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Figure 4.8: New Scenario in InFusion Window

InFusion Scenario Parameters

Timers

Timers allowed per state/sequence/scenario: 

2 timers per state and 6 timers per scenario are allowed.

Events

Events allowed to be used per state/sequence/scenario: 

For combined events, there is virtually no limit per state/sequence/scenario. 

Actions

Actions allowed per state/sequence/scenario: 

A maximum of 8 actions per state, 2048 actions per sequence (8*256 state), 4104 actions 
per scenario (2*2048 + 8 more in the Global Rules "state"). 

Monitors

Monitors allowed to be used per state/sequence/scenario: 

InFusion can keep an account of 8/12 Monitor/Count events per scenario. 

Random change of use of count and count randomly:
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In Global Rules, if a Counter is used for Event counting, 2 extra actions are consumed. 2 
more actions are required for "Every Nth occurrence" option. 

In Sequences, If a Counter is used for Event counting, 3 extra actions are consumed. 3 
more actions are required for "Every Nth occurrence" option. 

Regarding limits on any of the above mentioned connections, i.e., x timers + y monitors 
are allowed per state where x+y=n: 

There are a lot of big/small rules checked by the scenario compiler, but as a rule of 
thumb: 

8 actions per state are available

12 counters globally are available, each assigned permanently to a certain job 

6 available timers per scenario 

12 programmable multi‐purpose resources for DWORD comparison/substitution/capture 
are available. If a pattern detector uses 3 of these resources to trigger on a specific frame 
on the bus, only 9 more resources are available for other tasks. Frame/FIS type detectors 
are excluded from this rule, because they use their own dedicated resources. 

8 primitive detectors are available

If you want to trigger on a pattern (Frame/FIS) and change/capture a dword(s) before the 
last offset of a detected pattern (e.g., changing the Frame Type of a SAS Frame with Data 
Offset == 11223344), you are limited to a maximum of 9 dword offset (i.e., if you trigger 
on the 20th payload of a Data FIS, you can change/capture the 12th dword onwards. 11th 
payload dword and preceding dwords are not accessible for change/capture) 

You can not change a state based on back‐to‐back events. At 6G speed, there should be at 
least one dword between the triggering event of two consecutive states. At other speeds, 
back‐to‐back dword state transitions might rarely be missed, so best practice is to never 
assume back‐to‐back dword events. 

As described later in this chapter, you can create any number of scenarios and store them 
in libraries on the PC hard drive. Scenario library files names are in the following format: 

<filename>.infdb

Creating InFusion scenarios is easy, but it requires an understanding of the following 
terms defined in Table 4.1 on page 241.
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TABLE 4.1:  Key Scenario Terms

4.4.2 Global Rules

Global Rules are a portion of the scenario that can define only one test state. To create 
the Global Rules, you use the menu‐driven interface to enter an event or combined event 
and the corresponding action or set of actions (the response of InFusion hardware to the 
event).

In the case of a combined event, the action is taken upon occurrence of any of the events 
stated for the event combination. It is a logical OR association, meaning any of the events 
can trigger the action.

After you enter the event or combined event, the interface prompts you for actions. An 
action might be, for example, injecting a particular primitive or error into the traffic 
stream. You can enter multiple actions, which take place simultaneously. 

After defining the event and actions within the Global Rule area, you can save the 
scenario and download it to a InFusion device.

4.4.3 Sequences

The Global Rules are all you need for simple test scenarios. However, a scenario also can 
contain one or two sequences, which can define multiple states and allow branching 
between states. With a sequence, you also can do looping, which allows you to repeat a 
test state or to execute a test for a specified period of time.

As with Global Rules, the menu‐driven interface guides you in building a sequence. Some 
of the prompts are different, however, because you now are encapsulating groups of 

Term Definition
Action InFusion response to an event.

Event Condition that is detectable by InFusion.

Combined Event Logical OR association of events (for example, event A OR event B).

Global Rules Portion of a scenario that can define a single InFusion test state. 
You can think of the Global Rules and each sequence as a separate 
test routine or program operating within the scenario. Each 
operates independently and in parallel with the others. The 
purpose of each is to detect events and then respond with the 
appropriate action or set of actions. In essence, you can operate 
up to three test states simultaneously within InFusion.

Sequence Portion of a scenario that can define multiple InFusion test states. 
More flexible than the Global Rules, a sequence allows more 
powerful scenarios that include branching and looping between 
test states (Global Rules can define only a single test state, so there 
is no branching).

State “Behavior” of the Global Rules or a sequence at any point in time. 
In terms of InFusion testing, behavior is “waiting” for a set of 
events and responding with a set of actions.
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events and actions as distinct states. Recall that a state is a combination of events and 
actions at a specific point in time. If the event or combined event defined by a state 
occurs, the corresponding action or set of actions follows.

Figure 4.9: Global Rules and Sequence Areas of a Scenario

InFusion hardware provides the capacity to have up to two sequences co‐existing in a 
scenario in addition to the Global Rules. Recall that both the Global Rules and any 
sequences are active at all times. Each is a separate “state machine,” having the behavior 
of a particular test state at any point in time. Because the Global Rules has the capacity 
for only one state, you can view it as a “degenerative state machine.”

4.5 Scenario Libraries

You can create any number of scenarios, which you then can archive on your PC hard 
drive. You also can download up to ten scenarios to each InFusion device for test 
execution. You can think of the libraries as windows that hold scenarios. 

Recall that each library is a separate *.infdb file.

4.5.1 Main Library

When you launch the InFusion application, it opens a window called the Main Library. 
The main library is the default workspace for creating and storing new scenarios. The 
main library corresponds with the following file in the InFusion folder on the PC 
hard drive:

default.infdb

4.5.2 File Libraries

You can save the main library with a name other than default (while still using the .infdb 
file extension). The new file becomes a file library that is functionally equivalent to the 
main library with the following exception: It does not open by default in the Main Library 
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window. You can navigate to other file libraries using the File Manager of the InFusion 
application.

In this manual, the main library and other .infdb file libraries are collectively called 
general libraries.

If you select Open Library, you see a window similar to the following:

Figure 4.10: Open Library File List

By selecting the TestCasesForSATA.infbd file, you get an additional library window with 
predefined SATA test cases, similar to the following:

Figure 4.11: Test Cases for SATA Library

4.6 Scenario Properties

To begin the scenario creation process, you click the New Scenario button in a library 
window or on the InFusion application toolbar. As the first step in creating a scenario, the 
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application prompts you for scenario name, a short description (optional), and the 
direction of traffic to which any traffic changes apply. Changes are, for example, injection 
or removal of data or a primitive.

You identify direction of traffic change, or modification, in terms of traffic origin. The 
application uses the following conventions:

 From Initiator: Change is made to traffic coming from test host (for example, 
CRC error is injected into traffic stream sent from initiator to target).

 From Target: Modification is made to traffic coming from the target (for exam‐
ple, CRC error is injected into traffic stream sent from target to initiator). 

The following figure shows the first prompt in the scenario creation process.

Figure 4.12: Entering Basic Scenario Information

To copy an event or action, right‐click on the event or action and select Copy. 
Right‐click Click here to add another event or Click here to add an action and then select 
Paste. 

To copy a sequence or state, right‐click on the sequence or state and select Copy. 
Right‐click Click here to add another sequence or Click here to add another state and 
then select Paste. 

You can also cut, delete, and edit a selected sequence, state, event, or action.

When you click the Scenario Name or the Direction For Traffic Changes, the 
Scenario Properties dialog box displays (see Figure 4.13 on page 245), allowing you to 
enter the scenario name, a short description, and direction of traffic change.
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Figure 4.13: SAS Scenario Properties Dialog Box

In the Scenario Properties screen, the direction for traffic modification is defined on a 
global basis for the entire scenario. In other words, any scenario action that modifies line 
traffic only affects the traffic flowing in the direction established at the top of the 
scenario, in the Scenario Properties. Scenario events can be monitored in either direction, 
and therefore the parameters for events provide the ability to specify the intended 
direction for monitoring traffic for that event.

SATA Smart Hold Option

Figure 4.14: SATA Scenario Properties Dialog Box

SATA Scenario Properties have a Smart Hold option, which is on by default. 

Each port monitors incoming data, which originated with the other device’s receiver, as 
close as possible to where it enters the bus engine. If a port detects a HOLD primitive 
during a SATA frame, the port stops reading data from the FIFO and generates HOLDA. 
The HOLD propagates through the bus engine and eventually goes to the other device, 
where the HOLD causes the other device to send HOLDA. (The bus engine FIFOs must be 
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deep enough to hold all the traffic that the other device sends while the HOLD 
propagates. The port drops all incoming HOLDA conditions, so HOLDAs are never put in 
the FIFOs or made visible to the sequencers.)

After this, the port that had been receiving the HOLD stops sending HOLDA and attempts 
to read data from the FIFO. The termination of HOLD propagates through the bus engine 
and then causes the other device to restart transmission, which puts data into the FIFO.

Note: If both sides send HOLD primitives that overlap, the receivers drop the HOLD conditions to avoid 
overflowing the FIFOs. If you turn off the Smart Hold option, the port does not send HOLDA 
when it detects a HOLD primitive during a SATA frame.

4.7 Scenario Events

A scenario is a script you create using simple mouse clicks and text entries. As you work, 
the script takes shape in the scenario area of the application display. You can think of the 
scenario area itself as consisting of two subareas: A Global Rules area at the top, where 
you create the Global Rules, and a Sequence area beneath the Global Rules, where you 
create any sequences. Whether you are creating Global Rules or a Sequence, the menu‐
driven interface prompts you to specify the event(s) for which you want to trigger actions 
(see Figure 4.15 on page 247).



Scenario Events  Teledyne LeCroy
Figure 4.15: Event Properties Dialog.

While many events are line conditions, an event also can be a condition that occurs within 
a InFusion device (for example, detection of a trigger signal from another device). 
The following table lists supported events. Note that some events are applicable only in 
the context of creating sequences (those events appear on the drop‐down list only if you 
are creating a sequence). Sequences can have multiple states, and they allow branching 
between states.

TABLE 4.2:  Events

Event Description
Address Frame Occurrence of a specified address frame.
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 247



Teledyne LeCroy Scenario Events
Analyzer Trigger Trigger on Analyzer when its event matches. You can see the 
trigger on the Status Bar, but the Port Status dialog does not 
display any mark in the Trigger column. 

Note: This is different than the external trigger mechanism. 
You do not need an external trigger cable.

Note: The Trigger on Analyzer feature functions when the 
trigger pattern is set to "Pattern/Infusion" and running a 
scenario which will trigger analyzer after a 5s timer. A 
message "Triggered, Post‐Trig Capturing" displays on the 
Software Status bar. 

Note: When the analyzer triggers, it triggers on a packet 
before the actual trigger event occurs. The trace triggers 
more than 1us before the event actually occurs. The trigger is 
on the Initator side instead of the Target side as set in the 
scenario. 

Any DWORD Occurrence of any DWORD.

ATA Command Occurrence of a particular ATA command.

ATA Command Frame Occurrence of a particular ATA command frame.

[+] ATAPI Occurrence of a particular ATAPI command from the list:
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

Both Links Up Occurrence of both line ports active (not idling).

CRC Error Occurrence of a CRC error.

DWORD Matcher Occurrence of a particular DWORD.

FIS Frame Occurrence of a particular FIS frame.

FIS Type Occurrence of a particular SATA FIS type.

Frame Type Occurrence of a particular frame type.

Invalid 10bit‐code 
Error

Occurrence of an invalid 10b code.

Links Speed 3G Both lines operating at 3 Gbps.

Links Speed 6G Both lines operating at 6 Gbps.

Links Speed 12G Both lines operating at 12 Gbps.

OOB Signal Occurrence of OOB signal.

[+] Primitives Occurrence of Primitive Group, SAS Primitive, or SATA 
Primitive.

Running Disparity Error Occurrence of Running Disparity (RD) error.

SAS Data Pattern Occurrence of a particular data pattern in a SAS frame.

SATA Data Pattern Occurrence of a particular data pattern in a SATA frame.

{+} SCSI Occurrence of a particular SCSI command from the list:
MMC4, RBC, SBC2, SMC2, SPC2, SPC3, or SSC2.

SMP Frame Occurrence of a particular SMP frame.

SNW Occurrence of Final SNW, SNW1, SNW2, SNW3, Train SNW

SSP Frame Occurrence of a particular SSP frame.

Event Description
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The following sections provide some additional details about three of the above events.

4.7.1 DWORD Matcher

DWORD Matcher is a DWORD pattern matcher that presents match and mask fields and a 
K‐Code Mask field. K‐Codes are control characters that are always used in the first byte of 
a four‐byte primitive. Of the K‐Code masks listed in the menu, D‐D‐D‐D is used for data 
bytes, and K‐D‐D‐D is used for all primitives.

When you create a DWORD match, keep the following in mind:

 The pattern can be inside or outside of frames (it does not matter if the pattern 
is inside a frame or not).

 Because the pattern can be inside or outside of frames, there is no offset.
 You can make user‐defined primitives. (This is the reason this feature was cre‐

ated.)
 You can use any K/D pattern.

4.7.2 Address Frame

With Infusion, you must enter all values in reverse MSB, LSB order. 

For example: a SAS Address in the viewer "5000C50056B8C829" should be entered like 
this in Infusion: "29C8B85600C50050".

4.7.3 SAS Data Pattern

When you create a SAS data pattern, keep the following in mind:

 The pattern must be defined inside a frame that starts with a SOF or SOAF.
 The pattern must be data only (no K‐codes/primitives).
 The pattern must be defined at a specific offset in the frame.
 The pattern and mask must be specified in the same format as specified in the 

SAS standard: 
0x12345678 (hex)
where “1” is the first digit on the cable and is the MSB as given in the SAS Stan‐
dard.

For example, for an SMP Request:

Pattern: 0x40000000
Mask: 0xFF000000
Offset: 0
SOF Type: SOF

Timer Occurrence of a particular elapsed time (time period).

Training Sequence Occurrence after training sequence.

Trigger Input Occurrence of input trigger.

Event Description
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4.7.4 SATA Data Pattern

When you create a SATA data pattern, keep the following in mind:

 The pattern must be defined inside a frame that starts with a SATA_SOF.
 The pattern must be data only (no K‐codes/primitives).
 The pattern must be defined at a specific offset in the frame.
 The pattern and mask must be specified in the same format as specified in the 

SATA Standard.

For example, for Register H ‐> D FIS:

Pattern: 0x00000027
Mask: 0x000000FF
Offset: 0
SOF Type: SATA_SOF

4.7.5 Analyzer Trigger

Trigger the Analyzer when the Scenario event matches. You can see the trigger on the 
Analyzer Status Bar.

The Analyzer Trigger feature functions when the Analyzer trigger pattern is set to Pattern/
Infusion and is running a scenario which activates the Trigger analyzer action. A message 
Triggered, Post‐Trig Capturing displays on the Software Status bar.

This is different from the external trigger mechanism. You do not need an external trigger 
cable.

When the analyzer triggers, it triggers on a packet before the actual trigger event occurs. 
The trace triggers more than 1 μs before the event actually occurs. The trigger is on the 
Initator side instead of the Target side, as set in the scenario. 

4.8 Scenario Actions

After you enter the set of events for a test state, the menu‐driven interface prompts you 
for the corresponding action or set of actions. If you define multiple actions, the actions 
occur simultaneously (see Figure 4.16.)
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Figure 4.16: Action Properties Dialog

The following table lists supported actions. Note that some of these actions only apply to 
creating sequences.
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TABLE 4.3:  Test State Actions

Action Description
Analyzer 
Trigger

The Jammer sends a trigger to the Analyzer.

Beep Emits audible sound of duration selectable via 
drop‐down list.

Capture Data DWORD Captures a data DWORD into one of four registers.

Inject CRC Error Injects a CRC error into the line.

Invalid 10bit‐code 
Error

Injects invalid 10b code into the line.

Running Disparity 
Error

Injects a Running Disparity (RD) error into traffic.

Insert Address Frame

FIS Frame

SAS Primitive

SATA Primitive

SMP Frame

SSP Frame

Inserts a frame or primitive.

Insert DWORD Inserts DWORD.

Link Disconnect Puts both InFusion SAS ports at electrical idle 
immediately. This action is only in effect while the 
scenario is running, and the Jammer will 
reconnect the line when the scenario is stopped.

Reconnect Starts traffic pass‐through immediately. This 
action restarts traffic after a previous disconnect 
command. Once traffic is passing through, the 
initiator and target resume OOB signaling.

Monitor/Count Opens a window to count the number of events 
that occur during a session. A session is a time 
interval during which a scenario runs.

Remove Frame Partially

Primitive

Whole Frame

Removes the targeted event from the traffic.In 
InFusion. 

A Remove primitive action is implemented by 
replacing the primitive with an idle data DWORD. 

A Remove frame action is implemented by 
replacing the start‐of‐frame and end‐of‐frame 
primitives with an idle data DWORD.

Restart  All Sequences1 Restart all sequences in the scenario.1

Current Sequence1 Restart the sequence that contains this action 

definition. 1
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1 Only shown in Action Properties dialog box when creating a sequence.

4.8.1 Available Resources

You can specify Events, Combined Events and Actions and additional Events. The 
application automatically checks for the maximum number of terms (Events/Actions). 
When you exceed the limit, an error is flagged, prompting you to jump to the place that 
caused the error.

The list of available resources is given below:

 External Trigger X 1
 Analyzer Trigger X 1
 Training Detector x 4 (only M12x)
 Primitive Detector (each has its own Embedded counter in M12x) X 8
 Pattern Detector (each has its own Embedded counter in M12x) X 8 (a total of 12 

DWORD detectors are shared between all pattern detectors)
 Frame Type Detector X 24
 Counter X 12
 Timer X 8
 OOB X 1
 ComWakeDetected X 1
 ComWakeCompleted X 1
 ComInitDetected X 1
 ComInitCompleted X 1
 ComSasDetected X 1
 ComSasCompleted X 1
 Snw1 X 1
 Snw2 X 1
 Snw3 X 1
 SnwFinal X 1
 SnwTrain X 1

SNW Speed Negotiation 
Retime

Set RCDT, SNTT, ALT/TLT, TX speed, TRAIN/
TRAIN_DONE pattern, and/or PHY Capability.

Speed Negotiation 
Violation

Set Violation Type.

Stop Scenario Stops all scenario activity.

Substitute Data DWORD Substitutes a data DWORD in the traffic.

with SAS Primitive Substitutes a SAS primitive in the traffic.

with SATA Primitive Substitutes a SATA primitive in the traffic.

Trigger Output Sends a signal out the trigger port to the device 
downstream.

The trigger point in the Analyzer that caused the 
analyzer trigger action will not be the selected 
event, it will be the selected event with some 
offset.

Action Description
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 DisparityError X 1
 10B Error X 1
 CrcError X 1
 Both Links Up X 1
 Link Speed 3G X 1
 Link Speed 6G  X 1
 Link Speed 12G X 1
 Primitive Substitute X 12
 Insert Frame1 (Up To 1024 Dword) X 1
 Insert Dword8 (Up To 16 Dword) X 8
 SNW Manipulation X 16
 Global Action Register X 8
 State per sequencer X 256
 Action Register per state X 8

Usage of Action Register: 

 Each Counter in Global Rules = 2
 Each Counter in State = 3
 Each Timer in Global Rules = 2
 Each Timer in State  = 3
 Other Actions = 1

4.8.2 Using Counters in Events and Actions

Many of the events and actions supported by InFusion also support counters that can 
control functions.

Within events, counters determine how many times the event must occur before the 
associated actions are triggered. Event counters typically have two properties:

 Count Randomly: Can be set to “Yes” or “No” (default value is “No”). 
If set to “Yes”, the event repeats a random number of times (between 1 and the 
value set in the property Max Random Count, which replaces the property 
Counter Value when “Yes” is selected), before the action is triggered.

 Counter Value: Number of repeats required when Count Randomly is set to 
“No”. The default value is 1.

Within actions, counters determine how many times the system calls the action before it 
acts. Action counters typically have two properties:

 Random: Can be set to “Yes” or “No” (default value is “No”). 
If set to “Yes”, the action triggers a number of occurrences before the action 
takes place. That number ranges randomly between 1 and the value set in the 
property At least every Nth occurrence, which replaces the property 
Every Nth occurrence when “Yes” is selected.

 Every Nth occurrence: Number of times the system calls the action before it 
acts.

Note that there is some overlap in the way these counters can be used. For example, in 
the simple case of a single event leading to a single action, it makes no difference 
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whether you specify the event to require five repeats before triggering the action, or the 
action to require five occurrences before it acts.

However, in the case of combined events and/or actions, the separate counters provide 
flexibility in designing test cases. For example, consider the case where Event_1 OR 
Event_2 leads to Action. If Event_1 has a counter of 5, then the Action triggers either 
when Event_1 has repeated five times or when Event_2 happens the first time, whichever 
occurs first.

But if the event counters are set to 1 and the Action counter is set to 5, then the Action 
happens after five occurrences of EITHER Event_1 or Event_2.

4.8.3 Capturing a Data DWORD

InFusion provides the ability to capture individual data DWORDs and provides four 
different registers to store captured DWORDs (DWORD #0, #1, #2 and #3).

To capture a data DWORD, select Capture Data DWORD from the Action Properties 
screen, as shown below. Select the register to be used to store the DWORD from the 
drop‐down menu under the Capture Register property.

Figure 4.17: Capture Data DWORD Action

4.8.4 Using Captured Data DWORDs

Captured data DWORDs can be used in creating events for data that match the captured 
DWORD(s), or in creating actions to substitute the captured DWORD(s) into the data 
stream.
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To create an event using the captured DWORD, in the Event Properties menu, select SAS 
Data Pattern (or SATA Data Pattern), and then select any of the 12 DWORDs (DWORD 0 
Type through DWORD 11 Type). The drop‐down menu (see Figure 4.18 on page 256) 
provides the choice of a custom DWORD or any of the four captured DWORDs. If you 
select a captured DWORD, the Value field beneath this selection is hidden (the Value 
field is only used for specifying custom DWORDs). Note that choice of a mask and an 
offset are still available when using captured DWORDs.

Figure 4.18: Using a Captured DWORD in a SAS Data Pattern
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Captured data DWORDs may also be used in the Substitute Data DWORD test state 
action. From the Action Properties screen, choose Substitute Data DWORD and then 
select the Substitute for property. A drop‐down menu is provided (see below) that allows 
the choice of a custom DWORD or any of the four captured DWORD registers.

Figure 4.19: Using a Captured Data DWORD in Substitute DWORD Test Action

4.8.5 Summary of Scenario Creation

The suggested process of creating and executing a scenario is as follows:

1. Create a scenario in the main library.

2. Save all scenarios in the main library to a InFusion device or a device of your choice.

3. Select the scenario in the main library that you want to run on the device.

4. To run the scenario, click the Start Scenario button from the Main Library toolbar. 
The device starts to monitor/modify traffic.

Note:Step 1 is described in detail for each example in following sections. Steps 2 to 5 are described in 
detail at the end of this chapter.

4.9 Creating Global Rules

This section gives examples for creating the Global Rules area of a scenario. Recall that 
the Global Rules area defines a single test state. The Global Rules do not have the capacity 
for multiple states, so that area of a scenario cannot change state.
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In terms of InFusion testing, a state defines test “behavior.” In this context, behavior is 
“waiting” for an event and responding with an action or set of actions that happen 
simultaneously. 

Keep in mind that a test state you implement with the Global Rules operates in parallel 
with the active test state of each sequence in the scenario. 

In effect, InFusion lets you do up to three line tests at the same time. You can do one test 
with the Global Rules and a separate test with each sequence you create. You can have up 
to two sequences in a scenario. 

The following table summarizes the Global Rules examples that follow.

TABLE 4.4:  Global Rules Examples

4.9.1 Example 1: Creating a Single Event and Action that Removes a Primitive

In this example, the Global Rules area of the scenario waits for each RRDY Normal 
primitive from the initiator and removes it.

1. Click the New Scenario button in the main library or one of the device libraries.

2. In the Scenario Properties dialog, enter the scenario name, description, and 
direction of traffic change (see Figure 4.13 on page 245).

3. In the Global Rules area, click the prompt to add an event.

Figure 4.20: Example 1: Adding an Event

Example Description
1 Creating a single event and action (removes a primitive).

2 Creating a single event and action (replaces a primitive).

3 Creating a combined event (a logical OR association of multiple events) 
and an action.

4 Creating multiple triggers and actions.

5 Creating multiple actions on a single event.

6 Using timers.
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The Event Properties dialog box appears (see Figure 4.15 on page 247). 

4. In the Type column of the Event Properties dialog, choose Primitive > SAS Primitive.

5. In the Type column in the middle of the dialog box, click Description if you want to 
add a description of the event. 

6. Click Direction to choose the direction of traffic to monitor for the selected event 
(the default is From Initiator, which is what you want for this example). 

7. Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop‐down menu that lets you choose the type of primitive for which you 
want to wait in this scenario. In this example, it is RRDY (Normal).

Figure 4.21: Example 1: Event Drop-Down List

8. Click OK to close the Event Properties dialog box.
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9. In the Global Rules area, click the prompt to add an action.

Figure 4.22: Example 1: Entering an Action

The Action Properties dialog box appears (see Figure 4.16 on page 251).

10. In the Type column on the left, choose the action that you want to occur when an 
RRDY is detected. In this example, it is the Remove Primitive action. Select Random 
Yes or No, N for Every Nth occurrence, and Monitor/Count as Monitored or Not 
Monitored.

11. Click OK to close the Action Properties dialog box.

Figure 4.23: Example1: Complete Scenario

12. In the File menu, select Save Scenario to save the scenario.
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4.9.2 Example 2: Wait for a Primitive and Replace It with an Error

In this example, the Global Rules portion of the scenario waits for each RRDY Normal 
primitive and replaces it with an ERROR primitive.

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

3. As you did in the previous example, choose RRDY (Normal) as the type of primitive 
to monitor.

4. In the Global Rules area, click the prompt to add an action to display the 
Action Properties dialog box.

5. In the Type column on the left, choose Substitute > with SAS Primitive as the action 
that you want when an RRDY (Normal) occurs.

6. In the middle column of the dialog box, click Description if you want to add a 
description of the action.

7. Still in the middle column of the Event Properties dialog box, click Primitive to 
display a drop‐down menu that lets you choose the type of primitive for which to 
substitute for RRDY (Normal) (see Figure 4.21 on page 259). Choose ERROR.

8. Click OK to close the Action Properties dialog box.

9. In the File menu, select Save Scenario to save the scenario.

In this example, you set the substitution action to happen at every occurrence of an RRDY 
(Normal) (as shown in the figure, the action is set for every occurrence). However, you 
can set an action to happen at other multiples of event occurrence (for example 5, 25, 
1000 and so on). You also can set the action to happen at random, within a specified 
number of event occurrences.

Figure 4.24: Example 2: Complete Scenario
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4.9.3 Example 3: Creating OR Conditions

In this example, the Global Rules area of the scenario waits for either of two types of 
RRDY primitive and replaces them with an ERROR primitive.

This example includes a combined event (a logical OR association of two or more single 
events). Here, the combined event consists of any occurrence of RRDY (Normal) or RRDY 
(Reserved 0).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. In the Global Rules area, click the prompt to add an event to display the 
Event Properties dialog box.

3. As you did in example 1 of this chapter, choose RRDY (Normal) as the first primitive 
that you want to monitor.

4. Click the add combined event prompt to add a second event.

Figure 4.25: Example 3: Entering the Second Event

The Event Properties dialog box appears.

5. Choose RRDY (Reserved 0) as the second primitive that you want to monitor. 

6. Click OK to close the Event Properties dialog box. 

7. In the Global Rules area, click the prompt to add an action to display the Action 
Properties dialog box.

8. In the Type list on the left, choose Substitute SAS Primitive as the action that you 
want when either RRDY Reserved 0 or RRDY Normal occurs.

9. Click OK to close the Action Properties dialog box.
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10. In the File menu, select Save Scenario to save the scenario.

Figure 4.26: Example 3: Complete Scenario

4.9.4 Example 4: Multiple Triggers and Actions

In this example, the Global Rules area of the scenario waits for two events, each of which 
triggers a different action.

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As you did in example 2, choose RRDY (Normal) as the first event to monitor, and 
substitute with the SAS primitive ERROR as action.

3. In the Global Rules area, click the prompt to add the next event (keep in mind this is 
not a combined event).

Figure 4.27: Example 4: Entering Second Event
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The Event Properties dialog box appears.

In this example, there is a parallel set of events, but each event is associated with its own 
action. In a combined event, there is a parallel set of events sharing the same action.

4. Using the drop‐down menu, choose RRDY (Reserved 0) as the second event to 
monitor.

5. Click OK to close the Event Properties dialog box.

6. In the Global Rules area, click the prompt to add an action to be triggered by the 
RRDY (Reserved 0).

Figure 4.28: Example 4: Entering Second Action

The Action Properties dialog box appears.

7. Use it to choose Inject RD Error as the action triggered by RRDY (Reserved 0).

8. Click OK to close the Action Properties dialog box.

Figure 4.29: Example 4: Complete Scenario
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9. In the File menu, select Save Scenario to save the scenario.

4.9.5 Example 5: Multiple Actions on a Single Event

In this example, an event triggers a set of actions. The actions occur at the same time. The 
device waits for an ACK from the initiator. When it occurs, the device beeps, injects an RD 
error, and increments a counter monitoring for that event (ACK from initiator).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, configure the first event and its response in the Global 
Rules area. Choose ACK primitive as the event and Beep as the action. From the 
Action Properties drop‐down menu, enter 500 ms as the duration of the beep.

3. Click the add another action prompt to add a second action.

Figure 4.30: Example 5: Entering the Second Action

The Action Properties dialog box appears.

4. Choose Inject RD Error as the second action.

5. Click the add another action prompt to add a third action.

6. The Action Properties dialog box appears.

7. Choose Monitor/Count as the third action.
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8. Click OK to close the Action Properties dialog box.

Figure 4.31: Example 5: Complete Scenario

9. In the File menu, select Save Scenario to save the scenario. 

This example sets the counter to increment at each occurrence of an ACK (every 1 ACK). 

4.9.6 Example 6: Using Timers

In this example, the Global Rules portion of the scenario waits for an ACK primitive from 
the initiator. Each time the device detects an ACK, it injects an RD Error into the traffic 
stream. This state continues for a random period of time, not to exceed 1.790 seconds. 
After the time period has elapsed (timer times out), the scenario stops.

Although this example sets the timer for a random period, you also can set the timer for 
known values (2 ms., 5 mins., 1 hr., and so on).

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, configure the first event and its response in the Global 
Rules area. Choose ACK primitive as the event and Inject RD Error as the action.
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3. Click the prompt to add another event (keep in mind this is not a combined event).

Figure 4.32: Example 6: Entering the Second Event

The Event Properties dialog box appears.

4. In the Type column on the left, choose Timer. Set the timer for random timing with a 
maximum time limit of 1.790 seconds.

5. Click OK to close the Event Properties dialog box.

6. Click the prompt to add an action to correspond with the second event.

Figure 4.33: Example 6: Entering Second Action

The Action Properties dialog box appears.

7. In the Type list on the left, choose Stop Scenario as the action that you want after 
the timer has expired.
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8. Click OK to close the Action Properties dialog box.

Figure 4.34: Example 6: Complete Scenario

9. In the File menu, select Save Scenario to save the scenario.

4.10 Creating a Sequence

This section gives several examples for creating sequences. Recall that a sequence can 
have multiple states, but only one state is active at any time. In other words, at any point 
in time, a sequence “waits” for one event (or combined event) and responds with the 
corresponding action or set of actions when the event occurs. 

A sequence is more powerful than Global Rules, because you can create branching or 
looping test logic with a sequence.You can include up to two sequences in a scenario, but 
each is completely independent of the other. There is no branching or other interaction 
between the two, except through the Restart All Sequences action.

You must follow some simple rules when creating sequences:

TABLE 4.5:  Sequence Rules
You can use only two branch actions per state.
When you specify actions for a state, you can only use two instances of Branch to an 
Existing State or Branch to a New State. If you try to use more than two, a red error 
message appears in the status area of the application that says “Too Many Actions.”

You can use only one restart sequence action per state.
When you specify actions for a state, you can only use one instance of Restart 
Current Sequence or Restart All Sequences. If you try to use more than one, a red 
error message appears in the status area of the application that says “Too Many 
Actions.”

You can use a maximum of 255 states per sequence.
If you try to use more than 255 states, a red error message appears in the status area 
of the application.
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The following table summarizes the examples that follow.

TABLE 4.6:  Sequence Examples

4.10.1 Example 7: Creating Two Sequences and Global Rules

In this example, Global Rules substitute an Align (0) primitive for each of the following 
received from the initiator: Align (1), Align (2), and Align (3). As a separate test operation, 
two sequences determine the order in which each Identify Address frame is received 
from initiator and target.

The following tables summarize the logic implemented by each of the sequences.

TABLE 4.7:  Example 7: Logic of Sequence 0

TABLE 4.8:  Example 7: Logic of Sequence 1

Example Description

7

Creating two sequences and Global Rules: This scenario has two 
objectives that you implement with Global Rules and two sequences. 1) 
You use Global Rules to replace any of three types of primitives. 2) You 
use two sequences to detect the order in which a type of frame is 
received from initiator and target.

8

Creating a sequence with many states #1: The objective of this scenario 
is to detect an incorrect order of primitives and to cause the device to 
beep when it happens. You implement this scenario with a single five‐
state sequence.

9

Creating a sequence with many states #2: This scenario is an 
enhancement of example 8. In this scenario, the objective is to detect an 
incorrect order of primitives, fix it, and cause the device to beep when 
this happens. As with example 8, you implement this scenario with a 
single five‐state sequence. 

State Description
State 0 If Address Frame is detected from initiator, go to State 1;

otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from target, beep 1 second.

State Description
State 0 If Address Frame is detected from target, go to State 1;

otherwise, continue to check incoming frames (do not change state).

State 1 If next Address Frame detected is from initiator, beep 2 seconds.
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There is no interaction between the two sequences. Each of them operates 
independently (and is independent of the Global Rules). However, the two sequences 
complement each other with their logic. In this sense, they both combine to implement a 
test objective.

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the Global Rules area.

3. Click the prompt to add a sequence. Prompts for the sequence appear beneath the 
Global Rules area. You create a sequence one state at a time. The application 
numbers states consecutively from 0 up (1, 2, 3, and so on).

Figure 4.35:  Example 7: Adding a Sequence

By default, the name of the first sequence in a scenario is Sequence 0. The name of the 
first state is State 0. To change the name of a sequence or state, or to associate a 
description with it, click the name of the sequence or state. A dialog box appears that 
allows you to enter that information.

Note:The description does not appear on screen, but you can bring it up by clicking the name of the 
sequence or state.

4. In the State 0 area, click the prompt to add an event.
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Figure 4.36:  Example 7: Adding an Event for the First State

The Event Properties dialog box appears.

5. In the Event Properties dialog box, select Address Frame as the event.

6. Click OK to close the Event Properties dialog box.
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7. In the State 0 area, click the prompt to add an action.

Figure 4.37: Example 7: Adding an Action for the First State

The Action Properties dialog box appears

8. For the action, select Branch to > New State.

9. Click the OK button to close the Action Properties dialog box. 

10. This saves the action and automatically creates an area for State 1 in the scenario. 

11. In the State 1 area, click the prompt to add an event. The Event Properties dialog 
box appears.

12. Choose the Address Frame event. In the Direction column, select From Target (you 
want State 1 to trigger on an Identify Address frame received from the target). 

13. Click OK to close the Event Properties dialog box.
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14. Click the prompt to add an action for State 1.

Figure 4.38: Example 7: Adding an Action to the Second State

The Action Properties dialog box appears. 

15. In this example, you enter the action Beep, and you set the duration of the beep for 
1 second.

16. Click OK to close the Action Properties dialog box.
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17. You are finished creating the first sequence. Click the add another sequence prompt 
to create an area in the scenario for the second sequence (Sequence 1).

Figure 4.39: Example 7: Adding a Second Sequence

18. Create two states in the second sequence with the characteristics shown in the 
following table.

TABLE 4.9:  Example 7: States for Second Sequence

State Event Action
0 Address Frame from Target Branch to State 1

1 Address Frame from Initiator Beep for 2 seconds.
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19. In the File menu, select Save Scenario to save the scenario.

Figure 4.40: Example 7: Sequence Area of Scenario

4.10.2 Example 8: Creating a Sequence With Many States #1

In this example, a five‐state sequence detects if a group of primitives is received 
out‐of‐order from the initiator. The expected order is: Align (0), Align (1), Align (2), Align 
(3). If this scenario detects any other order of these primitives, it causes the device to 
beep and the scenario to restart.
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 275



Teledyne LeCroy Creating a Sequence
This example is designed to give you an idea of the powerful logic that you can 
implement with sequences.

Note that the states in this sequence have been renamed (do not have their default 
names). The following table summarizes the sequence logic.

TABLE 4.10:  Example 8: Logic of Sequence 0

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the five states for this sequence.

State Description
Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2);
otherwise, go to Indicate Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3);
otherwise, go to Indicate Error.

Wait for Align (3) If an Align (3) is received next, restart test;
otherwise go to Indicate Error.

Indicate Error Indicate error and restart test.
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3. In the File menu, select Save Scenario to save the scenario.

Figure 4.41: Example 8: Top Half of Scenario
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Figure 4.42: Example 8: Bottom Half of Scenario

4.10.3 Example 9: Creating a Sequence With Many States #2

In this example, a five‐state sequence not only detects if a group of primitives is received 
out‐of‐order, but it fixes any incorrect order. The logic is similar to that of example 8 with 
a few small changes. The following table summarizes each state.
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TABLE 4.11:  Example 9: Logic of Sequence 0

1. Click the New Scenario button in the main library or one of the device libraries. In 
the Scenario Properties dialog, enter the scenario name, description, and direction 
of traffic change.

2. As in previous examples, create the five states for this sequence.

State Description
Wait for Align (0) When an Align (0) is received, go to Wait for Align (1).

Wait for Align (1) If an Align (1) is received next, go to Wait for Align (2);
otherwise, replace primitive with Align (1) and go to Indicate 
Error.

Wait for Align (2) If an Align (2) is received next, go to Wait for Align (3);
otherwise, replace primitive with Align (2) and go to Indicate 
Error.

Wait for Align (3) If an Align (3) is received next, restart test;
otherwise, replace primitive with Align (3) and go to Indicate 
Error.

Indicate Error Indicate error and restart test.
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3. In the File menu, select Save Scenario to save the scenario.

Figure 4.43: Example 9: Top Half of Scenario
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Figure 4.44: Example 9: Bottom Half of Scenario

4.11 Running Scenarios

If you use a general library as a scenario archive, then the process of executing a scenario 
is as follows:

1. Select the scenario to run by clicking it. 

2. To run the scenario, click the Run Scenario button on the Device Library toolbar 
(second button from the right). The InFusion device then begins its session.

4.12 Scenario Batch Files

You can write a script with commands to run a sequence of executable scenarios 
automatically. A Scenario Batch file is a text file with a list of commands to run in 
sequence when you execute the file. A batch script can manage scenarios and their 
assigned ports and hardware in sequence, using conditions. The system checks for 
accuracy of inputs and commands.
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Note:Before you run a Scenario Batch file that requests scenarios, you must download the scenarios 
to the Scenarios box.

To start a batch script, click the New Batch Script   button or select 
File > New Batch Script.

4.12.1 Script Workspace

In the Script Workspace, add a command and make a batch file.

Figure 4.45: Script Workspace

In this dialog, you can enter a script command by clicking Click here to add 
script command.

3. First, click Click here to add script command to open the Command Properties 
dialog (see Figure 4.46 on page 283).
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Figure 4.46: Command Parameters Dialog

The Command Parameters Dialog contains the list of available commands and their 
parameters from which to build scenarios and connected hardware and available ports.

4. Select appropriate parameters for the command and click OK to display the script in 
the Script Workspace.

Note:You can select ports from the port list, depending on number of ports licensed.

Note:The hardware Serial Number can already exist or not. If the Serial Number exists, the Serial 
Number (for example, S/N: 12871) is shown. In Offline and Simulation mode, you can enter a 
Serial Number. In Online mode, you can only enter an existing Serial Number.
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5. To add another command, click Click here to add another script command.

To copy a script command, right‐click on the command and select Copy. 
Right‐click Click here to add another script command and then select Paste. 

You can also cut, delete, and edit a selected script command.

6. To edit batch commands, click the command, or right‐click the command and select 
Edit from popup menu.

7. To delete a command, right‐click and select Delete from popup menu, or select 
command and press Delete key on keyboard.

After finishing, if everything is correct, push the Run Batch button to execute scenario 
and save result in the log file.

Note:Before you run a Scenario Batch file that requests scenarios, you must download the scenarios 
to the Scenarios box.
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4.12.2 Error Checking

The Script Workspace shows errors by red color. The program reports all errors in the log 
file. 

If you use a script from other InFusion hardware, it may cause an error, for example, 
mismatch in hardware Mac addresses, or scenarios that are not already in current 
hardware.

4.12.3 Log

Results of executable batch commands are saved automatically into a log file with user‐
specified name. The status of executable commands is shown in log area.

4.12.4 Statements

Statements can be conditional statements or non‐conditional statements.

IfIsStopped

Shows whether a scenario is already stopped or not.

Format
   IfIsStopped (Serial Number, Target Port)

Parameters
 Serial Number: Serial number of hardware
 Target Port: Port number in port map

Example
IfIsStopped(ox01267, 1) Then

{
Beep (750, 300)
Run (ox01267," Detect AddressFrame Open", 5)
}

The value of second parameter is 5 and shows check stopping mode of combination of 
port number 1 and port number 3. 

After filling parameters from the Command Parameters Dialog, the program makes the IF‐
ELSE structure in the Script workspace. The ELSE statement is optional. To add an ELSE 
body, click Click here to add else body.
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Goto Label

Goes to specified label. Labels can be assigned to each script line. 

Format
Goto Label3

Parameters
none

Example
Label3: WaitForStop(0x83456, 2, 100))
Run (ox01267," Inject CRC000", 4)
Goto Label7

Note:You can use a Label and a Goto Label to make loops. First make the label, then make Goto Label. 
The Command Parameters window shows only enabled Labels. Labels are disabled by default 
and are in gray color. To enable them, click them to make purple color.
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Run

Runs the scenario on hardware on specified ports. If you call this command for the first 
time and the scenario was not assigned to the hardware and ports before, the scenario is 
assigned to specified hardware and ports and then scenario runs on the hardware.

Format
Run(Serial Number, Scenario Name, Target Port)

Parameters
 Serial Number: Serial number of hardware
 Scenario Name: Name of scenario
 Target Port: Port number in port map

Example
Run (ox841200," Substitute address frame", 4)
Beep(800, 400)
Run (ox841200," CRC Inject _ Play CD", 8)
WaitForStop(0x63463, 1, 150)
Run (ox841200," Remove Send Cue Sheet", 2)
Goto Label6
Run (S/N: 12871, Port 1, DISCOVER)

Note: If the selected ports are busy, scenario cannot run, and the command will be skipped. The result 
will be written in Log area.

Stop

Stops running scenario by hardware and port name.
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Format
Stop (Serial Number, Target Port)

Parameters
 Serial Number: Serial number of hardware
 Target Port: Port number in port map

Example
Run (ox00820,"Inject CRC000", 2)
Beep(700, 500)
Stop (ox00820, 2) 
Goto Label3
...
Label3 : Run(ox005007,"Detect DATA", 8)
Sleep(40)

WaitForStop

Used to wait for occurrence of specified condition.

Format
WaitForStop(SerialNumber, Target Port, Duration)

Parameters
 Serial Number: Serial number of hardware
 Target Port: Port number in port map
 Duration: Integer or random duration in milliseconds. In the Command Parame‐

ters Window, WaitForStop duration has three options:
 Infinite: Wait until Stop command.
 Random: Stop after a random time.
 Finite time: Stop after specified time in milliseconds.

Example
Run (ox001267,"Detect AddressFrame Open", 2)
WaitForStop (0x348790, 2, Forever) 
Run (ox005007,"Detect DATA", 4)
WaitForStop(ox005007, 4, 100)
Stop (ox001267, 2
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Sleep

Used to sleep for a few seconds.

Format
Sleep(Duration)

Parameters
 Duration: Integer or random duration in milliseconds

Example
Sleep(100)

Beep

If specified condition is satisfied, the system beep for specified duration.

Format
Beep (Duration, Frequency)

Parameters
 Duration: Integer or random duration in milliseconds
 Frequency: Frequency in hertz

Example
IfIsStopped(0x83456, 4)) then

{
  Beep (2, 20)
  Run (0x83456,"Identify_Disparity error", 8)

}
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Chapter 5

Sierra Trainer Traffic Generation
The Sierra Trainer is a traffic generator that can emulate a SAS initiator/target or 
SATA host/device. Traffic generation enables engineers to test designs under realistic 
conditions and to transmit known errors, allowing engineers to observe how devices 
handle faulty link conditions. 

Traffic generation is performed via the execution of text‐based scripts. These traffic 
generation files (*.ssg) contain statements about the types of traffic to be generated. 
These script files can be edited with either a simple text editor such as Notepad or with 
the Script Editor utility provided by the application. 

To open the Traffic Generation window, click the Launch Trainer Icon   in the 
SAS/SATA Protocol Suite window:

Figure 5.1: SAS: Sierra Trainer Window

SATA: Replaces the SAS icon with the SATA icon for Show Analyzer Frame.

Note:Trainer has Power On and Power Off commands to control External Power Expansion Card.
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5.1 Sierra Trainer Menus

The Sierra Trainer menus are: 

5.1.1 File Menu

New GenFile: Starts a new Generation File.

Open: Opens a file.

Close: Closes the current window.

Launch Analyzer: Displays Analyzer Window.

Launch Analyzer: Displays Jammer (Infusion) Window.

Save As: Saves the current file with a new name.

Print: Prints part or all of the current traffic data file.

Print Preview: Produces an on‐screen preview before printing.

Print Setup: Sets the options for the current or new printer.

Edit Comment: Allows you to enter a comment in a dialog.

Export: Saves trace as text file in Packet View Format.

Convert: Converts an SATrainer Generation File (.stg file) to a Generation File (.ssg file).

Figure 5.2: Trainer File Menu
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5.1.2 Setup Menu

 Update Sierra Device: See “Update Device” on page 221.
 Port Configuration:

You can select different combinations of Trainer with Analyzer and Jammer. When 
running two different applications on the ports, you must set the same port 
configuration in both of them. See “Ports Configuration” on page 98. The following 
describes possible configurations:

 Analyzer and Trainer on same port: You can generate initiator/target traffic 
and also capture the traffic generated.

 Analyzer and Trainer on same port, and Analyzer and Trainer on another 
port: You can generate initiator/target traffic and also capture the traffic gen‐
erated on two ports.

 Trainer on one port, Analyzer on another port, and Analyzer on a third port: 
Trainer is run on a port generating initiator/target traffic and two port Ana‐
lyzers run on two other ports capturing the traffic of those ports.

 Trainer on two ports, and Analyzer on two ports: Two Trainers run on two 
ports generating initiator/target traffic and two Analyzers run on two other 
ports capturing the traffic of those ports.

 Trainer and Jammer on same port: You can generate initiator/target traffic 
and also inject errors on the traffic between initiator and target on the port.

Note:See “Multi‐Port Trainer Script Assignments to Links” on page 310.

Display Options: Selects what information to display. See “Display Options” on page 378.

Figure 5.3: Trainer Setup Menu

5.1.3 Generate Menu

Start Generation: Causes the Generator to begin generation.

Stop Generation: Causes the Generator to stop generation.

Resume Generation: Causes the Generator to resume generation after a stop.

Connect Link: Automatically bring the linkup to the Host, Device, Initiator, or Target 
connected to the Trainer.

Disconnect Link: Disconnect link.

Connect Parameters: Set the “Identify” frame parameter settings to keep the link
connected. See “Connection Parameters” on page 383.
 Sierra M124 SAS/SATA Protocol Analyzer User Manual 293



Teledyne LeCroy Sierra Trainer Menus
294 Sierra M124 SAS/SATA Protocol Analyzer User Manual

Generation Options: Setup the Generation Rules. See “Auto Speed Negotiation” on page 
365.

Figure 5.4: Trainer Generate Menu

5.1.4 Search Menu

Go to Event: Opens a dialog that allows you to go to a frame and time.

Figure 5.5: Go to Event Dialog

Go to Marker: Positions the display to the selected marked packet.

Go to: Packet Types, SSP Frames, SMP Frames, Primitives, Errors, Data Lengths, Speed, 
SATA FIS Type, SATA FIS Port, or Hash Address (Source or Destination). See Figure 5.6 on 
page 295.

Find: Displays the Find dialog. See “Find” on page 374.

Find Next: Applies the previous Find parameters to the next search.

Search Direction: Toggles the search forward or backwards. The current direction is 
indicated in the menu.
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Figure 5.6: Trainer Search Menu

5.1.5 View Menu

See Figure 5.7.

Zoom In: Increases the size of the displayed elements.

Zoom Out: Decreases the size of the displayed elements.

Toolbars: Displays list of available toolbars: Standard, Frequently Used, Generator, 
Analyzer, Ports, or Customize. See “Resetting the Toolbar” on page 384.

Status Bar: Toggles the Sierra Trainer Status Bar, at the bottom of the window, which 
shows help messages and the search direction. The right most segment displays the 
current search direction: Fwd (forward) or Bwd (backward). Change the search direction 
from the Search menu or double‐click the Search Status segment.

Wrap: Wraps displayed packets within the window.

Compact: Displays each row on one line only, with no wrapping.

Figure 5.7: Trainer View Menu
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5.1.6 Tools Menu

Hash Address Utility: Opens a dialog that allows you to enter an eight‐byte SAS Address 
to display a Hashed Address.

Figure 5.8: Address Hash Utility Dialog

5.1.7 Window Menu

Cascade: Displays all open windows in an overlapping arrangement.

Tile Horizontal: Displays all open windows in a above‐below arrangement.

Tile Vertical: Displays all open windows in a side‐by‐side arrangement.

Arrange Icons: Arranges minimized windows at the bottom of the display.

Windows: Displays a list of open windows.

5.1.8 Help Menu

Help Topics: Displays online help. You can also select F1.

Check for Updates: Check whether a new software version is available. If so, you can 
download from the Teledyne LeCroy web site. You can select to Check for updates at 
application startup.

About: Displays version information.

5.2 Sierra Trainer Main Toolbar

The Sierra Trainer toolbar contains the following buttons:

Figure 5.9: Sierra Trainer Toolbar

The buttons have the following functions:

Open Document.

Save As. Opens a dialog in 
which you can save your edits 
in the appropriate file type.

Edit as Text. Edit the text file for 
the document.

Setup Display Options. Opens 
the Display Options window.
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5.3 Setting Up for Generating Initiator Traffic

Connect the SAS cable from the Target port of the Sierra Analyzer to the Target port on 
the unit under test. This transmits the Traffic Generator stream from the Target port to 
the target‐side port on the unit under test.

5.4 Setting Up for Generating Target Traffic

Connect the SAS cable from the Initiator port of the Sierra Analyzer to the 
Initiator‐side port on the unit under test. This transmits the Traffic Generator stream from 
the Initiator port to the initiator‐side port on the unit under test.

5.5 Creating a Traffic Generation File

Generating traffic is a two‐step process. 

Zoom In. Zoom Out.

Wrap. Find.

Find Next. Start All Generation.

Stop All Generation. Resume All Generation.

Connect All Link. Disconnect All Link.

Setup Generation Options. 
Opens the Generation Options 
window.

Launch Jammer (Infusion).

Launch Analyzer. Start Recording.

Stop Recording. Abort Recording.

Show Port Configuration Dialog.
(See “Ports Configuration” on 
page 98.)

Show Script Assignment 
Dialog.
(See section below.)

Tile Windows

                  Assign Active Script/
                  Remove Assigned
                  Script for 
                     Link 1, 2, 3, or 4

See “Multi‐Port Trainer Script 
Assignments to Links” on page 
310.
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First, create a text‐based Sierra Trainer Traffic Generator file. This text file has an .ssg 
extension. You can create this file by creating a new generator file or editing an existing 
file. 

Note: .ssg files created in other applications run in the Sierra Trainer.

After the file has been created, it can be opened and displayed in the application. You can 
invoke the application to transmit the traffic generation file by using the Start Generation 

button  . 

Note:For details about traffic generation files, see “Sierra Trainer Generation Language” on page 312.

5.5.1 Creating a New Generator File

You can create a new Sierra Trainer Traffic Generator .ssg file.

To create an .ssg file: 

1. In the Sierra Trainer window, select File > New GenFile to display the Global Settings 
of a new .ssg file in a trace view.

Figure 5.10: New GenFile
298 Sierra M124 SAS/SATA Protocol Analyzer User Manual



Creating a Traffic Generation File Teledyne LeCroy
2. Click the Edit as Text   button to enter Generation Block or Change Settings 
instructions in the Generation Script Editor. See “Starting the Script Editor” on page 
306.

5.5.2 Editing an Example Generation File

The easiest way to generate traffic is to start with one of the example generation files and 
edit the settings to see how the script file behaves. As you make and save changes, the 
trace view of the generation file is automatically updated. 

The following screenshots show an example file as it appears in the script editor and trace 
window.
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In the screenshot, global settings make up the eight bars at the top of the window. Below 
that are five frames. If you look at the script itself, there are six frame commands, five 
active and one commented out.

The following sections describe how to open and edit traffic generation files.

5.5.3 Converting a SATrainer Traffic Generation File

If you have old 2500‐based SATrainer Generator .stg files, you can convert them to Sierra 
Trainer Traffic Generator .ssg files using the legacy Convert function.

To convert an .stg file into an .ssg file: 

1. In the Sierra Trainer window, select File > Convert > Convert .stg to .ssg to display 
an Open dialog. 

2. Use Files of Type SATrainer Generator Files (.stg).

3. Select an SATrainer Generator *.stg file.

4. Click Open. The application creates a Sierra Trainer Traffic Generator file (*.ssg). 

5.5.4 Opening a Traffic Generation File

After the Traffic Generator file (*.ssg) file has been created, you can open it in the 
application.

To open a Traffic Generator file:

1. Select File > Open on the Menu Bar, or click   on the Toolbar, to display an Open 
dialog. 

2. Select a Generator text file (*.ssg) and click Open to display the file (see Figure 5.11 
on page 301). (The install directory contains example files.)
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Figure 5.11: Sierra Trainer Generator File

5.5.5 Layout

The .ssg file has several colored bars that represent global settings. The bars show the 
current configuration of the generation file. Example settings are:

 Configuration
 GenMode (SAS or SATA, SSC On or Off)
 Link speed (1.5 Gbps, 3.0 Gbps, 6.0 Gbps or 12.0 Gbps)
 Type of device (Initiator or Device)
 COMINIT
 COMWAKE
 Scrambling Mode

As changes are made and saved to the traffic generation file, the bars immediately 
update. The traffic pattern to generate appears below the bars as a series of frames. You 
can edit the traffic generation file to add, edit or remove frames.

5.6 Overview of Generation and Global Settings Files

Example .ssg files and Include files are in two directories called \Samples and \Include 
that are typically installed in: C:\Users\Public\Documents\LeCroy\SAS SATA Protocol 
Suite\Generation\Samples.
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5.6.1 Traffic Generation (*.ssg) Files

The .ssg traffic generation files are text files consisting of include statements, a 
generation block, and optionally global statements.

The generation block is the code responsible for the actual traffic generation. It is marked 
by the tag Generation. The composition and format of the generation block is described 
later.

The include statements provide links to the Include files, which provide the definitions 
for primitives, frames, and settings that hold for most or all of the generation session 
(global settings). 

The definitions for SAS and SATA traffic are contained in Teledyne LeCroy‐provided 
Include files: Settings.inc, PrimitivesDecl.inc, AddressFramesDecl.inc, SSPFrames.inc, 
SMPFrames.inc, and SSPFrames.inc.

5.6.2 Settings.inc File

The Settings.inc file contains global statements about the link, the type of device being 
emulated, and other conditions that are to exist throughout part or all of the traffic 
generation. This file must be included in the traffic generation file.

There are fifteen groups of settings in this file: 

 AutoMode
 COMINIT/COMRESET OOB Signal
 COMWAKE OOB Signal
 COMSAS OOB Signal
 Generation Commands
 Link Speed
 SATA Link Initialization
 SAS Speed Negotiation
 SATA Speed Negotiation
 Autowait:

 SAS After
 SAS Before
 SATA After
 SATA Before

 Wait Command Timeout
 Scrambling Mode
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Details about each group of settings are described in the Traffic Generation Language 
section.

Editing Settings.inc

Text in the Settings.inc file can be edited directly or copied into the beginning of the 
traffic generation file and edited there.

When editing global settings, keep in mind the following rule: The last line encountered 
before the generation block takes precedence. Thus, if the following two lines about the 
device emulation were added just above the generation block, the second would take 
effect:

set GenerationMode = GEN_MODE_SATA_HOST

set GenerationMode = GEN_MODE_SAS_INITIATOR 

The Global Setting “AutoAlign”

AutoAlign is a global setting that may be on or off depending on the type of device you 
are emulating. There is an AutoAlign setting for SAS and one for SATA, for example, “set 
AutoAlignSAS = ON” and “set AutoAlignSATA=OFF.”

 SAS: Sends AutoAligns every 2048 DWORDs.
 SATA: Sends AutoAligns every 256 DWORDs.

If you plan to set and reset AutoAlign in the middle of traffic generation, you need to 
know what the defaults are for AutoAlign. The defaults are as follows:

For SATA host/device emulation,:

 AutoAlignSATA is assumed to be ON.
 AutoAlignSAS is assumed to be OFF.
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For SAS emulation, the assumptions are opposite:

 AutoAlignSATA is assumed to be OFF.
 AutoAlignSAS is assumed to be ON.

For STP:

 AutoAlignSAS and AutoAlignSATA are assumed to be ON.

Placing Global Settings in the Generation Block

Some global settings such as AutoAlign = On/Off can be set and reset in the generation 
block. For example, you might want to set SASAutoAlign = ON prior to traffic generation, 
and then change to OFF halfway through the generation session.

When placed within the generation block and then viewed in the trace window, global 
settings appear as colored bars interspersed amidst the traffic.
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While most global settings can be set in the generation block, three will be ignored if 
placed within the generation block:
set Link Speed =
set GenerationMode =
set SSC = 

These commands should be configured either in the Setting.inc file or at the beginning of 
the traffic generation file as a global statement.

5.7 Primitive and Frame Definitions

Five other Include files are provided that define the most of the known templates for 
Primitives and Frames. The five are: 

 PrimitivesDecl.inc
 AddressFramesDecl.inc
 SSPFramesDecl.inc
 SMPFramesDecl.inc
 STPFramesDecl.inc

Each of the Frame templates defines header and field structure. 

The default value for all Frame fields is zero.

5.7.1 Special Conditions for Frames

There are three conditions about Frames that need to be kept in mind when configuring 
Frame generation:

1. Frame delimiters need to agree ‐ At the present time, when defining a Frame, make 
sure that the Frame Prologue and Frame Epilogue agree. Do not mix types. For example, 
do not mix a SAS Start of Frame (SOF) with a SAS End of Address Frame (EOAF). 

A SAS SOF should be matched to a SAS EOF. A SAS SOAF should be matched to a SAS EOAF. 
If generating SATA traffic, a SATA_SOF should be matched to a SATA_EOF.

At the present time, if you mix different types of prologues and epilogues for any given 
Frame, the Frame is ignored. 

2.   Data Length Fields can be fixed‐length or variable ‐ By default, data frames are of a 
fixed length. If you want to generate variable length frames, place an asterisk in the Data 
definition field in the SSPFramesDecl.inc file: 
Data : *

If you replace the asterisk with a value, then the field becomes fixed length.
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3. CRC Calculations are calculated unless told otherwise ‐ If the CRC is not explicitly set 
in the traffic generation file, the application assumes that you want it and calculates and 
displays it in front of the generated frames.

If you provide a CRC value, the application uses that value, even if it is incorrect. This 
gives you the option of configuring the generator to create errors.

If the generation file was created through the Export command (File > Export > To 
Generator File Format ...), the CRC is calculated but commented out. If the source trace 
has a bad CRC, the CRC is exported into the generation file and is not commented out.

5.7.2 Primitives Decl.inc File

The PrimitivesDecl.inc file defines Primitives. The file consists of declarations (left) and 
the corresponding byte streams (right).

 

To generate Primitives, copy relevant portions of text on the left (not the bytes shown 
right) from this file into the generator block section of the .ssg file. 

5.7.3 Address FramesDecl.inc File

The AddressFramesDecl.inc file defines Address frames.

5.7.4 SSPFrames.inc File

The SSPFrames.inc file defines SSP frames.

5.7.5 SMPFrames.inc File

The SMPFrames.inc file defines SMP frames.

5.7.6 STPFrames.inc File

The STPFrames.inc file defines STP frames.

5.8 Starting the Script Editor

To edit an .ssg file, use the Script Editor. The Script Edit editing tool displays the .ssg file 
and its supporting Include files. The Script Editor utility has several aids to simplify the 
process of writing and editing scripts: tool‐tips, drop‐down menus, and colored fields. 
The Script Editor example below shows several commented lines followed by some 
instructions. The Script Editor has three areas: toolbar (top), script window, and file tabs 
(at the bottom of the window). If errors occur, a log opens at the bottom of the window. 
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Note: If more than one port of Trainer is licensed, you can assign scripts to one or more 
ports. See “Multi‐Port Trainer Script Assignments to Links” on page 310.

To launch the Script Editor, click the Script Editor   button on the toolbar or 
right‐click in the trace window and choose Edit as Text.

Figure 5.12: Script Editor

5.8.1 Script Editor Toolbar

The Script Editor toolbar contains buttons for saving your edits, navigating, searching, and 
other functions. 

Figure 5.13: Script Editor Toolbar
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The buttons have the following functions:

View Options Menu

The View Options button displays a menu with the following options:

 Enable Outlining: Adds an expandable/collapsible tree structure to the left side 
of the Script Editor showing the hierarchical relationships of the script lines.

 Show Line Numbers: Adds line numbers to the left side of the Script Editor win‐
dow.

 Toggle Outlining: Switches between collapsed and expanded states.

Save. Saves your edits and 
immediately updates the 
setting bars and Frames shown 
in the trace window.

Add/Remove bookmark. 
Allows markers to be set or 
removed to aid in navigation.

View Options. Opens a menu 
with three options: Enable 
Outlining, Toggle Outlining, 
and Show Line Numbers. 
See View Options Menu 
below.

Go to next bookmark.

Cut. Go to previous bookmark.

Copy. Clear all bookmarks.

Paste. Find.

Undo. Find and Replace.

Redo. Go to Trace View

Print.
Go to Definition of 
Selected Keyword.

Open File under Cursor. Opens 
the file pointed to with the 
mouse in the script. This 
command works with Include 
statements.
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Pop-up Menu

Left‐click anywhere in the script window to open a pop‐up menu with the following 
options:

 Display Options: Selects what information to display. See “Display Options” on 
page 378.

 Edit as Text: Opens the Script Editor.
 Zoom In: Increases the size of the displayed elements
 Zoom Out: Decreases the size of the displayed elements
 Wrap: Wraps displayed packets within the window.
 Compact: Displays each row on one line only, with no wrapping

File Tabs

At the bottom of the window is a tab that shows the name of the .ssg file. If your .ssg file 
has an Include statement in it, the supporting Include files automatically open when the 
.ssg file is first opened. Tabs for the opened Include files appear at the bottom of this 
window.

Figure 5.14: File Tab

Error Log

Whenever you create a scripting error, a log opens at the bottom of the application 
window. When the error is corrected, the window automatically closes.

Figure 5.15: Log

Tooltips

The Script Editor window includes extensive tooltips for each keyword. To see a tooltip, 
hold the mouse pointer over a keyword. 
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5.9 Multi-Port Trainer Script Assignments to Links

If more than one port of Trainer is licensed, after you open a generator file (.ssg) or create 
a new generator file (“Creating a Traffic Generation File” on page 297), you can assign the 
script to one or more ports.

Click the  Port Configuration button to open the Set Port Configuration dialog 
(see “Ports Configuration” on page 98). Select a port configuration. For example, Trainer 
may be on Port1 and Port 2 or Port3 and Port4.

After you select port configuration, the Assign Active Script/Remove Assigned Script for 
Link 1, 2, 3, or 4 buttons have colors. For example, for Trainer on Ports 1 and 2, the 

buttons are  .

After you open or create a script in the Trainer window, click the L1 or L2 button to assign 
the script to Port 1 or Port 2. A display appears to the left of the script in the Trainer 
window:

That link now has link‐specific Start, Stop, Resume, Connect, and Disconnect buttons. 
(See the previous page for the button descriptions.) 
Use the link‐specific buttons to control each link separately.

You can click the L1 or L2 button again to remove the script from the link.

After you select port configuration, the Trainer toolbar changes to display the Generation 
buttons Start All Generation, Stop All Generation, Resume All Generation, 
Connect All Link, and Disconnect All Link:

Use these buttons to control all links. 

You can click  to open the Link Script Selection script assignment dialog (see the 
following two figures).
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For any available Link, you can select any open script from the Script drop‐down list.

After you select an open script, you can assign or remove a link for that script by clicking 
Assign Active Script/Remove Assigned Script for Link.

5.10 Generating Traffic

After the .ssg file has been opened onscreen, recording and traffic generation can begin 
at any time. 

1. (optional) Click   to begin the recording.

2. If the script does not have a connect block built into it, connect the exerciser to the 

DUT by clicking the Connect Link button  . Clicking this button causes the 
generator to invoke the various settings in your script (for example, the global 
settings) and then establish a connection.
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3. Click the Start Generation button   on the Toolbar. 

While generating traffic, a bar appears on the right of the trace view, indicating that 
traffic generation is taking place. (The green light on the Traffic signal button also blinks 
during traffic generation).

5.10.1 Stop Traffic Generation

Normally, traffic generation stops automatically when the application reaches the end of 
the Generator file. 

To manually stop traffic generation, click the Stop Generation button  .

5.10.2 Resume Traffic Generation

If traffic generation is stopped prior to the end of the script, it can be resumed. 

To resume traffic generation, click the Resume Generation button  .

5.11 Sierra Trainer Generation Language

The Sierra Trainer File Generation Language is an API that allows you to separate traffic 
into text commands. These commands are used construct primitives and frames that are 
sent to the host or the device. 

5.11.1 File Structure

Traffic Generation files (*.ssg) should have the following structure:

Declarations

 Global generation settings
 Constants
 Data patterns
 Chain of symbols (primitives, raw data)
 Packet templates

Note:Some declared objects could be used in further declarations as long as they are previously 
declared. No forward declarations are allowed at this time.

Generation Blocks

 List of generation instructions

Note: It is possible to create many generation blocks, but currently only a block with the name 
'Generation' executes. (Calls of some blocks from another blocks are not currently allowed.)
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5.11.2 Language

Comments

#' is the Comment symbol. The line remainder after this symbol is ignored.

/*' '*/' is a Comment Block. All the text between '/' '*' and '*' '/' is ignored.

/*
    This is an example of a block of comments.
*/

Includes

The directive %include “FileName.inc” includes the file FileName.inc. This lets you add 
common definitions and templates into new scripts.

The language parser makes sure the same file is not included more than once.

Example:

%include “SomeInc.inc” 
# This directive actually includes file 'SomeInc_1.inc'.

%inline is the same as %include, but without the Language parser check.

Settings

The Set "Constant Name" = Value statement sets different constants/modes using the 
following value types:

 Predefined constants (TRUE, FALSE, ON, OFF, INFINITE)
 Numbers

Examples:

Set AutoAlignSATA=ON
Set WaitTimeOut=239

Constants

Only unsigned integers can be defined as constants. Some constants are predefined in 
Sierra Trainer.

Examples:

Const SOME_HEX_DATA = 0xAABBFFEE #defines hexadecimal constant
Const SOME_DEC_DATA = 12     # defines decimal constant
Const "SOME DEC DATA" = 64     # defines decimal constant
Const "Some Hex Data" = 0xCDCDBEBE

Predefined Constants
 TRUE
 FALSE
 ON
 OFF
 INFINITE
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Data Patterns

Data patterns are streams of hexadecimal values. Using '['']' lets the user include 
constants or predefined data pattern in another pattern. 

Examples:

DataPattern PATTERN_1 = AAAABBBB [SOME_HEX_DATA] EEEEFFFF   1210ABB1 
AAAABBBB 1210ABB1 AAAABBBB 1210ABB1 AAAABBBB 1210ABB1 ["SOME DEC 
DATA"] 1210AB
DataPattern PATTERN_2 = 00000000 11111111 22222222 33333333 AAAABBBB 
55556666 FEFEFEFE CDCDCDCD 9999BBBB 12343434 6767676B 56BBFF                  
DataPattern PATTERN_3 = [PATTERN_1] FFFFFFFF EEEEEEEE [SOME_HEX_DATA]
DataPattern SOME_PATTERN = BBBBBBBB DDDDDDDD

Primitives

Primitives can be defined using the following:

 Byte values ('k' indicates control symbol). The 10b codes are calculated based on 
the current running disparity

 Primitives are completely interchangeable with SymChains.

Declaring Raw Data Definitions

Primitive primitive_name  = byte_data  …   byte_data  # (byte_data is Decimal, Hex, 10b, 
K type or D type format)

SynChain raw_data_name = byte_data  …   byte_data  # (byte_data is Decimal, Hex, 10b, 
K type or D type format)

RawData { param_data  …   param_data }  #(param_data is byte_data, primitive or 
variables)

Example:

Primitive "CHAIN (ONE)"  = kBC 1E 1E 1E kBC 1A 0F
SymChain ChainTwo = k28.5 D12.3 D10.2 D11.6
SymChain ChainThree = k28.3 3EA 25 k18 IFA
Primitive SOF = kBC 18 E4 67 
Primitive EOF = kBC 18 F0 9B
SymChain raw_data_1 = K28.1 D23.3 D11.4 D14.6
SymChain raw_data_2 = 345 160 023 K15.3 K28.1 D23.3 D11.4 D14.6 # some 
RD errors will occur
raw_data_1 ( 1000 ) # send defined above pattern raw_data_1 1000 times
raw_data_2 (  10 )  # send defined above pattern raw_data_2   10 times
raw_data_2 ( 195 )  # send defined above pattern raw_data_2  195 times

RawData { 217 2E1 351 362 }# send RawData pattern - some RD errors 
will occur
RawData { K28.1 D23.3 D11.4 D14.6 }    # send RawData pattern
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# RawData with variables embedded

RawData { 

K28.5 D24.0 D30.0 D01.4 

@variableName1 

50 00 62 B0 

00 00 00 30 

50 08 05 EF 

$C 

00 00 00 01 

00 00 00 00 

SendCRC 

K28.5 D24.0 D07.3 D31.4 }

}

When there are variable values in RawData, you must include SendCRC command instead 
of last dword. Otherwise, wrong CRC value will be sent.  The constraints are: 

  Variables are not allowed on First and LAST DWORD (instead of start/end 
frames). 

 SendCRC is only supported on last DWORD before end of frame.

Sending OpenAddressFrame Using 
Standard Frame Templates

Sending the Same 
OpenAddressFrame Using Raw Data 
Mechanism

 SendOpenAddressFrameSTP    {

SourceAddress      = { 500805EF FFFF0041 }

DestinationAddress = { 500062B0 00000030 
}

        ArbitrationWaitTime = 0x1

        AccessZoneManagement= 0x0

        SourceZoneGroup     = 0x0

        ConnectionRate      = 0x8

        Features            = 0x0

        InitiatorConnectionTag = 0x1

        InitiatorPort       = 0x0

        MoreCompatibleFeatures = 0x0

        PathwayBlockedCount = 0x0

      # CRC = 0x050F19E0  # good crc    }

Set ScramblingMode = 
SCRAMBLING_MODE_SAS    

RawData {

 K28.5  D24.0  D30.0  D01.4

   21       08        00        01

   50       00        62        B0

   00       00        00        30

   50       08        05        EF

    FF       FF        00        41

    00      00        00        01

    00      00        00        00

    05      0F        19         E0

 K28.5  D24.0  D07.3  D31.4 }

* CRC is inserted manually
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 Raw 10 bits codes. This definition might cause running disparity errors.

Example:

Primitive "CHAIN (TWO)" = 305 2D4 1E4 362
 Mixed bytes and 10b codes. This definition might cause running disparity errors.

Example:

Primitive "CHAIN (TWO)" = 305 2D4 1E4 362 ["CHAIN (ONE)"]

Packets/ Frames

Using the “Frame” or “Packet” keyword, you can define a frame of traffic to use in the 
generation stream. Declarations of prolog and epilog may be mixed with field 
declarations. 

Frame "name" : "parent name"
{
Field Definition 0: "Field Name : Field Length = Default Value" 
…
Field Definition n: "Field Name : Field Length = Default Value"
Primitive Definition 0: "Primitive name, offset, count"
…
Primitive Definition m: "Primitive name, offset, count"
Prolog = "primitive name"
Epilog = "primitive name"
}

Field Definition

 Field length is in bits. '*' means that the length is variable and is set based on the 
assigned value.

 Field starting offset is calculated from frame start based on the length of the pre‐
vious fields.

Examples:

Field32     : 32 = 0xAABBFFEE
FrameType   : 8  = 12
HashedDest  : 24 = HEX_DATA
Reserved1   : 8  = 0xDA
Field16     : 16 = 0xAAAA
Reserved2   : 8  = 0xAD
CRC         : 32

Data field Definition

• Data = { pattern }: Pattern is assigned to Data.

• Data = count, value: A pattern of “count” times “value” is assigned to Data.

• Data = count, start value, step: A pattern of values starting with “start value” with steps of “step” 
and a length of “count” is assigned to Data.
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Primitive definition. Primitives are inserted into the frame payload. Primitive definitions 
are inherited by descended frame templates.

 Assigning '*' clears all previous settings (maybe from parent frame template). 
 Offset specifies the DWORD offset where this primitive is inserted in the Frame.
 Count specifies how many times to repeat the primitive.

Examples:

Primitive : *
Primitive : SOF, 48   # where 48 = offset
Primitive : "CLOSE (NORMAL)", 36, 5   # where 5 = repeat

Prolog and Epilog define Primitive chains to be used at the beginning and end of the 
frame.

Examples:

Prolog = SOF # For this frame primitive 'SOF' is a Prolog.
Epilog = EOF # For this frame primitive 'EOF' is an Epilog.

Frames can be derived from other Frames, therefore inheriting the layout of the parent 
Frame. In this case, the user may:

 Change Prolog and Epilog.
 Change default field values.
 Add new fields.

Frame Examples

Frame  Some_Frame
{ 
    Field32     : 32 = 0xAABBFFEE
    FrameType   : 8  = 12
    HashedDest  : 24 = HEX_DATA
    Reserved1   : 8  = 0xDA
    Field16     : 16 = 0xAAAA
    Reserved2   : 8  = 0xAD
    Data        :  * = PATTERN_1
    CRC         : 32

    Primitive : *
    Primitive : SOF, 48
    Primitive : SOF, 96
    Primitive : "CLOSE (NORMAL)", 36, 5

    Prolog = SOF
    Epilog = EOF
}
Frame Some_Frame_1 : Some_Frame
{
    Field32 = "Some Hex Data"
    Data    = { 11111111 22222222 33333333 44444444 55555555 }
    Opcode    : 128, 8, 0x2A
    LBA       : 64
    
    Primitive : *
    Primitive : "CLOSE (NORMAL)", 24, 48 
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    Prolog = "CHAIN (ONE)"
    Epilog = "CHAIN (ONE)"
}

5.11.3 Generation Block

Sierra Trainer generates the stream that is defined in this block. 

Generation
{
Chain Definition (Repeat = N, Idle = M)
Chain Definition (N, M)
Chain Definition
Frame Definition
Frame Definition (RunningDisp = ON/OFF)
Frame Definition
{
Field Definition
Data Definition
} (Repeat = N, Idle = M, RunningDisp = ON/OFF)

5.11.4 Definitions

Chain Definition:

 Without any parameters, the chain is sent once.
 With “Repeat” and “Idle” parameters, the chain is sent N times and then noth‐

ing is sent (idle) M times. “Repeat” and “Idle” are optional.

Frame Definition

 Without any parameters, send the frame based in default values.
 With “RunningDisp” ON, send the frames based on default values and insert a 

running disparity error.
 With parameters overriding or adding to a template frame, with or without 

injection of an overriding or adding to a template frame, with or without injec‐
tion of running disparity error.

Field Variable Declarations

You can declare a variable (var_name) as a frame of type (frame_type):

$var_name = frame_type

Note:Frame variables can be declared/re‐declared and used many times.

Changing Frame Fields

You can change some fields in a frame variable.

Change var_name { field_name = value }
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Preprocessor Integer Arithmetic

You can declare DWORD variables, make arithmetic operations, and use them in field and 
parameters assignments.

Note:Arithmetic expressions are allowed only in numeric variable assignments.

Examples:

Legal Operations

x = 2
y = ( z = 12 ) + ( SOME_DEC_DATA + 36 ) / 8
z = 0x1 << 5     
s = "Some Hex Data" # constant may be used in operations

x++
y--
z += ( x + y )
x = ( ( y & 0xFF ) >> 5 ) / 12

SOF ( Repeat = x, Idle = y )     

X
{
Field16 =  0xEEEE   # Example of the data payload assignment which 
uses both integer variables, constants, hex literals and data patterns                                                       
Data    =  { y y y y 7a7a7a7a "Some Hex Data" "Some Hex Data" 8b8b8b8b 
z z z z [PATTERN_3] }
}
( Repeat = 10, Idle = y )  # uses integer variable for parameter/
setting.

Illegal operations

x = y + 2
SOF ( Repeat = (x+y)*7 )  
# - illegal, use z = (x+y)*7  SOF ( Repeat = z ) instead

Loops

Loops can be used in two modes:

1. Using an integer number, loop a specified number of loops. This number has to be 
smaller than 64,000.

2. Using the word “infinite”, loops for ever.

Loops ( loop_count/Infinite )
{
 send instructions
 assignments
 change values
 send instructions
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}        

Example:

LOOP( 50 )
{
        "CHAIN (ONE)"
        "CHAIN (TWO)"
        Some_Frame
        $Y = Some_Frame { Data = 256, 0xFEFEFEFE }
        Y
        Change Y { Field32 = x } 
        Y
        Y
} 

5.11.5 Connecting the Trainer

Three methods are available for connecting the trainer: 

 Use the Connect command to connect and perform transmitter training. 
 Use the new commands to handle the transmitter training manually (see Man‐

ual Transmitter Training Commands and Descriptions below). 
 Use the Send_Train_TX_Window command to send transmitter training auto‐

matically and use other commands for speed negotiation.

The SATA scripts should be run in SAS mode.

Manual Transmitter Training Commands and Descriptions

Send_TTIU (32'b DATA/Variable, Idle count, Repeat number) 

This instruction is mainly for sending a specific TTIU with variable number of Idles. 32 bit 
TTIU value can be specified either by directly specifying the 32 bit data or by specifying a 
variable. When the variable name is recognized, the trainer reads the data in the 
specified variable and considers it as the TTIU value. The Idle count defines the number 
of idles to be transmitted after the 32 bit TTIU and the repeat number defines the 
number of times the same TTIU is to be transmitted.

Example:

Var32 @ttiu =0x00006000
Generation {
Send_ttiu (0x00006000, 0x36, 0xA)    //ttiu with specific data
Send_ttiu (@ttiu, 0x36, 0xA)         //TTIU with variable
}

Wait_For_TTIU(DATA/Change TTIU  ,  MASK

This instruction waits for a specific TTIU. During the execution of this instruction, the 
previously transmitted TTIU is transmitted. The user can trigger a wait for a specific TTIU 
or change the TTIU, or a part of TTIU, by specifying the 32 bit mask value.

The default mask value is set to all ones. The application waits for all 32 bits to match the 
received TTIU. Changing the mask value provides the flexibility to wait for some specific 
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bits in the TTIU. Giving the Change_TTIU command with mask value waits for any change 
in the specified Bits in the Received TTIU compared to the previously received TTIU.

Example:
Generation
{
Wait_for_ttiu  (change_ttiu , 0x00004000) //waiting for change in tx_init 

bit of TTIU
Send_ttiu ((0x00006000, 0x36, 0xA)
Wait_for_ttiu (0x0000A000 , 0X00008000)  //waiting for train comp bit to 

go high
}

LRT: Last received TTIU

This instruction is for accessing the last received TTIU. The user can access the received 
TTIU and reuse it as required. 

Example:

{

@ttiu_mask=0x0006000
@ttiu=LRT
@ttiu_temp=@ttiu and @ttiu_mask
If(ttiu_temp=0006000)
{
Send_ttiu(0x0006000)
}

}

Training_ERROR_COUNT

This instruction is for accessing the error count of the received Dwords. This gives 
flexibility to the user to change the remote tx parameters to get the optimal link with 
minimal errors.

Example:
Var32 @error_count
Generation
{
Send_ttiu ((0x00006000, 0x36, 0xA)
Wait_ttiu (change_ttiu , 0x00004000) 
@error_count= Training_ERROR_COUNT;
If(@error_count<2)
{
Send_ttiu ((0x0000A000, 0x36, 0xA)

 }
}

Reset_Training_ERROR_COUNT

During manual Tx_Training resetting error _count can be done using this command.
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Example: 

Var32 @error_count
Generation
{
Send_ttiu ((0x00006000, 0x36, 0xA)
Wait_ttiu (change_ttiu , 0x00004000) 
@error_count= Training_ERROR_COUNT;
If(@error_count<2)
{
Send_ttiu ((0x0000A000, 0x36, 0xA)
Rest_Training_Error_count
 }
}

Change_Local_tx_parameter(16'b data/variable)

This instruction is to change the Local tx parameters. It takes either 16 bit data or 16 bit 
variable which represents the control word of the TTIU. When this command is given, the 
32 bit data or 16 bit variable value is written to the constant variable memory location 
(address location is 511)

Example:
 
var32 @received_control
var32 @Status
var32 @ control=0x00100000
var32 @temp
Generation
{
 Send_ttiu ((0x00006000, 0x36, 0xA)
 Wait_ttiu (change_ttiu , 0x00004000) 
 Change_Local_tx_parameter (0x0400)  //requesting to change the tx 

parameters to reference_1
@received_control=LRT
@temp=@received_control & 0x1111000 //0x11110000 is the mask data so that 

the variable contains only the 
control word of the received ttiu.                                      

Change_Local_tx_parameter(@temp)//variable as input

@status= Local_ Tx_status_word
@temp=@status | @control
Send_ttiu(@temp,0x36,0xA)
}

Where “0x0400” is the control word of TTIU.
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Local_ Tx_status_word

This instruction is for getting the status of the local tx parameters for the previous 
requested tx parameter change. This is a 32 bit word in which the LSB 16‐bit contains the 
status word and MSB 16 bits are ZEROS.

Set OOB_SpeedNeg_TX_TAT:Tx_training_analysis_time

 This setting defines the time for Link analysis i.e., the time for counting errors in the 
received dwords. At the end of this period, the trainer requests for new attached tx_phy 
change depending on the error count in Auto Tx_training mode. This is a global setting.

SendRAWTTIU(Pattern_marker  32bits of BMC encoded TTIU)

This command is for transmitting a Raw_TTIU. i.e BMC encoded 32 bits TTIU can be 
specified here. The user has the flexibility to specify the pattern marker.

Example:

Generation
{
Send_raw_ttiu( ffffc0000 FF C00F FC00 FF C00F FC00 FF C00F FC00 FF C00F 
FC00 FF C1F0 7C00 FF C00F FC00 FF C00F FC00 FF C00F FC00}
Idle(54)
}

Where “ffffc0000” is the pattern marker.

Send_TTIU/SendTTIU (32'b DATA/Variable, Idle count, Repeat number)

This instruction is mainly for sending a specific TTIU with variable number of idles .32 bit 
TTIU value can be specified either by directly specifying the 32 bit data or by specifying a 
variable.(when the variable name is given trainer reads the data in the specific variable 
and considers it as TTIU value).Idle count defines the number of idles to be transmitted 
after the 32 bit TTIU and repeat number defines the number of times the same TTIU to be 
transmitted.

Example:

Var32 @ttiu =0x00006000

Generation {

Send_ttiu (0x00006000, 0x36, 0xA)       //ttiu with specific data

Send_ttiu (@ttiu, 0x36, 0xA)                   //TTIU with variable

}

Wait_For_TTIU/WaitforTTIU(DATA/Change TTIU ,  MASK)
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This instruction waits for specific TTIU. During this instruction previous transmitted TTIU 
will be transmitted. User can trigger wait for specific TTIU, Change in TTIU or part of TTIU 
by specifying 32'bit mask value.

Default mask value is set to all ones. i.e waits for all 32'bits to match with the received 
TTIU. Changing the mask value gives the flexibility to wait for some specific bits in the 
TTIU. Giving Change_TTIU with mask value waits for any change in the specified Bits in 
the Received TTIU compared to the previous received ttiu.

Example:

Generation

{

Wait_for_ttiu  (change_ttiu , 0x00004000)            //waiting for change in tx_init bit of TTIU

Send_ttiu ((0x00006000, 0x36, 0xA)

Wait_for_ttiu (0x0000A000 , 0X00008000)        //waiting for train comp bit to go high

}

LRT: Last received TTIU:

 This instruction is for having access to the last received TTIU. User can have access to the 
received ttiu and reuse it as required. Example for using this command in the script is as 
follows:

{

@ttiu_mask=0x0006000

@ttiu=LRT

@ttiu_temp=@ttiu and @ttiu_mask

If(ttiu_temp=0006000)

{

Send_ttiu(0x0006000)

}

}
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Training_ERROR_COUNT

This instruction is for having access to the error count of the received Dwords. This will 
give flexibility to user to decide on changing remote tx parameters to get the optimal link 
with minimal errors.

Example:

Var32 @error_count

Generation

{

        Send_ttiu ((0x00006000, 0x36, 0xA)

       Wait_ttiu (change_ttiu , 0x00004000) 

       @error_count= Training_ERROR_COUNT;

      If(@error_count<2)

     {

        Send_ttiu ((0x0000A000, 0x36, 0xA)

     }

}

Reset_Training_ERROR_COUNT / ResetTrainingErrorCount

During manual tx_trainig resetting error _count can be done using this command.

Ex: Var32 @error_count

Generation

{

        Send_ttiu ((0x00006000, 0x36, 0xA)

       Wait_ttiu (change_ttiu , 0x00004000) 

       @error_count= Training_ERROR_COUNT;

      If(@error_count<2)

     {

        Send_ttiu ((0x0000A000, 0x36, 0xA)

      Rest_Training_Error_count

     }

}
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Change_Local_tx_parameter / changelocaltxparameter (16'b data/variable)

This instruction is to change the Local tx parameters. It takes either 16 bit data which 
represents the control word of the TTIU or 16'b variable that represents control word of 
the TTIU. 

when this command is given ,32 bit data or variable value will be written in to a constant 
variable memory location (address location is 511)

Example:

 var32 @received_control

var32 @Status

var32 @ control=0x00100000

var32 @temp

Generation

{

        Send_ttiu ((0x00006000, 0x36, 0xA)

      Wait_ttiu (change_ttiu , 0x00004000) 

 Change_Local_tx_parameter (0x0400)  //requesting to change the tx parameters to     
reference_1

              @received_control=LRT

        @temp=@received_control & 0x1111000 //0x11110000 is the mask data so that the 
variable contains only the control                                                        word of the received ttiu.

       Change_Local_tx_parameter(@temp)//variable as input

      @status= Local_ Tx_status_word

      @temp=@status | @control

      Send_ttiu(@temp,0x36,0xA)

}

Local_ Tx_status_word

This instruction is for getting the status of the local tx parameters for the previous 
requested tx parameter change. This is a 32 bit word in which LSB 16‐bit contains status 
word and MSB 16bits are ZEROS.

Set OOB_SpeedNeg_TX_TAT:Tx_training_analysis_time

This setting defines the time for Link analysis i.e time for counting errors in the received 
dwords after this time trainer request for new  attached tx_ph y change depending on 
the error count in Auto Tx_training mode . This is a global setting.
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Send_RAW_TTIU / SendRawTTIU(Pattern_marker  320bits of BMC encoded TTIU ,IDLE 
count, Repeat count)

This command is for transmitting a Raw_ttiu. i.e BMC encoded 320 bits ttiu can be 
specified here.User is given a flexibility to specify the pattern marker.

Generation

{

     sendrawttiu(3ff 3ff 000 000                 

                 3ff 000 3ff 000

                 3ff 000 3ff 000

                 3ff 000 3ff 000

                 3ff 000 3ff 000

                 3e0 3ff 01f 000

                 3ff 000 3ff 000 

                 3ff 000 3ff 000

                 3ff 000 3ff 000

                ,0x3a ,0x10 )            

   }

For TRAINING_ERROR_COUNT, Change_local_tx_parameter, Tx_status_word   

commands hardware creates separate variables with pre defined address. When user 
specifies this command, software should compile the commands in to variable 
commands with specific pre defined variable address

Other Tx‐training related Commands

1. LINK_SPEED_12G : Sets speed to 12G.

2. Set OOB_SpeedNeg_Phy_g4 WithoutSSC : Sets the G4 without SSC bit of phy 
capability window. 

3. Set OOB_SpeedNeg_Phy_g4 WithSSC : Sets the G4 with SSC bit of phy capability 
window.

4. SEND_TRAIN_TX_WINDOW : Starts sending tx training window.

5. Set OOB_SpeedNeg_MTTT  : Sets the maximum tx training time for Tx‐
training window.          
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Set Auto_TxUpdate:

This setting is for manual Tx training. When Auto_TxUpdate is set to true, the Local tx 
parameters will be updated automatically depending on the received control word and as 
result the  Tx_status_word is updated accordingly. When set to FALSE, Tx parameters is 
controlled by the script.

TRAINING_ERROR_COUNT, Change_local_tx_parameter, Tx_status_word   

This command instructs the hardware to create separate variables with pre‐defined 
addresses. When the user specifies this command, the software compiles the commands 
into variable commands with specific pre‐defined variable addresses.

5.11.6 Trainer Script Enhancements

The Trainer script language can already produce SAS/SATA Primitive Sequences and 
Frames.

The Trainer script enhancements described in this section allow generation of Commands 
and Application Layer sequences (as in the Exerciser), by processing received frames, 
making complex decisions, and generating the contents of frame in run‐time, for both RX 
and TX. Variables can keep the run‐time state of the bus. Low‐level commands can 
manipulate variables and use variables to create patterns.

Trainer language can perform SATA compliance tests with fast SSD devices and provide a 
SSD performance test tool with limited output data patterns. Trainer has sequential/
random LBA command generation and full NCQ support.

Trainer can be programmed to act as SAS Initiator, SAS Target, SATA Host, or SATA Device.

SAS Initiator

As an Initiator, Trainer can send commands in all protocols (SSP/STP/SMP) and interact 
with its peer to complete the command in normal conditions and some popular error 
conditions. Limitations are:

 Uses only one command at a time.
 Does not save Read data or reuse bulk read data for next commands.
 Sends only limited Write data patterns.
 Has tight flow control, due to limited RX frame processing.

SAS Target

As a Target, Trainer can receive commands in all protocols (SSP/STP/SMP) and respond to 
them in normal conditions or some popular error conditions. Limitations are:

 Uses only one command at a time. Command queuing is not supported.
 Does not save incoming write data. Sends back data for all LBAs or generates 

counter/random data. Cannot be used as a real formatted partition.
 Has tight flow control, due to limited RX frame processing.
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SATA Host

As a Host, Trainer can send commands and complete them in normal or some popular 
error conditions. SATA Host can issue NCQ commands, necessary for SATA compliance 
tests on SSD devices. Limitations are:

 Does not save Read data or reuse bulk read data for next commands.
 Sends only limited Write data patterns.

SATA Device

As a Device, Trainer can receive commands and respond to them in normal or some 
popular error conditions. Limitations are:

 Uses only one command at a time. Command queuing is not supported.
 Does not save incoming write data. Sends back data for all LBAs or generates 

counter/random data. Cannot be used as a real formatted partition. To use the 
Trainer as a SATA Device in real configurations, only tools like IO‐METER (that can 
work with un‐partitioned and un‐formatted drives) can be used. 

Variable Definition

Variable definition is like definitions in programming languages. You can define up to 512 
DWORD (32‐bit) variables. There is no constraint on variable names, except you cannot 
use keywords. Variable scopes are general and you should define them in the script 
header before the generation block.

The syntax of variable definition is:

VAR32 @VariableName1, @VariableName2, ...
VAR64 @VariableName

VAR64 holds field values greater than 32 bits, such as SASAddress. 

Note:Variable names should start with @.

Assigning Variable Values

You can set variable values in different ways:

Constant value:

@varName1 = 1234

Other variable value: 

@varName1 = @varName2

Result of expression on other variables:

@varName1 = @varName1 + @varName2

Fields of last received frame: 

@varName1 = (SSPFrame)LRF::FrameType,

where LRF is Last Received Frame
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Note:Specifying packet type (SSPFrame) before LRF causes last received frame to be this packet type, 
and field start‐bit position is calculated according to the packet‐type definition.

Part of last received frame: 

@varName1 = LRF[stratBitOffset:endBitOffset],
where offsets are bit based

Example:   

SendSSPFrameCommand_Initiator 
    {Data = LRF[startBitOffset:endBitOffset] )
Tag = 0x101}

The constraints are 1) Length bigger than 64 bit is not supported and 2) Offsets 
(StartBitOffset and EndBitOffset) should be in same DWORD, except for length bigger 
than 32.

Random values: 

@varName1 = Random

Expression on Variables

Mathematical expressions, such as sum, subtract, and shift:

@varName1 + @varName2
@varName1 - @ varName2
@varName1 & @varName2
@varName1 | @varName2
@varName1  <<  2

Logical expressions, such as compare, equal, not, and, and or:

@varName1  >  @varName2
@varName1 < @ varName2
@varName1 ==  @varName2
@varName1 != @ varName2
 (logical expression1) &&  (logical expression2)
(logical expression1) || (logical expression2)

Complex expressions (combination of different operators) with prioritizing supported:

(@varName1 + @varName2) > @varName3

If/While in Logical Expressions

Like programming languages, scripts allow conditional statements. 
The if/while syntaxes are:

If (expression)then
{
        ….
}
else
{
       ….
}
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While(@VarName)
{
     …….
}

Example for if, then else:      

@HT_RxFISType = LRF[0:7] 
#LRF_SATA_FIS_TYPE_START_BIT:LRF_SATA_FIS_TYPE_END_BIT
if  (@HT_RxFISType == SATA_FIS_TYPE_DMA_ACTIVATE)   then  {…}
 else { if (@HT_RxFISType == SATA_FIS_TYPE_DATA) then  {…}
             else { if (@HT_RxFISType == SATA_FIS_TYPE_RD2H)  then  {…} 
} } 

Example for while: 
while (@NCQ_Temp0)   {

@NCQ_Temp1= @NCQ_Temp1 >> 1
If (@NCQ_Temp1 != 0) then { … }
@NCQ_Temp0 = @NCQ_Temp1 & 0x00000001     }

Note: In this release, while condition is limited to simple variable values only. Combining operators is 
not allowed in while expressions. You should move such expressions inside while block. 

Note:Nested while and if are supported.

Wait/When/Do in Logical Expressions

The wait/when/do syntaxes are:

wait (time)
{when
{exp}do
{

….
}
elsewhen
{
{exp}do
{

….
}
on_timeout
{

….
}}

Example:        

wait  { #no timeout use global WaitTimeout value default 1000 useconds 
(1 ms) 
    when  {WF_OPEN_ACCEPT}   do   { … }
    elsewhen  {WF_OPEN_REJECT}   do   { … }
    on_timeout  { … }     }
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Example:        

wait_for (100000)  { WF_OPEN_ACCEPT  WF_TIMEOUT}  { … } # (100 ms) 

Note:Nested wait should not exceed 2 deep. Use a procedure call to extend wait logic sequence. Wait 
+ Wait_For ok.

Using Variable Values in Creating Patterns on Bus

In creating patterns to send on bus, trainer script allows using variables. In these cases, 
because the created pattern is dynamic, it is not possible to do scrambling and calculating 
in software code. These tasks are done in the hardware engine. To activate, set “Auto 
scramble mode” in “on” state.

The following examples show uses of variables in creating patterns.

Use variable for field value:

SendOpenAddressFrameSSP
{
InitiatorPort = 0x1
    InitiatorConnectionTag = @variableName1
…...
}

The constraints are: 

 Field Length bigger than 64 bit is not supported.
 Field StartBitOffset and EndBitOffset should be in same DWORD, except for 

length bigger than 32.

Use LRF directly for field value:

SendSSPFrameCommand_Initiator
{
    Data = LRF[startBitOffset:endBitOffset]
    Tag  = 0x101
}

The constraints are: 

 Length bigger than 64 bit is not supported.
 Offsets (StartBitOffset and EndBitOffset) should be in same DWORD, except for 

length bigger than 32.

SendSSPFrameCommand
 {
#Data = {00112233 @variableName1 @variableName2 44556677}
 }

RawData {
 K28.5  D24.0  D30.0  D01.4
              @variableName1
              50     00     62     B0
              00     00     00     30
              50     08     05     EF
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              $C
              00     00     00     01
              00     00     00     00
              SendCRC
              K28.5  D24.0  D07.3  D31.4 }
}

When there are variable values in RawData, you must include SendCRC command instead 
of last DWORD. Otherwise, wrong CRC value will be sent.

The constraints are: 

 Variables are not allowed on First and LAST DWORD (instead of start/end 
frames).

 SendCRC is only supported on last DWORD before end of frame.

SendSATAFrame
{
  SATA_SOF
  SATA_DATA ( 0x11223344 )
  SATA_DATA (@variableName1)
  SATA_DATA ( 0x55667788 )
  #SATA_CRC ( 0x99AACCBB ) # good crc - can be changed to bad
  SATA_EOF
}

If SATA_CRC command is not included, trainer engine computes and inserts correct CRC in 
pattern.

Timer

Trainer script syntax allows using some timers. You can start a timer anywhere. The timer 
current value is loadable on variable to be used in expressions and conditions on this 
expression. There are four timers, named A, B, C, and D.

Starting timer (setting timer value to zero) syntax is: 

CLEAR_TIMER_A
CLEAR_TIMER_B
CLEAR_TIMER_C
CLEAR_TIMER_D

Loading timer current value in variables:

@varName1 =TIMER_A
@varName1 =TIMER_B
@varName1 =TIMER_C
@varName1 =TIMER_D

       Example:  

   CLEAR_TIMER_A

   While(@Counter < MaxPeriodCount) {

      … @Counter = TIMER_A … }
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PATTERN Counter
Trainer script syntax allows you to use counters on a number of defined events in generation settings. 

Syntax for loading counters in variables is:

@varName1 = COUNT_REC_RESOURCE_OUTPUT_A
@varName1 = COUNT_REC_RESOURCE_OUTPUT_B
@varName1 = COUNT_REC_RESOURCE_OUTPUT_C
@varName1 = COUNT_REC_RESOURCE_OUTPUT_D
@varName1 = COUNT_REC_RESOURCE_OUTPUT_E
@varName1 = COUNT_REC_RESOURCE_OUTPUT_F

Syntax for clearing (resetting) counters is:

CLEAR_REC_RESOURCE_OUTPUT_A
CLEAR_REC_RESOURCE_OUTPUT_B
CLEAR_REC_RESOURCE_OUTPUT_C
CLEAR_REC_RESOURCE_OUTPUT_D
CLEAR_REC_RESOURCE_OUTPUT_E
CLEAR_REC_RESOURCE_OUTPUT_F

Example:  

CLEAR_REC_RESOURCE_OUTPUT_A
While(@Counter < MaxPrimitiveCount) {

… @Counter = COUNT_REC_RESOURCE_OUTPUT_A … }

Procedure Definition

Procedures allow creating simple syntaxes for complex reusable parts in scripts. You can 
write such code once as a procedure and use everywhere required.

Procedure definition syntax is:

procedure procedureName
{
...
}

Calling procedure syntax is:

Call procedureName
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5.11.7 Sierra Trainer Generation Commands

General Commands
IDLE (n) Generator will insert n idle DWORDs into the 

generation stream.

CLEAR_CREDIT_AVAIL This commands clears the credit established 
with the command WF_CREDIT_AVAIL. (See 
WF_CREDIT_AVAIL in following section on Wait 
Commands for explanation). 

RD_ERROR Generator will insert one idle DWORD into the 
generation stream, which will intentionally 
break RD sequence creating RD error.

CONNECT Generator will go through connection sequence 
using current GenFile settings (gen mode, 
speed, and so on). Generation will not resume 
until connection is established.

DISCONNECT Generator will break existing connection to DUT.

PAUSE Generator will come to a break and the user will 
be able to resume generation by pressing 
Resume button on Generation toolbar. 
Generator shall transmit idle DWORDs while in 
the Pause. 

OUTPUT_ON Takes the Trainer out of Electric Idle state. If it is 
already out of Electric Idle, this is a NOP. 

OOB Commands

COMINIT Generator will send COMINIT OOB signals using 
current COMINIT settings. 

COMRESET Generator will send COMRESET OOB signals 
using current COMRESET settings. 

COMWAKE Generator will send COMWAKE OOB signals 
using current COMWAKE settings. 

COMSAS Generator will send COMSAS OOB signals using 
current COMSAS settings. 

SATA_ALIGN Generator will go through SATA_ALIGN stage of 
SATA SpeedNeg process using current 
SATA_ALIGN settings. 

SATA_D10_2 Generator will go through SATA_D10_2 stage of 
SATA SpeedNeg process using current 
SATA_D10_2 settings. 

SPEED_NEG_RCDT Generator will go through SPEED_NEG_RCDT 
stage of SAS SpeedNeg process using current 
SPEED_NEG_RCDT settings. 

SPEED_NEG_ALIGN0 Generator will go through SPEED_NEG_ALIGN0 
stage of SAS SpeedNeg process using current 
SPEED_NEG_ALIGN0 settings. 
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SPEED_NEG_ALIGN1 Generator will go through SPEED_NEG_ALIGN1 
stage of SAS SpeedNeg process using current 
SPEED_NEG_ALIGN1 settings.

Set Speed = LINK_SPEED_1_5G Generator will change speed to 1.5G (if 
MultiSpeed is enabled). 
This setting is not applied when 
Advanced Connect is set.

Set Speed = LINK_SPEED_3G Generator will change speed to 3G (if 
MultiSpeed is enabled).
This settings is not applied when 
Advanced Connect is set.

Set Speed = LINK_SPEED_6G Generator will change speed to 6G (if 
MultiSpeed is enabled).
This setting is not applied when 
Advanced Connect is set.

Set Speed = LINK_SPEED_12G Generator will change speed to 12G (if 
MultiSpeed is enabled).
This setting is not applied when 
Advanced Connect is set.

DevSlp Makes the device sleep signal high. Trainer 
doesn’t go to Electric idle mode automatically 
after Devslp command. We can force trainer to 
go to DC Idle mode using the “disconnect “ 
command after Devslp command. This 
command works when Generation mode is 
GEN_MODE_SAS_INITIATOR or 
GEN_MODE_SATA_HOST

Exit_DevSlp Makes Device sleep signal low (comes out of 
device sleep mode). This command works when 
Generation mode is GEN_MODE_SAS_INITIATOR 
or GEN_MODE_SATA_HOST

SEND_TRAIN_RX_WINDOW   (This Command is used in Train Windows). This 
command works exactly same as 
"Send_Train_TrainDone."

SEND_TRAIN_TX_WINDOW

xxxxxx

(This Command is used in Train Windows).

Send_Phy_Capability Generator will send PHY Capability Bits.
(this command is used in SNW3).

Send_Train_TrainDone Generator will send Train/Train Done Patterns.
(This Command is used in Train Windows).

Delay (#) Generator will wait until # ns before executing 
next command.
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Power_Expansion_On(n)

Power_Expansion_Off(n)

Switch on power expansion card. The Default 
value is POWER_SOURCE_5V | 
POWER_SOURCE_12V. The power source can be 
combination of POWER_SOURCE_1_2V, 
POWER_SOURCE_1_5V, POWER_SOURCE_3_3V, 
POWER_SOURCE_5V, POWER_SOURCE_12V

Switch off power expansion card. The Default 
value is POWER_SOURCE_5V | 
POWER_SOURCE_12V.The power source can be 
combination of POWER_SOURCE_1_2V , 
POWER_SOURCE_1_5V , 
POWER_SOURCE_3_3V, POWER_SOURCE_5V, 
POWER_SOURCE_12V

Exit (ExitCode) Call this command in any branch of the Trainer 
program to stop execution. After exit, the 
Port Status dialog displays the exit code.

Note: The Trainer GUI has LED 
indicators:
Green is for pass.
Red is for fail.
No color is for unknown or for 
user to review.

set_trainer_interconnect_signal_1 or 
settrainerinterconnectsignal_1

Set these signals to allow other ports to wait on 
them using 
WF_TRAINER_INTERCONNECT_SIGNAL_1

set_trainer_interconnect_signal_2 or 
settrainerinterconnectsignal_2

Set these signals to allow other ports to wait on 
them using 
WF_TRAINER_INTERCONNECT_SIGNAL_2

set_trainer_interconnect_signal_3 or 
settrainerinterconnectsignal_3

Set these signals to allow other ports to wait on 
them using 
WF_TRAINER_INTERCONNECT_SIGNAL_3

set_trainer_interconnect_signal_4 or 
settrainerinterconnectsignal_4

Set these signals to allow other ports to wait on 
them using 
WF_TRAINER_INTERCONNECT_SIGNAL_4

SET_EXTERNAL_TRIGGER  Call this command to set External Trigger Out 
Settings and External Trigger In Type to High 
Active, Low Active, Toggle and set External 
TrigOut pulse width.

SET_ANALYZER_TRIGGER  Call this command to set Analyzer Trigger.
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Set 
OOB_SpeedNeg_TX_TAT:Tx_training_an
alysis_time

 This setting defines the time for Link analysis 
i.e., the time for counting errors in the received 
dwords. At the end of this period, the trainer 
requests for new attached tx_phy change 
depending on the error count in Auto 
Tx_training mode. This is a global setting.

Set Auto_TxUpdate This setting is for manual Tx training. When 
Auto_TxUpdate is set to true, Local tx 
parameters will be updated automatically 
depending on the received Control word and 
Tx_status_word will be updated accordingly. 
When set to FALSE,Tx parameters has to be 
controlled by script.

Send_TTIU (32 bit DATA/Variable, Idle 
count, Repeat number) 

This instruction is mainly for sending a specific 
TTIU with variable number of Idles. 32 bit TTIU 
value can be specified either by directly 
specifying the 32 bit data or by specifying a 
variable. When the variable name is recognized, 
the trainer reads the data in the specified 
variable and considers it as the TTIU value. The 
Idle count defines the number of idles to be 
transmitted after the 32 bit TTIU and the repeat 
number defines the number of times the same 
TTIU is to be transmitted.

Example:
Var32 @ttiu =0x00006000

Generation {

Send_ttiu (0x00006000, 0x36, 0xA)    //
ttiu with specific data

Send_ttiu (@ttiu, 0x36, 0xA)         //
TTIU with variable

}
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LRT: Last received TTIU This instruction is for accessing the last received 
TTIU. The user can access the received TTIU and 
reuse it as required. 

Example:
{

@ttiu_mask=0x0006000

@ttiu=LRT

@ttiu_temp=@ttiu and @ttiu_mask

If(ttiu_temp=0006000)

{

Send_ttiu(0x0006000)

}

}

Training_ERROR_COUNT This instruction is for accessing the error count 
of the received Dwords. This gives flexibility to 
the user to change the remote tx parameters to 
get the optimal link with minimal errors.

Example:

Var32 @error_count

Generation

{

Send_ttiu ((0x00006000, 0x36, 0xA)

Wait_ttiu (change_ttiu , 0x00004000) 

@error_count= Training_ERROR_COUNT;

If(@error_count<2)

{

Send_ttiu ((0x0000A000, 0x36, 0xA)

 }

}
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Reset_Training_ERROR_COUNT During manual Tx_Training resetting error 
_count can be done using this command.

Example: 
Var32 @error_count

Generation

{

Send_ttiu ((0x00006000, 0x36, 0xA)

Wait_ttiu (change_ttiu , 0x00004000) 

@error_count= Training_ERROR_COUNT;

If(@error_count<2)

{

Send_ttiu ((0x0000A000, 0x36, 0xA)

Rest_Training_Error_count

 }

}

340 Sierra M124 SAS/SATA Protocol Analyzer User Manual



Sierra Trainer Generation Language Teledyne LeCroy
Change_Local_tx_parameter (16 bit 
data/variable)

This instruction is to change the Local tx 
parameters. It takes either 16 bit data or 16 bit 
variable which represents the control word of 
the TTIU. When this command is given, the 32 
bit data or 16 bit variable value is written to the 
constant variable memory location (address 
location is 511)

Example:
var32 @received_control

var32 @Status

var32 @ control=0x00100000

var32 @temp

Generation

{

 Send_ttiu ((0x00006000, 0x36, 0xA)

 Wait_ttiu (change_ttiu , 0x00004000) 

 Change_Local_tx_parameter (0x0400)  //
requesting to change the 
tx parameters to 
reference_1

@received_control=LRT

@temp=@received_control & 0x1111000 //
0x11110000 is the mask 
data so that the 
variable contains only 
the control word of the 
received ttiu.                                      

Change_Local_tx_parameter(@temp)//
variable as input

@status= Local_ Tx_status_word

@temp=@status | @control

Send_ttiu(@temp,0x36,0xA)

}

Where “0x0400” is the control word of TTIU.

Local_ Tx_status_word This instruction is for getting the status of the 
local tx parameters for the previous requested tx 
parameter change. This is a 32 bit word in which 
the LSB 16‐bit contains the status word and MSB 
16 bits are ZEROS.
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SATA Commands

Look at STP sample file for syntax.

 SEND_SATA_FRAME
 SendSATAFrame
 SATAData
 SATA_Data
 SATACRC
 SATA_CRC
 SATAXXXX
 SATA_XXXX

Primitive Commands

The following is a list of SAS and SATA primitives declared in Primitives.Decl.inc as Symbol 
Chains. If you want to use these primitives in your script, you must also include 
Primitives.Decl.inc in your script.

 SOF
 EOF
 SOAF
 EOAF
 ALIGN (0) 

Send_RAW_TTIU(Pattern_marker 32 
bits of BMC encoded TTIU)

This command is for transmitting a Raw_TTIU. 
i.e BMC encoded 32 bits TTIU can be specified 
here. The user has the flexibility to specify the 
pattern marker.

Example:
Generation

{

Send_raw_ttiu( ffffc0000 FF C00F FC00 
FF C00F FC00 FF C00F 
FC00 FF C00F FC00 FF 
C1F0 7C00 FF C00F FC00 
FF C00F FC00 FF C00F 
FC00}

Idle(54)

}

Where “ffffc0000” is the pattern marker.

TRAINING_ERROR_COUNT, 
Change_local_tx_parameter, 
Tx_status_word   

This command instructs the hardware to create 
separate variables with pre‐defined addresses. 
When the user specifies this command, the 
software compiles the commands into variable 
commands with specific pre‐defined variable 
addresses.
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 ALIGN (1)
 ALIGN (2)
 ALIGN (3)
 NOTIFY (ENABLE SPINUP)
 NOTIFY (RESERVED 0)
 NOTIFY (RESERVED 1)
 NOTIFY (RESERVED 2)
 ACK
 NAK (CRC ERROR)
 NAK (RESERVED 0)
 NAK (RESERVED 1 
 NAK (RESERVED 2)
 CREDIT_BLOCKED
 RRDY (NORMAL)
 RRDY (RESERVED 0)
 RRDY (RESERVED 1)
 SATA_SOF
 SATA_EOF
 SATA_CONT
 SATA_DMAT
 SATA_HOLD
 SATA_HOLDA
 SATA_PMACK
 SATA_PMNAK
 SATA_PMREQ_P
 SATA_PMREQ_S
 SATA_R_ERR
 SATA_R_IP
 SATA_R_OK
 SATA_R_RDY
 SATA_SYNC
 SATA_WTRM
 SATA_X_RDY
 SATA_ERROR
 AIP (NORMAL)
 AIP (RESERVED 0)
 AIP (RESERVED 1)
 AIP (RESERVED 2)
 AIP (RESERVED 3)
 AIP (WAITING ON CONNECTION)
 AIP (WAITING ON DEVICE)
 AIP (WAITING ON PARTIAL)
 BREAK
 BROADCAST (CHANGE)
 BROADCAST (RESERVED 0)
 BROADCAST (RESERVED 1)
 BROADCAST (RESERVED 2)
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 BROADCAST (RESERVED 3)
 BROADCAST (RESERVED 4)
 BROADCAST (RESERVED CHANGE 0)
 BROADCAST (RESERVED CHANGE 1)
 CLOSE (CLEAR AFFILIATION)
 CLOSE (NORMAL)
 CLOSE (RESERVED 0)
 CLOSE (RESERVED 1)
 ERROR
 HARD_RESET
 OPEN_ACCEPT
 OPEN_REJECT (BAD DESTINATION)
 OPEN_REJECT (CONNECTION RATE NOT SUPPORTED)
 OPEN_REJECT (NO DESTINATION)
 OPEN_REJECT (PATHWAY BLOCKED)
 OPEN_REJECT (PROTOCOL NOT SUPPORTED)
 OPEN_REJECT (RESERVED ABANDON 0)
 OPEN_REJECT (RESERVED ABANDON 1)
 OPEN_REJECT (RESERVED ABANDON 2)
 OPEN_REJECT (RESERVED ABANDON 3)
 OPEN_REJECT (RESERVED CONTINUE 0)
 OPEN_REJECT (RESERVED CONTINUE 1)
 OPEN_REJECT (RESERVED INITIALIZE 0)
 OPEN_REJECT (RESERVED INITIALIZE 1)
 OPEN_REJECT (RESERVED STOP 0)
 OPEN_REJECT (RESERVED STOP 1)
 OPEN_REJECT (RETRY)
 OPEN_REJECT (STP RESOURCES BUSY)
 OPEN_REJECT (WRONG DESTINATION)
 DONE (ACK/NAK TIMEOUT)
 DONE (CREDIT TIMEOUT)
 DONE (NORMAL)
 DONE (RESERVED 0)
 DONE (RESERVED 1)
 DONE (RESERVED TIMEOUT 0)
 DONE (RESERVED TIMEOUT 1)

SAS-Specific Script-Defined Constants

The following is a list of SAS‐specific constants declared in AddressFramesDecl.inc as 
Symbol Chains. If you want to use these commands in your script, you must also include 
AddressFramesDecl.inc in your script.

 SAS_AF_DT_NO_DEVICE_ATTACHED
 SAS_AF_DT_END_DEVICE
 SAS_AF_DT_EDGE_EXPANDER_DEVICE
 SAS_AF_DT_FANOUT_EXPANDER_DEVICE
 SAS_AF_FT_IDENTIFY
 SAS_AF_FT_OPEN
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 SAS_AF_PROTOCOL_SMP
 SAS_AF_PROTOCOL_SSP
 SAS_AF_PROTOCOL_STP
 SAS_AF_PROTOCOL_UNKNOWN
 SAS_AF_RATE_1_5_GBPS
 SAS_AF_RATE_3_GBPS
 SAS_AF_RATE_6_GBPS
 SAS_AF_RATE_12_GBPS
 SMP_FRAME_TYPE_REQUEST
 SMP_FRAME_TYPE_RESPONSE
 SMP_REPORT_GENERAL
 SMP_REPORT_MANUFACTURER_INFO
 SMP_DISCOVER
 SMP_REPORT_PHY_ERROR_LOG
 SMP_REPORT_PHY_SATA
 SMP_REPORT_ROUTE_INFO
 SMP_CONFIGURE_ROUTE_INFO
 SMP_PHY_CONTROL
 SSP_FRAME_TYPE_DATA
 SSP_FRAME_TYPE_XFER_RDY
 SSP_FRAME_TYPE_COMMAND
 SSP_FRAME_TYPE_RESPONSE
 SSP_FRAME_TYPE_TASK
 SSP_FRAME_TYPE_VENDOR
 MUX (LOGICAL 0)
 MUX (LOGICAL 1)
 BREAK_REPLY
 TRAIN
 TRAIN_DONE
 PS_ACK
 PS_NAK
 PS_REQ_PARTIAL
 PS_REQ_SLUMBER

Primitive Category
 ALIGN: 0, 1, 2, or 3
 NOTIFY: ENABLE SPINUP, RESERVED 0, RESERVED 1, or RESERVED 2
 ACK
 NAK: CRC ERROR, RESERVED 0, RESERVED 1, or RESERVED 2
 RRDY: NORMAL, RESERVED 0, RESERVED 1
 AIP: NORMAL, RESERVED 0, RESERVED 1, RESERVED 2, RESERVED 3, WAITING ON 

CONNECTION, WAITING ON DEVICE, or WAITING ON PARTIAL
 BREAK
 CLOSE: CLEAR AFFILIATION, NORMAL, RESERVED 0, RESERVED 1
 CREDIT BLOCKED
 OPEN ACCEPT
 OPEN REJECT: BAD DESTINATION, CONNECTION RATE NOT SUPPORTED, NO DES‐

TINATION, PATHWAY BLOCKED, PROTOCOL NOT SUPPORTED, RESERVED ABAN‐
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DON 0, RESERVED ABANDON 1, RESERVED ABANDON 2, RESERVED ABANDON 3, 
RESERVED CONTINUE 0, RESERVED CONTINUE 1, RESERVED INITIALIZE 0, 
RESERVED INITIALIZE 1, RESERVED STOP 0, RESERVED STOP 1, RETRY, STP 
RESOURCES BUSY, or WRONG DESTINATION

 BROADCAST: CHANGE, RESERVED 0, RESERVED 1, RESERVED 2, RESERVED 3, 
RESERVED 4, RESERVED CHANGE 0, or RESERVED CHANGE 1

 DONE: ACK/NAK TIMEOUT, CREDIT TIMEOUT, NORMAL, RESERVED 0, RESERVED 
1, RESERVED TIMEOUT 0, or RESERVED TIMEOUT 1

 SATA FLOW CTRL PRIMITIVE
 SATA IDLE PRIMITIVE
 SAS PS PRIMITIVE: PS_REQ_PARTIAL, PS_REQ_SLUMBER, PS_ACK, or PS_NAK

Wait Commands

Syntax: 

WAIT_FOR { <command1> <command2> ... <group1> <group2> ... }

Wait Command Name Description
WF_TIMEOUT Timeout Credit Available 

When WF_TIMEOUT is requested in WAIT_FOR 
command, the wait session will be released after 
timeout has elapsed.

The Timeout value can be set two different ways:

1. Through the global WaitTimeout setting that 
can appear anywhere in generation. Default value 
is 1000 microseconds.

Syntax:

Set WaitTimeout = <value> (in microseconds) 

2. Through local WaitTimeout value for this 
specific wait session. 

Syntax: 

WAIT_FOR (<number_of_microseconds>) 
{WF_TIMEOUT <other_wait_commands>} 

In this case wait for other commands will be 
released no later then after 
number_of_microseconds, but global 
WaitTimeout value remains unchanged for future 
use.

See Generation\Include\
WaitCommands.inc in the program folder for the 
samples of syntax. 

WF_SOF  primitive

WF_EOF  primitive

WF_SOAF  primitive

WF_EOAF  primitive
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WF_ACK  primitive

WF_NAK_CRC_ERROR  primitive

WF_NAK_RESERVED_0  primitive

WF_NAK_RESERVED_1  primitive

WF_NAK_RESERVED_2  primitive

WF_CREDIT_AVAIL Credit Available

This function is based on a 10‐bit counter whose 
value can range from ‐512 to +511 (twos‐
complement). This counter is cleared by sending 
or receiving an OPEN_ACCEPT primitive, or by 
execution of a CLEAR_CREDIT_AVAIL command in 
the script. 

This counter is incremented by receiving any SAS 
RRDY primitive and is decremented by sending 
SAS SOF. The wait_for command will wait for this 
counter to have a positive value between +1 and  
+511. This wait_for condition is intended to be 
used before sending a SAS frame within a 
connection.

ClEAR_CREDIT_AVAIL clears this credit function.

WF_CREDIT_BLOCKED_RECEIVED CreditBlocked Received

This function is based on a flip‐flop which is 
cleared by sending or receiving an OPEN_ACCEPT 
primitive. It is set by receiving a CREDIT_BLOCKED 
primitive. It is intended to be used in conjunction 
with wf_credit_avail to prevent script hangs in 
those cases where there is not going to be any 
more credit granted.

WF_CREDIT_BLOCKED  primitive

WF_RRDY_NORMAL  primitive

WF_RRDY_RESERVED_0  primitive

WF_RRDY_RESERVED_1  primitive

WF_BREAK  primitive

WF_CLOSE_CLEAR_AFFILIATION  primitive

WF_CLOSE_NORMAL  primitive

WF_CLOSE_RESERVED_0  primitive

WF_CLOSE_RESERVED_1  primitive

WF_DONE_ACK_NAK_TIMEOUT  primitive

WF_DONE_CREDIT_TIMEOUT  primitive

WF_DONE_NORMAL  primitive

WF_DONE_RESERVED_0  primitive

Wait Command Name Description
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WF_DONE_RESERVED_1  primitive

WF_DONE_RESERVED_TIMEOUT_0  primitive

WF_DONE_RESERVED_TIMEOUT_1  primitive

WF_ERROR  primitive

WF_HARD_RESET  primitive

WF_AIP_NORMAL  primitive

WF_AIP_RESERVED_0  primitive

WF_AIP_RESERVED_1  primitive

WF_AIP_RESERVED_2  primitive

WF_AIP_RESERVED_WAIT_ON_PART  primitive

WF_AIP_WAIT_ON_CONN  primitive

WF_AIP_WAIT_ON_DEVICE  primitive

WF_AIP_WAIT_ON_PARTIAL  primitive

WF_IDENTIFY_FRAME  Identify Address Frame

WF_OPEN_FRAME  Open Address Frame

WF_SMP_REQUEST  SMP Request Frame

WF_SMP_RESPONSE  SMP Response Frame

WF_REC_RESOURCES_OUTPUT_A Advanced Wait Condition A

This command causes generation to wait for 
Event "A" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_B Advanced Wait Condition B

This command causes generation to wait for 
Event "B" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_C Advanced Wait Condition C

This command causes generation to wait for 
Event "C" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_D Advanced Wait Condition D

This command causes generation to wait for 
Event "D" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

WF_REC_RESOURCES_OUTPUT_E Advanced Wait Condition E

This command causes generation to wait for 
Event "E" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

Wait Command Name Description
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WF_REC_RESOURCES_OUTPUT_F Advanced Wait Condition F

This command causes generation to wait for 
Event "F" to occur that you defined in the 
Generation Options dialog described at the end of 
this chapter.

 wf_trainer_interconnect_signal_1 Events used to signal from one port to another.

 wf_trainer_interconnect_signal_2 Events used to signal from one port to another.

 wf_trainer_interconnect_signal_3 Events used to signal from one port to another.

 wf_trainer_interconnect_signal_4 Events used to signal from one port to another.

WF_COMRESET_COMINIT  COMRESET OOB Signals

WF_COMSAS  COMSAS OOB Signals

WF_COMWAKE  COMWAKE OOB Signals

WF_BLOCK1_MISC_RESERVED_0  reserved

WF_BLOCK1_MISC_RESERVED_1  reserved

WF_BLOCK1_MISC_RESERVED_2  reserved

WF_BLOCK1_MISC_RESERVED_3  reserved

WF_BLOCK1_MISC_RESERVED_4  reserved

WF_SATA_CONT  primitive

WF_SATA_DMAT  primitive

WF_SATA_EOF  primitive

WF_SATA_ERROR  primitive

WF_SATA_HOLD  primitive

WF_SATA_HOLDA  primitive

WF_SATA_PMACK  primitive

WF_SATA_PMNAK  primitive

WF_SATA_PMREQ_P  primitive

WF_SATA_PMREQ_S  primitive

WF_SATA_R_ERR  primitive

WF_SATA_R_IP  primitive

WF_SATA_R_OK  primitive

WF_SATA_R_RDY  primitive

WF_SATA_SOF  primitive

WF_SATA_SYNC  primitive

WF_SATA_WTRM  primitive

WF_SATA_X_RDY  primitive

WF_OPEN_ACCEPT  primitive

WF_OPEN_REJECT_BAD_DESTINATION  primitive

WF_OPEN_REJECT_CONN_RATE_NOT_SUPPO
RTED

 primitive

WF_OPEN_REJECT_NO_DESTINATION  primitive

WF_OPEN_REJECT_PATHWAY_BLOCKED  primitive

Wait Command Name Description
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WF_OPEN_REJECT_PROTOCOL_NOT_SUPPOR
TED

 primitive

WF_OPEN_REJECT_RETRY  primitive

WF_OPEN_REJECT_STP_RESOURCES_BUSY  primitive

WF_OPEN_REJECT_WRONG_DESTINATION  primitive

WF_OPEN_REJECT_RESERVED_ABANDON_0  primitive

WF_OPEN_REJECT_RESERVED_ABANDON_1  primitive

WF_OPEN_REJECT_RESERVED_ABANDON_2  primitive

WF_OPEN_REJECT_RESERVED_ABANDON_3  primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_0  primitive

WF_OPEN_REJECT_RESERVED_CONTINUE_1  primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_0  primitive

WF_OPEN_REJECT_RESERVED_INITIALIZE_1  primitive

WF_OPEN_REJECT_RESERVED_STOP_0  primitive

WF_OPEN_REJECT_RESERVED_STOP_1  primitive

WF_ALIGN_0  primitive

WF_ALIGN_1  primitive

WF_ALIGN_2  primitive

WF_ALIGN_3  primitive

WF_NOTIFY_ENABLE_SPINUP  primitive

WF_NOTIFY_RESERVED_0  primitive

WF_NOTIFY_RESERVED_1  primitive

WF_NOTIFY_RESERVED_2  primitive

WF_BROADCAST_CHANGE  primitive

WF_BROADCAST_RESERVED_0  primitive

WF_BROADCAST_RESERVED_1  primitive

WF_BROADCAST_RESERVED_2  primitive

WF_BROADCAST_RESERVED_3  primitive

WF_BROADCAST_RESERVED_4  primitive

WF_BROADCAST_RESERVED_CHANGE_0  primitive

WF_BROADCAST_RESERVED_CHANGE_1  primitive

WF_BLOCK2_MISC_RESERVED_0  reserved

WF_BLOCK2_MISC_RESERVED_1  reserved

WF_TRAIN  primitive

WF_TRAIN_DONE  primitive

WF_BREAK_REPLY  primitive

WF_MUX_LOGICAL_0  primitive

WF_MUX_LOGICAL_1  primitive

WF_PS_REQ_PARTIAL primitive

WF_PS_REQ_SLUMBER primitive

Wait Command Name Description
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WF_PS_ACK primitive

WF_PS_NAK primitive

WF_EXTERNAL_TRIGGER This command causes generation to wait for an 
External Trigger

WF_ANALYZER_TRIGGER This command causes generation to wait for an 
Analyzer Trigger

WF_TTIU(DATA/Change TTIU  ,  MASK) This instruction waits for specific TTIU. During this 
instruction the previously transmitted TTIU is 
transmitted. The user can trigger wait for specific 
TTIU or change the TTIU or part of TTIU by 
specifying the 32'bit mask value.

The default mask value is set to all ones, i.e waits 
for all 32'bits to match with the received TTIU. 
Changing the mask value gives the flexibility to 
wait for some specific bits in the TTIU. Giving 
Change_TTIU with mask value waits for any 
change in the specified Bits in the Received TTIU 
compared to the previously received ttiu.

Wait Command Name Description
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Wait Command Groups

Wait Command Group Group Contents
WF_TIMEOUT WF_TIMEOUT_BLOCK_ONE

WF_TIMEOUT_BLOCK_TWO

WF_ALL_SOF WF_SOF

WF_SOAF

WF_ALL_EOF WF_EOF

WF_SOAF

WF_NAK WF_NAK_CRC_ERROR

WF_NAK_RESERVED_0

WF_NAK_RESERVED_1

WF_NAK_RESERVED_2

WF_RRDY WF_RRDY_NORMAL

WF_RRDY_RESERVED_0

WF_RRDY_RESERVED_1

WF_CREDIT_OK WF_CREDIT_AVAIL

WF_CREDIT_BLOCKED_RECEIVED

WF_CLOSE   WF_CLOSE_CLEAR_AFFILIATION

WF_CLOSE_NORMAL

WF_CLOSE_RESERVED_0

WF_CLOSE_RESERVED_1

WF_DONE WF_DONE_ACK_NAK_TIMEOUT

WF_DONE_CREDIT_TIMEOUT

WF_DONE_NORMAL

WF_DONE_RESERVED_0

WF_DONE_RESERVED_1

WF_DONE_RESERVED_TIMEOUT_0

WF_DONE_RESERVED_TIMEOUT_1
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WF_AIP WF_AIP_NORMAL

WF_AIP_RESERVED_0

WF_AIP_RESERVED_1

WF_AIP_RESERVED_2

WF_AIP_RESERVED_WAIT_ON_PART

WF_AIP_WAIT_ON_CONN

WF_AIP_WAIT_ON_DEVICE

WF_AIP_WAIT_ON_PARTIAL

WF_REC_RESOURCES WF_REC_RESOURCES_OUTPUT_A

WF_REC_RESOURCES_OUTPUT_B

WF_REC_RESOURCES_OUTPUT_C

WF_REC_RESOURCES_OUTPUT_D

WF_REC_RESOURCES_OUTPUT_E

WF_REC_RESOURCES_OUTPUT_F

WF_RCV_STATUS WF_SATA_R_ERR

WF_SATA_R_OK

WF_PM_REQ WF_SATA_PMREQ_P

WF_SATA_PMREQ_S

WF_PM_STATUS WF_SATA_PMACK

WF_SATA_PMNAK

WF_OPEN_REJECT WF_OPEN_REJECT_BAD_DESTINATION

WF_OPEN_REJECT_CONN_RATE_NOT_SUPPORTED

WF_OPEN_REJECT_NO_DESTINATION

WF_OPEN_REJECT_PATHWAY_BLOCKED

WF_OPEN_REJECT_PROTOCOL_NOT_SUPPORTED

WF_OPEN_REJECT_RETRY

WF_OPEN_REJECT_STP_RESOURCES_BUSY

WF_OPEN_REJECT_WRONG_DESTINATION

WF_OPEN_REJECT_RESERVED_ABANDON_0

WF_OPEN_REJECT_RESERVED_ABANDON_1

WF_OPEN_REJECT

(continued...)

WF_OPEN_REJECT_RESERVED_ABANDON_2

WF_OPEN_REJECT_RESERVED_ABANDON_3

WF_OPEN_REJECT_RESERVED_CONTINUE_0

WF_OPEN_REJECT_RESERVED_CONTINUE_1

WF_OPEN_REJECT_RESERVED_INITIALIZE_0

WF_OPEN_REJECT_RESERVED_INITIALIZE_1

WF_OPEN_REJECT_RESERVED_STOP_0

WF_OPEN_REJECT_RESERVED_STOP_1

Wait Command Group Group Contents
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Predefined Constants

WF_OPEN_RESPONSE WF_OPEN_ACCEPT

WF_OPEN_REJECT

WF_ALIGN WF_ALIGN_0

WF_ALIGN_1

WF_ALIGN_2

WF_ALIGN_3

WF_NOTIFY WF_NOTIFY_ENABLE_SPINUP

WF_NOTIFY_RESERVED_0

WF_NOTIFY_RESERVED_1

WF_NOTIFY_RESERVED_2

WF_BROADCAST WF_BROADCAST_CHANGE

WF_BROADCAST_RESERVED_0

WF_BROADCAST_RESERVED_1

WF_BROADCAST_RESERVED_2

WF_BROADCAST_RESERVED_3

WF_BROADCAST_RESERVED_4

WF_BROADCAST_RESERVED_CHANGE_0

WF_BROADCAST_RESERVED_CHANGE_1

WF_SAS_PS_REQ WF_PS_REQ_PARTIAL

WF_PS_REQ_SLUMBER

WF_SAS_PS_STATUS WF_PS_ACK

WF_PS_ACK

Predefined Constant Internal Value
GEN_MODE_ERROR 0

GEN_MODE_SATA_HOST 1

GEN_MODE_SATA_DEVICE 2

GEN_MODE_SAS_INITIATOR 3

GEN_MODE_SAS_TARGET 4

GEN_LINK_SPEED_1_5G 00

GEN_LINK_SPEED_3G 01

GEN_LINK_SPEED_6G 10

SCRAMBLING_MODE_NONE 0

SCRAMBLING_MODE_SAS 1

SCRAMBLING_MODE_SATA 2

Wait Command Group Group Contents
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Generation Settings

Setting
Default 
Value Description 

Global Settings

GenerationMode >>>>> Generation Mode ‐ must be defined or no generation 
will take place. Possible Values: 
GEN_MODE_SATA_HOST GEN_MODE_SATA_DEVICE 
GEN_MODE_SAS_INITIATOR 
GEN_MODE_SAS_TARGET

Default Value: GEN_MODE_ERROR ‐ undefined mode

SSCEnable 0 Spread Spectrum Clocking (SSC)

In SATA software, turns SSC on or off. Can only be set 
outside Generation block.

In SAS software, when you turn on SSC, Trainer PHY 
can turn on SSC on the PHY. In the SAS protocol, 
during speed negotiation, when both sides of a link 
agree to turn on their SSC, SSC will turn on, with the 
SSC Type and SSC Amplitude parameters. 

SSCType Specifies SSC type as midspread.

SSCAmplitude Specifies SSC Amplitude. Possible values are:

SSC_AMP_500

SSC_AMP_1000

SSC_AMP_1500

SSC_AMP_2000

SSC_AMP_2500

SSC_AMP_3000

MultiSpeedMode 0 When set, the change of speed within Generation 
block is allowed with following syntax: set Speed = 
LINK_SPEED_1_5G / LINK_SPEED_3G / 
LINK_SPEED_6G

Output Disable 0 This very poorly named register bit forces the Trainer 
to output data. It is a little like the output_on script 
command except that its effect cannot be undone for 
the duration of the script. If this is turned on, none of 
the out‐of‐band commands will work, as the output 
enable is forced on.

SupportSNW1 1 When set, in “Connect command” SNW1 will be tried 
in Speed Negotiation phase 
Can only be set outside Generation block.

SupportSNW2 1 When set, in “Connect command” SNW2 will be tried 
in Speed Negotiation phase.
Can only be set outside Generation block.
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PauseTrnScrmblr. 0 When set, the generator pauses the Idle scrambler of 
Train/TrainDone pattern.

ReconnectOnRun 0 When “AdvanceConnect” and “ReconnectOnRun” 
are set, the “Connect” command forces the Trainer 
to disconnect the physical link before executing the 
“Connect” command. 

When “AdvanceConnect” is not set, this setting does 
not affect the Trainer.

AdvanceConnect 0 When set, the Trainer uses the 
“PHY Capability” and “SupportSNW” settings, 
instead of the “Set Speed” settings, for executing the 
“Connect” command.

OutputOffAfterDC On

Off

If set to On, Trainer puts DC Idle on line when it 
detects sync lost on the link.

Setting
Default 
Value Description 
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AutoMode Settings

AutoOOBMode On When set, the generator will go through the stages of 
bringing up the link automatically, including waiting 
for and responding to the device or host it is 
connected to. 

AutoHoldMode 0 When set, the generator will respond automatically 
to Hold requests. Not supported for version 1.1 
(reserved). 

AutoDMAT 0 When set, the generator will respond automatically 
to DMAT requests. Not supported for version 1.1 
(reserved). 

AutoSpeedNeg On When set, the generator will automatically go 
throughthe speed negotiation process, for the speed 
set in the PINTERFACEC_SERDES register for the 
Trainer. 

AutoAlignSATA 0 When set, the generator will automatically inserting 
the stream 2 Align(0) primitives every 254 DWORDs, as 
specified in the SATA spec. 

AutoAlignSAS On When set, the generator will automatically inserting 
the stream Align primitives every 2048 DWORDs, as 
specified in the SAS spec.Two Align modes can be 
turned on simultaneously, to support STP

COMINIT Settings

COMINIT_NegLen 800 The number of bursts to send as part of this OOB 
type.Each Burst is followed by an Idle. The Burst‐Idle 
pairs are repeated the requested number of times, 
and then followed by the Negation_length of Idle. 

COMINIT_IdleLen 480 Burst time between each OOB idle in OOBIs.During 
the specified period, the generator will send 
ALIGN(0) at the specified speed. 

COMINIT_BurstLen 160 Idle time between each OOB burst in OOBIs.During 
the specified period, the generator will keep the line 
at electric idle. 

COMINIT_NumBursts 6 Negation time at the end of the OOB signal in 
OOBIs.During the specified period, the generator will 
keep the line at electric idle. 

Setting
Default 
Value Description 
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COMWAKE Settings

COMWAKE_NegLen 280 The number of bursts to send as part of this OOB 
type.Each Burst is followed by an Idle. The Burst‐Idle 
pairs are repeated the requested number of times, 
and then followed by the Negation_length of Idle. 

COMWAKE_IdleLen 160 Burst time between each OOB idle in OOBIs.During 
the specified period, the generator will send 
ALIGN(0) at the specified speed. 

COMWAKE_BurstLen 160 Idle time between each OOB burst in OOBIs.During 
the specified period, the generator will keep the line 
at electric idle. 

COMWAKE_NumBursts 6 Negation time at the end of the OOB signal in 
OOBIs.During the specified period, the generator will 
keep the line at electric idle. 

COMSAS Settings

COMSAS_NegLen 2400 The number of bursts to send as part of this OOB 
type.Each Burst is followed by an Idle. The Burst‐Idle 
pairs are repeated the requested number of times, 
and then followed by the Negation_length of Idle. 

COMSAS_IdleLen 1440 Burst time between each OOB idle in OOBIs.During 
the specified period, the generator will send 
ALIGN(0) at the specified speed. 

COMSAS_BurstLen 160 Idle time between each OOB burst in OOBIs.During 
the specified period, the generator will keep the line 
at electric idle. 

COMSAS_NumBursts 6 Negation time at the end of the OOB signal in 
OOBIs.During the specified period, the generator will 
keep the line at electric idle. 

SATA Link Init Settings

OOB_SATA_D102_Time 100000 D10.2 time for SATA link synchronization in 
OOBIs.During the specified period, the generator will 
transmit D10.2 symbols. 

OOB_SATA_Align_Time 100000 ALIGN(0) time for SATA link synchronization in 
OOBIs.During the specified period, the generator will 
transmit ALIGN(0) primitives. 

Setting
Default 
Value Description 
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SAS Speed Negotiation Settings

OOB_SAS_Align1_Time 81920 ALIGN(1) time for SAS speed negotiation in 
OOBIs.During the specified period, the generator will 
transmit ALIGN(1) primitives. 

OOB_SAS_Align0_Time 81920 ALIGN(0) time for SAS speed negotiation in 
OOBIs.During the specified period, the generator will 
transmit ALIGN(0) primitives. 

OOB_SAS_Interspeed_Time 750000 Interspeed time for SAS speed negotiation in 
OOBIs.During the specified period, the generator will 
keep the line at electric idle. 

OOB_SpeedNeg_MTT. 29998080 
OOBI

The maximum time in OOBI during which training 
phase of speed negotiation should be completed in 
Train‐SNW. 

OOB_SpeedNeg_SNTT. 2200
OOBI

The time in OOBI during which generator transmits 
phy capability bits in SNW‐3. In Automatic 
connection This value is also used for the time during 
which generator sends Align0 and Align1 in SNW1 
and SNW2. 

OOB_SpeedNeg_BCT. 2200
OOBI

The time in OOBI during which generator transmits 
COMWAKE or D.C. idle during SNW‐3. 

OOB_SpeedNeg_MTTT  750000000 
OOBI 

The maximum time for transmitter training to 
complete during Train_Tx‐SNW.

OOB_SpeedNeg_COEF_Sett
ing.

Normal The initial coefficient setting values to be transmitted 
in the Tx‐training TTIU. The value can be one of these 
values :Normal, Reference‐1, Reference‐2, No‐
equalization. 

Setting
Default 
Value Description 
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Phy Capabilities Settings

OOB_SpeedNeg_Phy_start The START bit shall be set to one. The phy’s receiver 
shall use this bit to establish the timing for the 
subsequent bits.

OOB_SpeedNeg_
Phy_txSSCtype

A TX SSC TYPE bit set to one indicates that the phy’s 
transmitter uses center‐spreading SSC when SSC is 
enabled.
A TX SSC TYPE bit set to zero indicates that the phy’s 
transmitter uses down‐spreading SSC when SSC is 
enabled or that the phy does not support SSC.

OOB_SpeedNeg_Phy_RLLR The REQUESTED LOGICAL LINK RATE field indicates if 
the phy supports multiplexing and, if so, the logical 
link rate that the phy is requesting.

OOB_SpeedNeg_
Phy_g1WithoutSSC

A G1 WITHOUT SSC bit set to one indicates that the 
phy supports G1 (i.e., 1.5 Gbps) without SSC.
A G1 WITHOUT SSC bit set to zero indicates that the 
phy does not support G1 without SSC.

OOB_SpeedNeg_
Phy_g1WithSSC

A G1 WITH SSC bit set to one indicates that the phy 
supports G1 (i.e., 1.5 Gbps) with SSC.
A G1 WITH SSC bit set to zero indicates that the phy 
does not support G1 with SSC.

OOB_SpeedNeg_
Phy_g2WithoutSSC

A G2 WITHOUT SSC bit set to one indicates that the 
phy supports G2 (i.e., 3 Gbps) without SSC. 
A G2 WITHOUT SSC bit set to zero indicates that the 
phy does not support G2 without SSC.

OOB_SpeedNeg_
Phy_g2WithSSC

A G2 WITH SSC bit set to one indicates that the phy 
supports G2 (i.e., 3 Gbps) with SSC.
A G2 WITH SSC bit set to zero indicates that the phy 
does not support G2 with SSC.

OOB_SpeedNeg_
Phy_g3WithoutSSC

A G3 WITHOUT SSC bit set to one indicates that the 
phy supports G3 (i.e., 6 Gbps) without SSC. 
A G3 WITHOUT SSC bit set to zero indicates that the 
phy does not support G3 without SSC.

OOB_SpeedNeg_
Phy_g3WithSSC

A G3 WITH SSC bit set to one indicates that the phy 
supports G3 (i.e., 6 Gbps) with SSC.
A G3 WITH SSC bit set to zero indicates that the phy 
does not support G3 with SSC.

OOB_SpeedNeg_

Phy_g4WithoutSSC 

A G4 WITHOUT SSC bit set to one indicates that the 
phy supports G4 (12 Gbps) without SSC.

 A G4 WITHOUT SSC bit set to zero indicates that the 
phy does not support G4 without SSC. 

Setting
Default 
Value Description 
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OOB_SpeedNeg_

Phy_g4WithSSC

A G4 WITH SSC bit set to one indicates that the phy 
supports G4 (12 Gbps) with SSC. 

A G4 WITH SSC bit set to zero indicates that the phy 
does not support G4 with SSC.

OOB_SpeedNeg_Phy_Parity The PARITY bit provides for error detection of all the 
SNW‐3 phy capabilities bits. 
The PARITY bit shall be set to one or zero such that 
the total number of SNW‐3 phy capabilities bits that 
are set to one is even, including the START bit and the 
PARITY bit.

Setting
Default 
Value Description 
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SATA Speed Negotiation Settings

OOB_SpeedNeg_RCDT 750000 Maximum time in OOBIs during the speed 
negotiation window for a transmitter to reply with 
ALIGN(1). 

OOB_SpeedNeg_SNTT 163840 Time in OOBIs during which ALIGN(0) or ALIGN(1) is 
transmitted at each physical link rate during the 
speed negotiation sequence. 

OOB_SpeedNeg_SNLT 153600 Time in OOBIs during which the transmitter shall 
transmit idle between rates during speed 
negotiation. 

Speed Settings

Speed >>>>> Link Speed Possible Values: 
LINK_SPEED_1_5G LINK_SPEED_3G LINK_SPEED_6G
Default Value: LINK_SPEED_1_5G

RateMatching 0 Possible values: 0 (disabled) and 1 (enabled). 

When RateMatching is enabled, the software 
programs every other dword as Align(0) primitive, 
cutting the throughput in half. 

It is not recommended to use SendInc and SendBulk 
when you are employing RateMatching, since the 
automatically generated data will not get rate 
matched.

Scrambling Mode Settings

Scrambling >>>>> Raw Data Scrambling Mode ‐ Only those raw 
DWORDs will be scrambled that contain only data 
bytes (no 10‐bit symbols or 'K' bytes. Scrambling is 
reset by changing ScramblingMode or by any valid 
SAS or SATA frame.

When Scrambling is on, scrambling is done by Trainer 
engine. It automatically detects scrambling type (SAS 
or SATA) by start frame primitive.

When Scrambling is off, data is sent without any 
scrambling.

Possible Values: 
SCRAMBLING_MODE_NONE
SCRAMBLING_MODE_SAS 
SCRAMBLING_MODE_SATA 
SCRAMBLING_MODE_AUTO
Default Value: SCRAMBLING_MODE_AUTO

Setting
Default 
Value Description 
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Wait Timeout Settings

WaitTimeout 1000 Sets global WaitTimeout value in microseconds 

AUTO_WAIT_SAS_AFTER Settings

AUTO_WAIT_SAS_AFTER_
CLOSE_FOR_CLOSE

FALSE When set, the generator will insert WAIT_FOR CLOSE 
command immediately after each CLOSE primitive. 

AUTO_WAIT_SAS_AFTER_
EOF_FOR_ACK

FALSE When set, the generator will insert WAIT_FOR ACK 
command immediately after each EOF primitive. 

AUTO_WAIT_SAS_AFTER_
EOF_FOR_ACK_OR_NAK 

FALSE When set, the generator will insert WAIT_FOR ACK or 
NAK command immediately after each EOF primitive. 

AUTO_WAIT_SAS_AFTER_
OPEN_FOR_OPEN_ACCEPT

FALSE When set, the generator will insert WAIT_FOR 
OPEN_ACCEPT command immediately after each 
Open Address Frame. 

AUTO_WAIT_SAS_AFTER_
OPEN_FOR_OPEN_REJECT

FALSE When set, the generator will insert WAIT_FOR 
OPEN_REJECT command immediately after each 
Open Address Frame. 

AUTO_WAIT_SAS_AFTER_
IDENTIFY_FOR_IDENTIFY_
FRAME

FALSE When set, the generator will insert WAIT_FOR 
Identify Frame command immediately after each 
Identify Address Frame. 

AUTO_WAIT_SAS_AFTER_
SMP_REQ_FOR_RESP

FALSE When set, the generator will insert WAIT_FOR SMP 
Response Frame command immediately after each 
SMP Request Frame. 

AUTO_WAIT_SAS_BEFORE Settings

AUTO_WAIT_SAS_BEFORE_
CLOSE_FOR_CLOSE

FALSE When set, the generator will insert WAIT_FOR CLOSE 
command right before each CLOSE primitive. 

AUTO_WAIT_SAS_BEFORE_
SOF_FOR_CREDIT

FALSE When set, the generator will insert WAIT_FOR 
CREDIT command right before each SOF primitive. 

AUTO_WAIT_SAS_BEFORE_
IDENTIFY_FOR_IDENTIFY_
FRAME

FALSE When set, the generator will insert WAIT_FOR 
Identify Frame command right before each Identify 
Address Frame. 

AUTO_WAIT_SAS_BEFORE_
OPEN_ACCEPT_FOR_OPEN

FALSE When set, the generator will insert WAIT_FOR Open 
Frame command right before each OPEN_ACCEPT 
primitive. 

AUTO_WAIT_SAS_BEFORE_
OPEN_REJECT_FOR_OPEN

FALSE When set, the generator will insert WAIT_FOR Open 
Frame command right before each OPEN_REJECT 
primitive. 

AUTO_WAIT_SAS_BEFORE_
AIP_FOR_OPEN

FALSE When set, the generator will insert WAIT_FOR Open 
Frame command right before each primitive of AIP 
group. 

AUTO_WAIT_SAS_BEFORE_
SMP_RESP_FOR_REQ

FALSE When set, the generator will insert WAIT_FOR SMP 
Request Frame command right before each SMP 
Response Frame. 

Setting
Default 
Value Description 
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AUTO_WAIT_SATA_AFTER Settings

AUTO_WAIT_SATA_AFTER_
X_RDY_FOR_R_RDY

FALSE When set, the generator will insert WAIT_FOR 
SATA_R_RDY command immediately after each case 
of SATA_CONT primitive following SATA_X_RDY 
primitive. 

AUTO_WAIT_SATA_AFTER_
WTRM_FOR_STATUS

FALSE When set, the generator will insert WAIT_FOR 
SATA_R_ERR or SATA_R_OK command immediately 
after each case of SATA_CONT primitive following 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_AFTER_
PMREQ_S_FOR_RESPONSE

FALSE When set, the generator will insert WAIT_FOR 
SATA_PMACK or SATA_PMNAK command 
immediately after each case of SATA_CONT primitive 
following SATA_PMREQ_S primitive. 

AUTO_WAIT_SATA_AFTER_
PMREQ_P_FOR_RESPONSE

FALSE When set, the generator will insert WAIT_FOR 
SATA_PMACK or SATA_PMNAK command 
immediately after each case of SATA_CONT primitive 
following SATA_PMREQ_P primitive. 

AUTO_WAIT_SATA_AFTER_
SYNC_FOR_SYNC

FALSE When set, the generator will insert WAIT_FOR 
SATA_SYNC command immediately after each case of 
SATA_CONT primitive following SATA_SYNC primitive. 

AUTO_WAIT_SATA_BEFORE Settings

AUTO_WAIT_SATA_BEFORE
_PMACK_FOR_PMREQ

FALSE When set, the generator will insert WAIT_FOR 
SATA_PMREQ_S or SATA_PMREQ_P command right 
before each SATA_PMACK primitive. 

AUTO_WAIT_SATA_BEFORE
_PMNAK_FOR_PMREQ

FALSE When set, the generator will insert WAIT_FOR 
SATA_PMREQ_S or SATA_PMREQ_P command right 
before each SATA_PMNAK primitive. 

AUTO_WAIT_SATA_BEFORE
_RERR_FOR_WTRM

FALSE When set, the generator will insert WAIT_FOR 
SATA_R_ERR command right before each 
SATA_WTRM primitive. 

AUTO_WAIT_SATA_BEFORE
_ROK_FOR_WTRM

FALSE When set, the generator will insert WAIT_FOR 
SATA_R_OK command right before each SATA_WTRM 
primitive. 

AUTO_WAIT_SATA_BEFORE
_RIP_FOR_SOF

FALSE When set, the generator will insert WAIT_FOR 
SATA_R_IP command right before each SATA_SOF 
primitive. 

AUTO_WAIT_SATA_BEFORE
_R_RDY_FOR_X_RDY

FALSE When set, the generator will insert WAIT_FOR 
SATA_X_RDY command right before each 
SATA_R_RDY primitive. 

Setting
Default 
Value Description 
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5.11.8 Auto Speed Negotiation

The commands SATA_D10.2, SATA_ALIGN, SPEED_NEG_ALIGN0 and SPEED_NEG_ALIGN1 
operate differently based on the state of the Auto Speed negotiation (Asng) control bit 
(which is set or cleared by configuration memory blocks in the stream) and by the current 
SAS/SATA, Init/Targ state of the Trainer Engine. The table below  illustrates different 
actions done by Trainer Engine executing SATA_D10.2, SATA_ALIGN, SPEED_NEG_ALIGN0 
and SPEED_NEG_ALIGN1 commands based on Asng and Trainer Engine setup.SS

Command AutoSpeedNeg Actions
SATA_D10.2 0 Send D10.2 dwords until the 

count is exhausted, then move 
on to the next block in stream. 
The count is specified by the 
SPEED_NEG_PARAMETER control 
block.

1 Send D10.2 dwords until the 
count is exhausted or an ALIGN_0 
is detected (whichever comes 
first), then move on to the next 
block in the stream.

SATA_ALIGN 0 Send Align_0 primitives until the 
count is exhausted, then move 
on to the next block in the 
stream. The count is specified by 
the SPEED_NEG_PARAMETER 
control block.

1 Send Align_0 primitives until the 
count is exhausted or an Align_0 
is detected (whichever comes 
first), then move on to the next 
block in the stream.

SPEED_NEG_ALIGN0 0 Send Align_0 primitives until the 
count is exhausted, then move 
on to the next block in the 
stream.

1 Send Align primitives until the 
count is exhausted, then move 
on to the next block in the 
stream. Start with Align_0, and 
switch to Align_1 if an Align_0 is 
detected.

SPEED_NEG_ALIGN1 0 Send Align_1 primitives until the 
count is exhausted.

1 Do nothing at all.
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5.11.9 Generation Options

Use the Generation Rules to set triggers and filters. 

To display the Generation Options dialog, select Generate > Generation Options or click 

the Setup Generation Options   button.

Figure 5.16: Generation Options Window

The page has the following areas: 

 Toolbar: Contains buttons that control the Generation Rules page.
 Available Events Area: Area where you can park Event buttons that you intend 

to use in the Main Display area.
 Main Display Area: Area where you configure trigger and filter rules. You config‐

ure rules by dragging Event buttons from the Available Events area and then 
assigning actions to those buttons. 

 Config Status Indicator: A button that indicates if the rule is valid or invalid. If a 
trigger or filter rule is configured correctly, the button is green and indicates 
Config is Valid. If a rule is not configured correctly, the button is red and indicates 
Config is Invalid.

Pop‐Up Menus: When you right‐click a button or area in the Generation Rules page, a 
context‐sensitive pop‐up menu appears that lets you do operations that relate to that 
button or area.

Properties Dialogs: When you click the Show/Hide Properties Dialog button for an event, 
action, or state, a dialog allows you to perform the same operations as in the pop‐up 
menus.

Main
Display
Area

Config
Status
Indicator 

Available
Events
Area

Toolbar
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5.11.10 Generation Rules Toolbar

The Generation Rules toolbar buttons control the Generation Rules page.

Figure 5.17: Generation Rules Toolbar

TABLE 5.12:  Recording Rules Buttons 

Note: If you have a wheel on the mouse, you can zoom by holding down the CTRL key and rolling the 
mouse wheel.

5.11.11 Generation Rules Page: How It Works

You can think of the Generation Rules page as a workspace for creating rules (rules that 
determine how the analyzer generates traces). Rules are combinations of events and 
actions. 

New Event. Creates a 
new event in the 
Available Events 
area.

Zoom Out. Makes 
the display appear 
smaller.

Delete Event. Deletes 
the selected event.

Show/Hide 
Channels. Shows or 
hides the channel 
icon on the Event 
button.

Undo. Undoes the 
change made to 
Recording Rules 
page. The Undo 
buffer has unlimited 
size.

Show/Hide 
Properties Dialog. 
Shows or hides the 
properties dialog of 
the selected event, 
action, or state.

Redo. Restores 
changes done to the 
Recording Rules 
page.

This display 
appears when the 
current Recording 
Rules configuration 
can be executed by 
the hardware.

Zoom In. Enlarges 
the display (see 
note). There are five 
zoom levels. The 
default level is the 
middle one.

This display 
appears when the 
current Recording 
Rules configuration 
cannot be executed 
by the hardware.
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An event and the action or actions associated with it form a rule state. 

Briefly, creating a rule involves the following steps: 

1. Creating Event buttons in the Available Events area.

2. Drag‐and‐drop of Event buttons to the appropriate areas (cells) in the Main Display 
area.

3. Assigning an action or actions to each Event button.

5.11.12 Creating Event Buttons

To create a rule, first create one or more Event buttons. As you create Event buttons, they 
appear in the Available Events area. You then can drag‐and‐drop them into the Main 
Display area.

To create event buttons: 

1. Click the New Event button at the left side of the toolbar to display the New Event 
pop‐up menu.

Figure 5.18: New Event Menu
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2. Select an event, such as Primitive. The event appears in the Available Events area.

Figure 5.19: Available Events Area

5.11.13 Dragging a Button to the Main Display Area

After you create an Event button in the Available Events area, you can drag the button to 
the Main Display area and drop it in the appropriate cell (a cell is a grayed‐out rectangle 
with a dashed line around it). You can think of each cell as a target for drag‐and‐drop of an 
Event button.

To drag‐and‐drop the Event button: 

1. Place the mouse cursor on the Event button in the Available Events area. Click the 
left mouse button.

2. Drag the button to the cell. When the button is in the cell, a dashed highlight line 
appears around the cell. Drop the button in the cell (release the left mouse button). 
The Event button appears in the cell.

Figure 5.20: Event in Main Display

The default label for the first cell is Global State, which is active at all times. 
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5.11.14 Assigning an Action

After you have dropped the Event button in a cell in the Main Display area, you can assign 
an action to the event. 

Note: If you do not assign an action to an Event button, the Generator ignores the event.

To assign an action to an Event button: 

1. Right‐click the Event button to display a pop‐up menu.

Figure 5.21: Action Menu

2. Select Specify Action, and then choose an action from the submenu. The menu 
closes, and the action is assigned.

Figure 5.22: Action in Main Display

Note:You can also set actions within the Properties dialog for each event. Double‐click the Event 
button to open the Properties dialog, then select the Actions tab and set your actions.
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5.11.15 Generation Rules Pop-Up Menus

The Generation Rules window has context‐sensitive pop‐up menus that are associated 
with the following types of object: cells, events, and actions.

Cell Pop-up Menu

If you right‐click a cell in the Main Display area that has an Event button contained in it, 
the Cell pop‐up menu appears. The Cell pop‐up menu has the following options.

 New Event: Displays the same menu that you get when you click the New Event 
button on the toolbar.

 Properties: Displays the Properties dialog for the selected cell.

Action Pop-up Menu

If you click an Action button in the Main Display area, the Action pop‐up menu appears 
with the options A through F and No Action.

Event Pop-up Menu

If you click an Event button in the Main Display area, the Event pop‐up menu appears. The 
Event pop‐up menu has the following options: 

 Specify Action(s): Opens the Actions submenu, allowing you to assign an action 
to the event. Options on this submenu are the same as those on the Action pop‐
up, described previously.

 Move Event to: Moves the selected event to a different position in the Recording 
Rules window.

 Copy Event to: Copies the selected event to a different position in the Recording 
Rules window.

 Delete This Event: Deletes the selected Event. Alternatively, you can use the 
Delete button on the toolbar or keyboard to delete events.

 Properties: Displays the Event Properties dialog for the selected event.

Figure 5.23: Event Properties
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The dialog lists the Properties and their Values.

5.11.16 Events and Event Properties

Generation rules are associations between events and actions. These associations 
determine how trace recording occurs. The supported events are:

 Primitives: Primitive Categories or Primitive
 Frames: Open Address Frames, Identify Address Frames, 

Zone Broadcast Address Frames, SSP Frames, or SMP Frames
 SCSI Commands
 SCSI Status
 SATA FIS: Register Host to Device, Register Device to Host, Set Device Bits, DMA 

Activate, DMA Setup, BIST Activate, PIO Setup, Data, Route, or Vend FIS
 SSP Frame Header: DATA, XFER_RDY, COMMAND, RESPONSE, TASK, VENDOR, or 

RESERVED
 SSP Information Unit: Command IU, Task IU, XFER_RDY IU, or Response IU
 SMP Request/Response: RPT_GENERAL, RPT_MFG_INFO, DISCOVER, RPT_‐

PHY_ERR_LOG, RPT_PHY_SATA, RPT_RT_INFO, CONFIG_RT_INFO, PHY_CON‐
TROL, PHY_TEST_FUNCTION, CONFIG_PHY_ZONE, CONFIG_ZONE_PERM, 
RPT_ZONE_PERM, or RPT_ZONE_RT_TBL

 ATA Commands
 ATAPI Commands
 SATA Data Pattern
 SAS Data Pattern
 Transmitter Trainer IU Pattern 

Data Pattern Mask and Match

If you select Data Pattern as the Event, you can set Data Pattern event properties in the 
Event Properties dialog.

Figure 5.24: Event Properties for Data Pattern Event
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In the Data Pattern dialog, you can set the DWORD. You can set the Offset by entering an 
integer. Optionally click the Sequential Offsets checkbox.

5.11.17 Setting Complex “Wait For” Conditions

The Generation Options dialog lets you define complex “Wait For” events and assign a 
letter value (“A” through “F”) to the definition, so that you can refer to the definition by 
letter instead of by textual name. 

After a letter value has been assigned to an event, the letter is referred to in your 
generation script using the following command syntax:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}

where “A,” in this case, is the defined condition.

Setting Conditions with the Generation Options Dialog

To set a complex condition, open the Generation Options dialog: 

1. Select Generate > Generation Options from the menu to open the 
Generation Options dialog.

2. Click the New Events button and select an event from the menu. The selected event 
should appear in the Available Events area along the left side of the dialog box.

3. Drag the new event button to the Global State cell.
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4. Right‐click the new event button and select Specify Action(s). A menu appears 
showing the letters A through F and the option “No action.”

5. Select a letter from the menu. The menu closes. The event button should now point 
to a neighboring button that has the letter value you assigned.

6. After the condition has been defined, you can then add the Wait For command line 
(with whatever letter you assigned) to your script. For example:

Wait_For {WF_REC_RESOURCES_OUTPUT_A}

5.11.18 Find

Find allows searches on an open trace using one or more criteria. You can search by 
packet, transactions, split transaction, transfer, packet type, and fields within packets. 

To run Find, select Search > Find or by click   on the toolbar. 

Searches can combine criteria using the options Intersection and Union. 
Intersection creates AND statements such as “Find all packets with x and y.” 
Union creates OR statements such as “Find all packets with x OR y.”

You can also perform searches in which packets or events are excluded from a trace, using 
the Exclusion option.
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To perform a search: 

1. Select Find... under Search on the Menu Bar.
OR

Click in the Toolbar.
You see the User‐Defined Find Events screen:

Figure 5.25: Find Dialog

2. Select Frames, Transactions, SCSI Operations, Management Transactions, ATA 
Commands, or OOBs from the top left list box to list that type of event in the Events 
Group box.

3. Select one or more events from the Events Group box:

 Packet Types (Header, PHY, Event, Transaction)
 Primitives
 Source Addresses
 Hash Source Addresses
 Destination Addresses
 Hash Destination Addresses
 Data Length
 SMP Frames
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 SSP Frames
 Errors
 FIS Types
 FIS Port Number
 Channel
 Data Pattern
 Completion Time

4. Select one of the following options:

 Union: Find all packets matching ANY of the specified events.

 Intersection: Find packets matching ALL of the specified events.

 

 Exclusion: Exclude packets matching any of the specified events.
Exclusion works with the other two options: 
Select Union AND Exclusion
(=Exclude packets with ANY of the following fields) or 
Intersection AND Exclusion
(=Exclude packets with ALL of the following fields.)

5. Optionally set the search Direction and Origin.

6. Optionally check to Search in Hidden or Find All.

7. Click OK.

After the search finishes, the program displays the packets meeting the search criteria.

5.11.19 Data Pattern Mask and Match

If you select Data Pattern as the Event Group in the Find dialog, you can set the Bitmask, 
Mask, and Match for each bit (see Figure 5.26 on page 377).
376 Sierra M124 SAS/SATA Protocol Analyzer User Manual



Sierra Trainer Generation Language Teledyne LeCroy
Figure 5.26: Data Pattern

Bitmask and Match always correlate. When you set Bitmask or Match. the other changes 
to maintain their correlation. 

Note: If you set Bitmask/Match before setting Mask, the Mask changes to the default mask. You must 
change to the Mask that you want. 

Note: If you set an appropriate Mask before setting Bitmask/Match, the Mask does not change 
automatically to a default mask if you change Bitmask/Match.

5.11.20 Find Next

To apply the previous Find parameters to the next search: 

 Select Find Next under Search on the Menu Bar.

OR

 Click on the Toolbar.

5.11.21 Search Direction

Toggles the search forward or backwards. The current direction is indicated in the menu.
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5.12 Display Options

You can select what information to display using the Display Options window.

To open the Display Options window: 

 Select Display Options under Setup on the Menu Bar.

OR

 Click on the Toolbar.

You can select Color/Format/Hiding, Level Hiding, and Headers display options. The 
following sections describe these display options.

Restore Factory Presets sets all Display Options values to the installed values.

5.12.1 Color/Format/Hiding Display Options

To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab.

Figure 5.27: Display Options Dialog - Color, Format, Hiding Tab
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Color Display Options

The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter any 
color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it. 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field.

Figure 5.28: Display Options Dialog - Color
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To customize colors, use the Custom tab.

Figure 5.29: Custom Colors

Note:You cannot change the color of an Invalid Data (packet error) field. It is permanently set to red.

Formats Display Options

For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Binary, Decimal, and Hexadecimal. An example of a 
text data format is ASCII. 

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Data) in the Group and Color column and expand it. 

Select a data type in the Group.

Select a format in the Format section. The following formats are available:

Figure 5.30: Formats

If available, select Bit Order in the Format section. The options are MSB to LSB or LSB to 
MSB.
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Hiding Display Options

By default, no data is hidden. You can hide any group of data and any type of data.

To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hiding section of the Format section.

Level Hiding Options

By default, nothing is hidden. You can hide: 

 Packet Types
 Primitives
 Source Addresses
 Destination Addresses
 Data Length
 SMP Frames
 SSP Frames
 Channels
 FIS Types
 FIS Ports
 Gen Global Settings

Select the Level Hiding tab, then select the data types to hide.

Figure 5.31: Level Hiding Tab

You can select to Hide selected items or Show selected items.
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Headers Options

You can choose the appearance of header fields. Select the Header tab, then select the 
header.

Figure 5.32: Level Hiding Tab

Available headers are: 

 SSP Frame Header
 SMP Report General (Request or Response)
 SMP Report Mfg Info (Request or Response)
 SMP Discover (Request or Response)
 SMP Report Phy Error Log (Request or Response)
 SMP Report Route Info (Request or Response)
 SMP Configure Route Info (Request or Response)
 SMP Phy Control (Request or Response)
 SMP Phy Test Function (Request or Response)
 SMP Configure Phy Zone (Request or Response)
 SMP Configure Zone Permission (Request or Response)
 SMP Report Zone Permission (Request or Response)
 SMP Report Zone Routing Table (Request or Response)
 STP Register Host to Device FIS
 STP Register Device to Host FIS
 STP Register Device Bits Device to Host FIS
 STP DMA Activate Device to Host FIS
 STP DMA Setup FIS
 STP BIST Activate FIS
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 STP PIO Setup Device to Host FIS
 STP Data FIS
 STP Frame Summary Header
 SATA Frame Summary Header
 SAS Delta Time

Check boxes to allow a field when the selected header is collapsed. Example header fields 
are: 

 Frame Type
 Function
 Result
 Offset
 FIS Type

You can move items up and down.

You can select to Restore Defaults for the selected header or all headers.

Saving Display Options

You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

 To save the current Display Options values in an options file for use in future ses‐
sions, click Save. Enter a file name without a file name extension. The program 
adds the .opt extension. (The file must have an .opt file name extension.)

 To load a previously saved .opt file, click Load and select a file name.
 To save the current Display Options values in the default.opt options file for use 

as the default display options, click Save as Default. (Do not delete the 
default.opt file.)

 To apply the current Display Options values, click Apply. The Display Options win‐
dow remains open.

 To apply the current Display Options values and close the Display Options win‐
dow, click OK.

 To cancel unsaved changes to display values and exit the Display Options win‐
dow, click Cancel. 

5.12.2 Connection Parameters

To display the Connection Parameters dialog (see Figure 5.33 on page 384), select 
Generate > Connect Parameters.
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Figure 5.33: Connection Parameters Dialog

You can set the “Identify” frame parameter settings to keep the link connected:

 Device Type: End Device, Edge Expander, or Fanout Expander
 SSP Initiator: Present or Not Present
 STP Initiator: Present or Not Present
 SMP Initiator: Present or Not Present
 SSP Target: Present or Not Present
 STP Target: Present or Not Present
 SMP Target: Present or Not Present
 SAS Address (hex): eight digits ‐ eight digits
 PHY Identifier (hex): two digits
 Zone Device: Yes or No
 Zone Broadcast Method (hex): two digits

You can select to not show the dialog until there is a generation mode change.

5.12.3 Resetting the Toolbar

The Analyzer Toolbar has the following:

 Launch Jammer: Switches to InFusion frame.
 Launch Analyzer : Switches to Analyzer frame.
 Start Recording: Start Analyzer without switching to Analyzer frame. 
 Stop Recording: Stop Analyzer without switching to Analyzer frame. 
 Abort Recording: Abort Analyzer without switching to Analyzer frame.

The Generator Toolbar has the following:
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 Start Generation 
 Stop Generation 
 Resume Generation
 Connect Link
 Disconnect Link
 Generation Options

From time to time (such as following a software upgrade), it is possible for the buttons on 
the toolbar to not match their intended function. You can reset the toolbar by performing 
the following steps:

1. Select View > Toolbars from the menu bar.

2. Select Customize from the submenu to display the Customize dialog box.

Figure 5.34: Customize Commands

3. Select the Toolbars tab to display the Toolbars page of the Customize dialog box.

Figure 5.35: Customize Toolbars

4. Click the Reset All button.
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Creating a Pattern Generator File
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You may use any text editor or word processor to create a pattern generator file (*.spg) 
using the following conventions:

Note: If you have purchased a licence you can enable the pattern generator (see “Ports Configuration” 
on page 98.)

6.1 Key words

ALIGN, CONT, DMAT, EOF, HOLD, HOLDA, PMACK, PMNAK, PMREQ_P, PMREQ_S, R_ERR, 
R_IP, R_OK, R_RDY, SOF, SYNC, WTRM, X_RDY, XXXX, LOOP, Enable, Disable, Host, Device, 
Scramble, Role, END_OF_FILE.

6.2 Comment format
/*Comment text*/

6.3 Primitive definition format

To add an ALIGN primitive, use ALIGN or 27.3 10.2 10.2 K28.5

To add a CONT primitive, use CONT or 25.4 25.4 10.5 K28.3

6.4 Loop definition format

You may write a defined pattern into memory repeatedly by enabling a loop.

Loop definition allows either “Enable” or Disable”. To enable looping use: Loop=Enable

6.5 Scramble definition format

Scramble definition allows either “Enable” or Disable”. To enable scramble use: 
Scramble=Enable

6.6 Role definition format

To specify SATA hardware role: Role=Host or Role=Device 
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6.7 END_OF_FILE definition

A pattern generator file must include END_OF_FILE as the last statement in the file.

Figure A‐1 illustrates a typical Pattern Generator file.

Figure A.1: Sample Pattern Generator File *spg
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China Restriction of Hazardous Substances Table
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The following tables are supplied in compliance with China’s Restriction of Hazardous 
Substances (China RoHS) requirements: 

 



Teledyne LeCroy WAN Operation
7.1 WAN Operation

WAN connected operation is supported. Contact factory for details of operation. Refer 
“How to Contact Teledyne LeCroy” on page 391 for contact information.
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How to Contact Teledyne LeCroy
Type of Service Contact

Call for technical support US and Canada: 1 (800) 909‐7112

Worldwide: 1 (408) 653‐1260

Fax your questions Worldwide: 1 (408) 727‐6622

Write a letter Teledyne LeCroy

Protocol Solutions Group
Customer Support
3385 Scott Blvd.

Santa Clara, CA 95054‐3115

USA

Send e‐mail psgsupport@teledynelecroy.com

Visit Teledyne LeCroy’s web site teledynelecroy.com/

Tell Teledyne LeCroy Report a problem to Teledyne LeCroy Support via e‐mail by 
selecting Help>Tell Teledyne LeCroy from the application 
toolbar. This requires that an e‐mail client be installed and 
configured on the host machine.
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10 bit payload data display 187

8 bit payload data display 187

A
Abort Analyzer button 297

About 225, 296

Action 241
button 371
pop-up menu 371

action
counter 254
scenario 250

Action Properties dialog 253
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assigning 370
events 370, 372

Actions submenu 371

Add Device... 18

Add Pattern button 103

Add to Trigger 113

address 391

address frame 62

Address Frame Type Pattern dialog 81

Address FramesDecl.inc 306

Advanced Mode 27, 100

Advanced Probe Setting dialog 206

alias name 227

ALIGN Transmission Period 96

Analysis Project dialog 43

analyzer
connecting 13

analyzer overview 9

Anchor the Selection bar 216

Any Trigger mode 69

application overview 27

As previously saved 212

assigning actions 370

ATA Command Pattern dialog 89

ATA command pattern dialog 86

ATA Command Report 133

ATAPI Report 133

ATAPI spec assignment 211

Auto Probe Calibration dialog 209

Auto Run 12, 94

AutoAlign 303

Available Events Area 366

B
Based on Cell Type 215

Based on Port No. 215

Based on Read/Write Command Type 215, 217

Based on Specific Command Type 215, 217

batch command editing 284

batch script 281

Batch Script Setting 234

Beep statement 289

BIST (FIS) 67

bookmarks 163
finding 164

Break Link Recovery 232

Browse Default Path 211

buffer
% full 195

bus condition report 132

Bus Utilization
buttons 152

Bus Utilization View 151

buttons
bus utilization 152
Main toolbar 296
Script Editor 308
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C
cables

usage 13
Cancel button kills upload immediately 213

capture
pre and post trigger 56

Capture tab 39

cascading 14

CATC Script Language 157

CATC Technical Support 391

Cell pop-up menu 371

cells 369
highlight 369

Check for Updates 225, 296

Choose Port Speed 97

Click here to add another script command 284

Click here to add script command 282

Close previous sample file when new sample 
file opens 213

Collapse All 194

Collapse Log button 158

color 201

colors
Display Options 379

column
hiding 148
rearrange 124
resize 124

column content
filtering 146
sorting 148

Column View 31

column view 123

Columns in Row 201

Combined Event 241

Command Parameters dialog 283

Command Properties dialog 282

Compact 295

compensate
for line loss 204

Complex "Wait For" Conditions 373

components 10

conditional statements 285

Config Status Indicator 366

configuration 198

Configuration menu (InFusion) 234

Configure Device 234

Connect Link 293

Connect Link button 297

Connect Parameters 293

Connect Parameters command 383

Connection Parameters dialog 383

contact 391

Convert 292

Convert port configuration without prompt for 
confirm 211

Copy Event to option 371

copying events 371

Count Randomly 254

Counter Value 254

counters 254

CRC Calculations 306

Create statistical report read/write page 49, 213

crossover MiniSAS 13

Current License Configuration field 219

cursor position status bar 197

cursors
locating 162
positioning 197
timing 127

Customize
command 385
dialog box 385

Customize the color of any operation code 
field 116

D
data

pattern 58
show 193

DATA (FIS) 68

data format 193

Data Pattern definition dialog 58

Data Pattern Mask and Match 372, 376

Data Payload View 153

data report 152

Data Report button 152, 156

Data View 31

DataPatternCapture 113

Decode CDB of Commands 216

Decode Toolbar 189

Decode toolbar 34

Default Workspace 211, 212

default workspace 211

default.infdb file 242

Define different patterns for pre-trigger and 
post-trigger data captures 40

Delete button 371

Delete This Event option 371

deleting events 371

Device Identifier dialog 226

Device List 227

Device Setup dialog 221
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Device Sleep 119

Device Type field 384

DHCP server 26

direction
search 294, 377

Disconnect 17

Disconnect Link 293

Disconnect Link button 297

disparity indication 189

display
fonts 202

display Configuration 198

display configuration 198

Display License Information 224

display manipulation 113

Display Options 293
Color/Format/Hiding tab 378
factory settings 378
level hiding 381
loading 383
saving 383
values 378
window 378

DMA activate (FIS) 66

DMA setup (FIS) 66

Don’t care (Snapshot) 68

dragging buttons 369

Dword Matcher 249

E
Easy Mode 27

Edit as Text button 296

Edit Comment 292

Edit script 161

e-mail 391

Email CATC Support 391

Enable Outlining command 308

Enable Tooltip box 201

Entire Memory 94

Error Injection 232

error log 309

error message
startup 12

errors 285

Ethernet
connecting with 26

Ethernet port 11

Event 241

event
counter 254
scenario 246

Event buttons
creating 368
dragging 369

Event pop-up menu 371

Event Properties dialog 371

events 372
actions 370, 372
buttons 368
copying 371
deleting 371
moving 371

Events Group box 375

example files 52

exclude from capture
Align 40
Idles 40
Notify 40
OOB Signals 39
patterns 56
Payload of Data Frame 40
RRDY 40
SATA_CONT 39
SATA_SYNC 39
XXXX 40

Exclusion search 376

Expand All 194

Expand Log button 158

Expandability 14
Cascading with CATC SYNC Expansion Cards 14
Using the Power Expansion Card 14

expandability 14

Expanded Waveform View 127

Expansion module 10

Export 292

Export Paired SAS Address Report 49

Export Read/Write Command Report 49

Export to Excel button 144

Export to Initiator Emulator 45, 47

External Trig In Setting 97, 220

External Trig Out Setting 96, 220

External Trig Setting 234

External Trig Setting dialog 220

external trigger 10

External Trigger dialog 73, 74

Extract Sample File dialog 47

F
fax number 391

features 10

field
show/hide 191

Field Settings 200

Field View 126

file library 242

File Manager 243

File Menu 292

File menu (InFusion) 234
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file type
definition 51

files
.utg 35, 291
tabs 309

filter 166
by tag number 174
check condition 173
options 171
save setup 168
type 167

filter enable 178

filter idle 161, 179

filtering 166
direction 168

filtering column content 146

Filtering menu 166

filters 366

Find
command 375
utility 374

Find and Replace button 297

Find button 297

Find command 294

Find Device 225

Find Device button 227

Find Next 294

Find Next command 377

FIS Report 140

FIS Type selection dialog 63

Fit to Graph Area 151

Floating License dialog 219

Force Add/Connect Attempt 18

format
display options 380

Found Device List Mode 211

Frame Inspector View 125

frames
hide 149

From Initiator 244

From Target 244

G
general report 131

Generate Menu 293

Generating Traffic 297, 311

Generation Commands 335

Generation Files 299

Generation Language 312

Generation Options 294

Generation Rules 366

Generation Rules page 366

Generation Rules toolbar 367

Getting Started manual 10

Gigabit Ethernet interface 26

Global Rules 241
examples 257

Go to ATA/SCSI Cmd. 151

Go To button 161

Go to command 294

Go to Event 294

Go to Event dialog 294

Go to Marker 294

Go To Timestamp dialog 163

Goto Command 192

Goto Label statement 286

Goto Response 191

Goto Within Packet command 192

grouping
by port 95

H
hardware

run 42
hardware setup 12

Hash Address Utility 296

Hashed Address field 296

Help Menu 296

Help Topics 223, 296

Hide All Primitives 161

Hide RRDY Primitives 161

Hide Unassociated Traffic 161

hiding
display options 381
levels 381

hiding options 381

Histogram View 31

histogram view 149

Humidity 12

I
Identify frame parameter settings 384

IfIsStopped statement 285

Include statement 309

InFusion 231

Infusion 35

InFusion scenarios 238

Initiator Emulation 297

Install component selection 12

Installation CD ROM 10

Intersection search 376

IP Settings... 18
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Jammer 237

Jump to Next button 146

Jump to Previous button 146

Jump to Specific button 146

K
K-Codes 249

L
lanes report 138

launching 26

Launching the CrossSync Control Panel 44

LCD display 11

LEDs
description 11

library 242
main 242

License Configuration 219

License Manager 219

line condition 247

line numbers 308

link layer
command interpretation 42

Link Script Selection dialog 310

Link With Sample View 146

Load command 383

log
error 309

log file 285

M
Main Display Area 366

Main Library window 242

Main Window 37

Manual Calibration of Tx Path from Jammer or 
Trainer 207

Manual Trig button 69

manual trigger 69

Maximum Number of Uploader Threads 211

Memory Assignment 217

Memory Size 94

MiniSAS 13

mini-SAS connectors 10

Move drop-down list 146

Move Event to option 371

moving events 371

N
NACA test 227

NCQ Commands Time out Threshold 211

network 26

Networks... 18

New Batch Script command 233

New Event
button 368
option 371
pop-up menu 368

New GenFile 292

New Protocol Analyzer Project in Advanced 
Mode 210

New Scenario button 244

New Scenario command 233

New script 161

normal zoom
reset 162

Notes tab 100

Number of Run text box 94

O
Open as Data View 153

Open Document button 296

Open Library command 233

Open Sample file In 212

operating system 12

opt files 383

order reorder
in results display 187

Others Report view 134

output trigger 104

P
Pack Repeated Primitives 213

Packet Drop 232

Packet View 31, 111

packing list 10

Partial Memory 94

Paths settings 210

pattern definition
in sequential trigger mode 91

Pattern field 103

Pattern triggers 69

Pending ATA IO 151

Pending SCSI IO 151

Performance Report 139

performance report 139

PHY Identifier field 384

PIO Setup (FIS) 67

PM Performance Report 142

PM Statistic Report 141

pop-up menu
Script Editor 309

pop-up menus
Sierra M124 SAS/SATA Protocol Analyzer User Manual 397



Teledyne LeCroy Index
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port

renaming 190
status 195

port alias 202

Port Configuration 233, 234, 293

Port Configuration button 98

port ID 190

Port Speed 97

Port Status 35

Power Expansion Cards 21

pre-trigger 92
data 93

Primitive and Frame Definitions 305

Primitive Manipulation 232

primitive report 132

primitive response timeout 95

Primitive selection dialog 58

Primitives Decl.inc 306

Print Preview button 144

Program Manager Window 26

project
examples 52
file type definition 51
notes 100
settings 92, 109

project note 100

Project Tree 39

projects 51

Properties
option 371

Properties options
events 371

protocol
error mask 96

Protocol Analyzer 27

Protocol Analyzer setting 210

protocol error report 134

protocol errors 59

Protocol Errors dialog 80

Q
Queue Command Report 141

Quick View 212

R
Read/Write Command Report 143

read/write command report 138

Rec Analyzer command 234

References Probe Setting dialog 206

Refresh (append to) the list of found devices 211

Refresh Device List 20

register device to host (FIS) 64, 65

relative time display 42

Remove Device 18

Rename Title of Port dialog 190

renaming port 190

Repeat decoded command in frame column 216

Reset (clear) the list of found devices 211

Reset All button 385

resetting
Toolbar 385

Response frame 191

Restore Factory Presets button 378

Restore Factory Presets option 378

Resume Generation 293

Resume Generation button 297

Reverse Link Data 213

rules
validity 366

Run Batch button 284

Run Batch Script command 233

run hardware 42

Run Scenario button 281

Run scripts button 159

Run statement 287

Run Verification Scripts dialog 158

running disparity 189

Running verification scripts button 158

Rx/Tx Settings dialog 205, 207

S
Sample View link 146

Sample View Settings 212

Sampling memory usage optimization 212

Sampling Memory Usage Optimization 
option 217

SAS Address 296

SAS Address Alias 203

SAS Address field 384

SAS address report 137

SAS data pattern 249

SAS Parameters window 70

SAS Verification 227

SAS/SATA Protocol Suite 27

SATA data pattern 250

SATA Parameters window 71

save
Display Options 383
partial trace capture 45, 46, 47, 48, 50
trace capture 44

Save As Display Formats 46

Save as Text button 144

Save As Text dialog 123

Save button 296
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Save Filtered Sample 45

Save Output button 158

scenario 238
action 250
creation 257
event 246
properties 244
running 281

Scenario Batch file 281

Scenario Properties dialog 244

scramble/unscramble payload data 187

scrambling
disable 95

Script Assignment dialog 310

Script Editor 306
buttons 296, 308
pop-up menu 309
toolbar 307

Script Workspace 282

SCSI Command 84

SCSI Command report 136

SCSI commands
address display 42

SCSI spec assignment 211

search 179
by tag 184, 185
complex 374
Direction 376
direction 294, 377
domain 182
Exclusion 376
for data pattern 180, 181
Intersection 376
logic 181
Origin 376
SAS address 182
save setup 180
status 197
STP port 182
sub items 182
Union 376

Search Direction 294

search direction 180

search from 180

search items 181

Search Menu 294

select
item for capture 57

Select Device 15

Select Port Configuration dialog 99

selecting components for installation 12

separate systems 12

sequence 241
examples 268

sequential triggering 90

Serial ATA (SATA) data transfers 9

Serial Attached SCSI (SAS) data transfers 9

session 252

Set Alias Name 17

Set as Second Data Payload 155

set device bits (FIS) 65

Set Port Configuration dialog 98

Set the Anchor row as sync. point 216

Set Time Stamp Origin 166

Set Timers dialog 104

Setting button 145

Setting dialog 145

settings
advanced mode 109

Settings command 158

Settings dialog 158

Settings tab 92, 109

Setup command 12

Setup Display Options button 296

Setup Generation Options button 297

Setup Menu 293

show
all data in data field 193

Show Description window 161

Show Device Library command 233

Show Grid 161

Show Library command 233

Show Line Numbers command 308

Show Output 161

Show Output command 233

Show Sector Count instead of Xfer Length 216

Show Warning in Search Primitive In Column 
View 216

Show XXXX value 96

Show/Hide CMD packet
in results display 187

Show/Hide Command queue
in results display 187

Show/Hide Compare 2 Data Payloads 
button 155

Show/Hide DLLP packet
in results display 187

Show/Hide Field 191

Show/Hide Link Packet button 186

Show/Hide Physical Packet
in results display 187

Show/Hide TLP packet
in results display 187

Show/Hide Transport Packet button 187

Sierra M6-4 Protocol Analyzer 9

Sierra Trainer menus 292

Sierra Trainer toolbar 296
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simulation mode 26

Sleep statement 289

SMP Command report 136

SMP frame 62

SMP Initiator field 384

SMP Target field 384

SMP Transport report 135

SMPFrames.inc 306

Snapshot mode 69

Soft Reset dialog 89

Software default 211

software installation 12

software overview 27

sorting column content 148

Spec View 125, 188

Specify Action option 371

Speed Negotiation 227

Spread Sheet Color Setting 215

Spreadsheet View 31

spreadsheet view 122

SSP Frame 63

SSP Initiator field 384

SSP Target field 384

SSP Transport Report 135

SSPFrames.inc 306

Start Analyzer button 297

Start Generation 293

Start Generation button 297

State 241

statements 285

statistical report
column setting 145
content (SATA) 130, 131
options 131
save as text 144

Statistical Report toolbar 143

Statistical Report View 146

statistical reports 31

Statistics button 153

Status bar 197

Status Bar command 295

Stop Analyzer button 297

Stop Batch Script 234

Stop Generation 293

Stop Generation button 297

Stop Hardware button 69

Stop statement 287

STP Initiator field 384

STP Target field 384

STP Transport report 136

STPFrames.inc 306

subnet 26

support 391

Switch to CATC Navigation 213

Synchronize with Trace View 151

T
tabs

file 309
Target Emulation 297

task command report 137

Technical Support 391

telephone number 391

Temperature 12

Template Files 210

Text View 31

text view 125

Tile Views 162

time
relative display 42

Time Stamp Origin 166

Timeout Pattern dialog 72

timer 72
setup advanced mode 104

Timer definition dialog 90

Timer dialog 72

timers 266

timing
cursors 126
measurement 127

tool bar 196

Toolbar
command 385
Recording Rules 366
resetting 384
tab 385

Toolbar command 196

Toolbars 295

Tools Menu 296

Tools menu (InFusion) 234

tooltips 309

Trace Capture 44

Trace Memory Status section 93

Traffic Generation 35, 291

Traffic Generation (*.ssg) Files 298, 300, 302

Traffic Generation window 291

Traffic Monitoring 232

Trainer toolbar 296

tree 308

trigger
condition 103
manually 69
multi link 104
on address frame 81
on ATA command 76
on ATA command pattern 86, 89
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on ATAPI 81
on bus condition 74
on data pattern 78
on FIS 87
on FIS pattern 87
on pattern 69
on primitive 75
on protocol errors 80
on SCSI Command 84
on SMP Frame 83
on soft reset 89
on SSP Frame 83
on STP frame 82
on symbol 75
on timer 72
position in memory 93
setting advanced 103
setup 68
snapshot 69

Trigger tab 68

triggering
on timer sequential 90
order 91

triggers
setting 366

Tx Vout & Preemphasis command 207

TxRx Vout 204

TxRx Vout & Preemphasis command 205

U
Union search 376

unpacking 10

Update License 223

Update Sierra Device 234, 293

Update Sierra Device command 221

Upload Manager dialog 94

USB port 11

user defined decoding 222

User Defined Decoding dialog 222

User Path 210

User-Defined Find Events screen 375

using the cursors 197

Using the Power Expansion Card (part number
ACC-EXP-004-X) 21

Using the Power Expansion Card 2 (part 
number

ACC-EXP-005-X) 21
Using the Power Expansion Cards 21

V
Value Replacement 232

VENDOR (FIS) 68

Verification script command 158

Verification Script Engine Reference Manual 158

View Field option 188

View Menu 295

View menu (InFusion) 234

View Options
button 308
menu 308

View Type toolbar 125

Viewer 111

Viewer Setting toolbar 186

Viewing Check Condition Sense Data 120

views 31

Visible box 200

W
WaitForStop statement 288

Waveform Display 31

waveform display 126

web site 391

Website, CATC 391

Window Menu 296

Windows default 211

Wrap 295

Wrap button 297

Wrap Packet box 201

wrap packets
in results display 186

Z
Zone Broadcast Method field 384

Zone Device field 384

Zoom In 295
results display 156, 162

Zoom In button 297

Zoom Out 295
results display 156, 157, 162

Zoom Out button 297
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